
a a ¥ A \ fr 
: . , \ 

y, € 2 aI 
= 4 i t F 

* é : , ss 
- ‘tr ¥ ee + 

4 : = a ¢ 
) ky 

oe 
a 

«ude : a # 

y a 



cricket 

Professional Graphs 
Made Simple 
For effective presentation quality graphs, there’s no ap- 
plication more versatile than Cricket Graph™. 

Cricket Graph lets you enter and edit data quickly — even 
import data from word processors, spreadsheets or 
databases using up to (with sufficient memory): 

e 100 columns per data window 

e 2700 rows per column 

Change the graph style or any of the details with just a 
click of the mouse. Cricket Graph creates dynamic graphs 
with ease. 

Powerful Features For Professional Presentations 

¢ Data window; column 
formatting 

@ Sixteen bar patterns, 
48 plot symbols, 6 line 
styles and 5 line widths 

e Selection of fonts, 
sizes and styles 

e Text, lines, arrows, 
rectangles, ovals, etc. 
added anywhere 

¢ Reposition, stretch, 
shrink graphs 

¢ Overlay multiple sets 
of data 

e Large data sets 
(2000 or more points) 

e Regression curve fits, 
error bars and grids 

e Depth for added 
dimension 

e Object & background 
COLOR selection 

e Mathematical transfor- 
mations on data in 
data window 

e and much more 

Choose From A Wide Variety Of Graphs And Charts 
¢ Scatter «Column ¢ Quality Control 
e Line e Stacked Bar e Area 

e Pie e Stacked Column —_® Double Y Graphs 
e Bar e Polar e Text 

Full Control Of The Printed Page 
e Multiple graphs per page 

e Position and size each graph on the page 

e Print on Apple® LaserWriter® 

e COLOR GRAPHS using Hewlett-Packard color 
plotters, ImageWriter® Il or ImageWriter LQ 

e Cricket Expression™ Device Drivers can interface 
non-PostScript® printers with Cricket Graph, offering 
more output device options. 

Sales ( Millions ) 

Corporate Sales Figures 
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Second Third Fourth 

Quarters 

SYSTEM REQUIREMENTS 
Requires Macintosh®, Macintosh SE or Macintosh Il. 
A hard disk or additional disk drive is required to run 
Cricket Graph. 

© Copyright 1988 Cricket Software, Inc. 
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Great Valley Corporate Center 
40 Valley Stream Parkway 
Malvern, PA 19355 

40 (215) 251-9890 
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Apple, ImageWriter, LaserWriter and Macintosh are registered 
trademarks of Apple Computer, Inc. 
PostScript is a registered trademark of Adobe Systems, Inc. 
Cricket Expression and Cricket Graph are trademarks of Cricket Software, Inc. 
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Release Notes 

This upgrade of Cricket Graph™ represents significant improvements in accuracy and 
performance. In addition, we have included enhancements to give you more control over the 
appearance of your graphs. 

We think you'll find that Cricket Graph 1.3 meets your most sophisticated graphing needs, and 
gives you even more power and ease of use than earlier versions. 

Cricket Graph is a trademark of Cricket Software, Inc. 
Macintosh is a registered trademark and MultiFinder is a trademark of Apple Computer, Inc. 

IBM is a registered trademark of International Business Machines Corporation. 



-Macintosh Compatibility 

Cricket Graph 1.3 requires a 
Macintosh® Plus, Macintosh SE 
or Macintosh II, and System 
Software 6.0 or greater. 

Memory and Disk Space 
Requirements 

We have improved the data 
structure of graphs to increase 

the accuracy of computations. 
As a result, Cricket Graph 1.3 

uses more memory to construct 

your graph, and graph files 
require more space on your 
disk. 

=) Chem Lab Graphs 
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(>) Graph Format 

MultiFinder Memory 
Requirement 

When running under Multi- 
Finder™, the default memory 
requirement for Cricket Graph 
1.3 is 768K. 

Extended Precision 
Variables 

The minimum representable 
value for extended precision 
variables is -1.1E+4931. The 
maximum representable value 
is 1.1E+4931. 
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(@) Tab-Delimited Text 
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New Data Format 

You can now save data asa 
tab-delimited ASCII text file. 
This allows you to export data 
to a wide variety of applica- 
tions, running both on 
Macintosh computers and on 
other systems, such as IBM® PC 
compatibles. 

Regardless of the column 
format (decimal, dollars, or 

percent), tab-delimited text files 

are saved in scientific format to 

preserve the actual numeric 

values of the data. 

Please note that the StatWorks 
data format is no longer an 
option for saving files. 

Click here to save data as 
tab-delimited ASCII text file 

oe Cricket Graph 1.3 | 



Improved Out-of-Memory 
Handling | 

If you run out of memory while 
running Cricket Graph 1.3, you 
will be able to save changes 
made .to any open window 
except the frontmost window. 
Since the frontmost window 
was active when memory ran 
out, it is impossible to update 
its contents accurately. 

Before you perform a memory- 
intensive operation—a compli- 
cated sort, for example—it’s a 
good idea to save the file in the 
frontmost window. That way, if 
memory runs out, you won’t 

lose data from any of the open 
windows. 

After you have saved changes 
to the other open windows, 

Cricket Graph returns you to 
the Finder. If you were using 
MultiFinder when you ran out 
of memory, you will be 

returned to another of the 

applications running under 
MultiFinder. | 

Realigning Legend Items 

The Legend dialog box (which 
appears when you double-click 
a graph’s legend) now contains 
a check box labeled “Realign 
Items.” If you have ungrouped 
the legend and moved the — 
items, regroup the legend and 
double-click it, then click this 

check box to ensure proper 
vertical spacing of the legend. 
This option also allows you to 
correct the line spacing between 

legend items after you have 
changed the font size used for 
the legend. 

Plain 

| LJ Bold 

[_] Italic 

[ ] Underline 

[|] Outline 

[|] Shadow 

[ |] Condense 

[ ] Extend 

% 

Command-W to Close 

We’ve changed the Command- 
_ key shortcut for the Close 
command in the File menu from 
Command-K to the standard 
Command-W. 

‘Save Data" #5 
Save Data As... 

Page Setup... | 

Print ae PF | 

Plot Setup... 

Helvetica He 
| Avant Gardg 

Border: 

@®None OC _ 
(] Realign Items 

Click here to realign 

~ legend items vertically 

| : Release Notes a 



New Plot Symbol Option 

If you wish, you can plot a data 
set in a line graph without a 
plot symbol. This option creates 
graphs that contain only lines. 
To remove plot symbols from a 
data set: 

1. Start by double-clicking the 
plot symbol of the data set 
in the legend. 

Plot $ymbal 

-X] no plot symbol 

| OK | | Cancei 

| 
Click here to 

remove plot 

symbols from 
selected data set 

2. In the dialog box that 
appears, click the check box 
labeled “no plot symbol,” 
then click OK to return to 
the graph window. The 
legend now displays a line 
symbol, with no plot 

symbol, for the data set. 

Line Width 

Line Style. 

Signal *1 

science data graph = 

Data from "Science Data” 

3. If you want to use plot 
symbols again, double-click 
the line symbol to redisplay 
the plot symbol dialog box, 
then click the “no plot 
symbol” check box to 
remove the X. You can now 
choose a new plot symbol 
before clicking OK to close 
the dialog box. 

/ 
~~ Sigial > | 

re SI 

a Cricket Graph 1.3 =. 





Registration # 

License : 
_ Cricket Software, Inc. hereby agrees to grant you a non-exclusive license to use the enclosed 
program, subject to the terms and restrictions set forth in this License Agreement. 

Copyright 
This manual and the software described in it are copyrighted with all rights reserved. Under the 
copyright laws, this manual or the software may not be copied, in whole or part, without written 
consent of Cricket Software, except in the normal use of the software or to make a backup copy. The 
same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the 
original. This exception does not allow copies to be made for others, whether or not sold. Under the 
law, copying includes translating into another language or format. 

You may use the software on any computer owned by you, but extra copies cannot be made for this 
purpose. A multiuse license may be purchased to allow the software to be used on more than one 
computer owned by the purchaser, including a shared-disk system. (Contact Cricket Software for 
information on multiuse licenses.) 7 

©1987 Great Valley Corporate Center 
40 Valley Stream Parkway 
Malvern, PA 19355 
(215) 251-9890 

Limited Warrenty on Media and Manuals 
If you discover physical defects in the media on which this software is distributed, or in the manuals 
distributed with the software, Cricket Software will replace the media or manuals at no charge to you, 

provided you return the item to be replaced with proof of purchase to Cricket during the 90-day 
period after you purchased the software. In some countries the replacement period may be different. 

ALL IMPLIED WARRANTIES ON THE MEDIA AND MANUAL, INCLUDING IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, 
ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF THE ORIGINAL 
RETAIL PURCHASE OF THIS PRODUCT. . 

Even though Cricket has tested the software and reviewed the documentation, CRICKET MAKES 
NO WARRANTY OR REPRESENTATION, EITHER EXPRESS OR IMPLIED, WITH RESPECT | 

TO THIS SOFTWARE, ITS QUALITY, PERFORMANCE, MERCHANTABILITY, OR FITNESS 

- FOR A PARTICULAR PURPOSE. AS A RESULT, THIS SOFTWARE IS SOLD "AS IS," AND 
YOU, THE PURCHASER, ARE ASSUMING THE ENTIRE RISK AS TO ITS QUALITY AND 
PERFORMANCE. 

IN NO EVENT WILL CRICKET BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, 
INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN THE 

SOFTWARE OR ITS DOCUMENTATION, even if advised of the possibility of such damages. In 
particular, Cricket shall have no liability for any programs or data stored in or used with Cricket 
products, including the costs of recovering such programs or data. 

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED. No Cricket dealer, agent, or 

employee is authorized to make any modification, extension, or addition to this warranty. 

Some states do not allow the exclusion or limitation of implied warranties or liability for incidental or 

consequential damages, so the above limitation or exclusion may not apply to you. This warranty 

gives you specific legal rights, and you may also have other rights which vary from state to state. 

Macintosh is a trademark of McIntosh Laboratory, Inc. and is licensed to Apple Computer, Inc. ImageWriter, 

LaserWriter, MacPaint, MacDraw, MacWrite, and Switcher are trademarks of Apple Computer, Inc. OverVue is a 

trademark of ProVue, Inc. Omnis 3 is a trademark of Blythe Software. MacDraft is a trademark of Innovative Data 

Design, Inc. Multiplan and Excel are trademarks of Microsoft Corporation. Filevision is a trademark of Telos 

Software, Inc. StatWorks is a trademark of Cricket Software, Inc. 
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Graph Registration # _.-G 94638 . 
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Card 

Welcome to Cricket Graph 
Another high-quality application from 
the Leader in Graphics Productivity 
Software. 

The only thing between you and valuable 
technical support, as well as timely 
information on future updates to Cricket 
Graph, is this registration card. 

Register Now! | 
You must complete this card to qualify 
for Cricket Software’s Standard Service 
Plan, six months of free technical 
support on your new Cricket applica- 
tion. Our technical service team is eager 
to help you resolve any questions that 
may arise as you familiarize yourself 
with Cricket Graph. You'll also receive 
two free issues of Reflections, Cricket 
Software’s News and Information 
quarterly. Your Standard Service Plan 
begins the moment we receive this card. 

Cricket Software also offers Extended 
and Preferred Service Plans designed 
to meet the support requirements of 
every individual and business user of 
Cricket Software products. Please 
check the service plan information box 
on the registration card if you would 
like to receive more information on 
Cricket Software Service Plans. 



CH ANGE OF ADDRES S ey AR
D Graph Registration # 

Please use this postcard to notify Cricket Software if you move. We need this information in order to keep you 
informed about new versions of Cricket Software products and to maintain our Customer Support files. 

COMPANY DEPT. 

NAME TITLE 

STREET ADDRESS 

- CITY STATE ZIP 

COUNTRY 

TELEPHONE / HOME OFFICE 

PREVIOUS STREET ADDRESS 

Signature 

REPLACEMENT DISK POLICY 

If your master program disk becomes unusable and you wish to have it replaced, please complete this card and 
return it along with your original disk, a photocopy of your dated proof-of-purchase and $25.00 to Cricket 
Software. 

COMPANY DEPT. 

COUNTRY 

TELEPHONE / HOME OFFICE 

Signature 

Graph Registration # GG 94638 | 
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BUSINESS REPLY MAIL 
FIRST CLASS PERMIT NO. 45 MALVERN, PA 

POSTAGE WILL BE PAID BY ADDRESSEE 

Cricket Software, Inc. 

Great Valley Corporate Center 
40 Valley Stream Parkway 
Malvern, PA 19355-9767 

NO POSTAGE 
NECESSARY 
IF MAILED 

IN THE 
UNITED STATES 
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cRAPH | 
Presentation Graphics for Science and Business 

Program by Jim Rafferty and Rich Norling 

Ny 

coicket 
sollware 

Great Valley Corporate Center 
40 Valley Stream Parkway 

Malvern, PA 19355 
(215) 251-9890 

This manual was produced using MacPaint™, MacWrite™, Switcher™ and a LaserWriter™. 
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Contents 

CHAPTER 1: Introducing Cricket Graph 

Starting Cricket Graph 
Learning to Use Cricket Graph 
An Example from Business 
An Example from Science 

CHAPTER 2: Entering and Editing Data 

Basic Structure of the Data Window 
Text or Numeric 
Entering a Column of Data 
Entering a Row of Data 
Entering Missing Values 
Editing Data 
Cutting, Copying and Pasting 
Editing Variable Names 
Selecting Columns or Multiple Columns 
Deleting Entire Columns of Data 
Selecting Rows or Multiple Rows 
Deleting Rows of Data 
Multiple Data Windows 
Storing Data 
Recalling Data 
Importing / Exporting with Cricket Graph 

CHAPTER 3: The Apple Menu 

About Graph... 
Desk Accessories 
Chooser 
Scrapbook 
Keycaps 

CHAPTER 4: The File Menu 

New 
Open... 
Close 7 
Save Data / Save Graph 
Save Data As... / Save Graph As... 
Page Setup... 
Print 
Plot Setup... 
Plot 
Quit 
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CHAPTER 58: The Edit Menu 

Undo 
Cut 
Copy Data / Copy Picture 
Paste 

Clear 
Select All 
Show Clipboard / Hide Clipboard 

CHAPTER 6: The Data Menu 

Sort... 
Recode... 
Transform... 
Simple Math... 
Count Frequency... 
Smooth... 

CHAPTER 7: The Graph Menu 

Selecting Variables 
Scatter 
Line 

Area 

Bar 

Column 
Pie 
Stacked Bar 
Stacked Column 
Polar 

QC 
Double Y 
Text 

Combination of Column and Line 

CHAPTER 8: Changing Items in the Graphs 

Changing an Axis 
Changing the Tick Labels 
Changing Plot Symbols or Bar Patterns 
Changing the Legend | 
Changing Text 
Resizing the Plot Frame 
Exploding a Pie Graph 
Deleting a Set of Data 
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CHAPTER 9: The Curve Fit Menu 

Selecting the Data to Fit 
The Various Regression Fits 
Interpolation 
Removing a Fitted Curve 

CHAPTER 10: The Goodies Menu 

Show Tools / Hide Tools 

Show Colors / Hide colors 
X Error Bars 

Y Error Bars 
Show Legend / Hide Legend 
Add Depth / Remove Depth 
Add Plot Frame / Remove Plot Frame 
Switch Axes 

Add Value Labels / Remove Value Labels 
Record Preferences 

CHAPTER 11: Selecting Colors 

The Color Palette 
Changing Grid and Axis Colors 
Changing Tick Label Colors 
Changing Colors of Symbols or Patterns 
Changing the Legend Color 
Changing Colors of Text, Rectangles, Lines and Arrows 
Printing in Color 

CHAPTER 12: The Formats Menu 

Creating a Format 
Saving a Format 
Recalling a Format 
Removing a Format : 
Swapping Formats with Others 

CHAPTER 13: Getting It on Paper 

Introducing the Page Layout Window 3 
Selecting a Graph for Moving or Resizing 
Moving a Graph 
Resizing a Graph 
Arranging the Graph(s) 
Working with Color Plotters 
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Appendix A: Do's & Don'ts of Creating 
Effective Graphs 

Rule #1: Simplify 
Rule #2: Emphasize 
Rule #3: Use Balance 
Rule #4: Space Carefully 
Rule #5: Maintain Scale 
Rule #6: Watch Pattern & Color 
Rule #7: Choose Data & Tick-Mark Location 
Rule #8: Place Numbers & Labels Carefully 
Rule #9: Use Consistent Font Size & Style 
Rule # 10: If it doesn't feel right, redo it! 

Appendix B: Technical Details 

Contents of Saved Formats 
What does Record Preferences Set? 
Numeric Computation Standards in Cricket Graph 
Computations in Quality Control 
Handling Pictures | 
Memory Management 
Sorting Order 
Recoding Order 

Appendix C: Importing & Exporting with 
Other Applications 

Methods for Importing and Exporting 
Text File Format used by Cricket Graph 
Example: Reading a SYLK File 
Example: Reading a Text File 
Data from Mainframe Computers 
Exporting Graphs to Other Programs 
Transferring Multiple Pictures 
Sample Macintosh Pascal Program to Read Files 
Sample Macintosh Pascal Program to Write Files 

Appendix D: Working with MacDraw 

Getting Graphs into MacDraw 
Grouping Objects 
Resizing and Moving Objects 
Rotating Objects 
Selecting Patterns 
Selecting Line and Arrow Types 
Setting the Drawing Size 
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Appendix E: Using Cricket Graph with Switcher 

Installing Applications 
Switching Between Programs 
Setting Options 
Saving a Bundled Set 
Quitting Switcher 

Appendix F: Using Color Plotters 

Installing the Plotter Resources 
Plot Setup 

_ Setting Pen Colors 
Page Layout with the Plotter. 
Technical Details on the Serial Interface 

Appendix G: A Quick Tour of the Menus 
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Chapter 1: Introducing Cricket Graph 

Welcome to Cricket Graph! 
Cricket Graph is a high-performance product designed to 

meet your graphic needs in both science and business. At 

the same time, with Cricket Graph you can create and 
customize graphs quickly and easily. 

Cricket Graph allows graphs to be printed on the 
ImageWriter™ I/II, LaserWriter™ and a number of color 

plotters (Apple and Hewlett Packard, to mention a few). 

Special versions of the software are also available for 

operating high quality film recorders and other high-end 

devices (if you would like more details, give us a call). 
With film recorders, you can capture high quality color 
slides and prints using Cricket Graph. 

Not only can you create graphic output using a variety of 

devices (and in color) but you have total page arrangement 

capabilities in Cricket Graph. This means that you can 

determine the size and position of each graph on the page. 

You can also overlay one graph with another or place 

several side by side for comparison. You have complete 

control! 

Though Cricket Graph is very easy to use, very complex 

things can be done with it. There are many powerful 

shortcuts available in Cricket Graph and you will not be 

able to learn everything all at once. That will come with 

time and practice (and of course from reading this 

manual). You will, however, be able to get presentation 

quality graphs completed and printed in no time at all. 

& 
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Starting Cricket Graph 
Cricket Graph comes on two disks. One is labeled "Graph 

Disk" and the other "System & Utilities". The Cricket 

Graph program and some sample data files are on the 

Graph Disk. The System disk contains a number of files 

including: System file; Switcher; a preconfigured Switcher 

document; and device installers for a number of color 

plotters. Switcher is a program licensed from Apple that 
allows you to have several programs in memory at once 

and allows switching back and forth between them 

_ (Appendix E: Using Cricket Graph with Switcher). The 
device installers are for installing the necessary resources 

for a variety of color plotters (Appendix F: Using Color 

Plotters). 

Turn on your Macintosh and insert the Graph disk and the 

System disk into the disk drives (running Cricket Graph 

with less than two disk drives is somewhat impractical, 

but it can be done). After a few seconds, the desktop 
image will appear. ‘ 

A number of file icons (graphic images representing an 
object) are used by Cricket Graph and are explained 

throughout this manual. The two icons you will need to 
be familiar with immediately are illustrated below. 

a, Program icon 
Graph 

Data Icon 

Business Data 

& 
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Click the icon labeled Cricket Graph which will then be 

highlighted. Select Open from the File menu. The 

Cricket Graph program is now started. It will take a few 

seconds for the program to be loaded. When Cricket _ 

Graph is first started in this way, an empty data window 

will appear. 

Close Box -always located in upper lefthand corner of window 

You can begin entering data at this point or you might 

wish to close this window (by clicking in the Close Box in 

the upper lefthand corner of the window) and open a data 

file from the disk. — 
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Learning to Use Cricket Graph 
Each of the following chapters is organized so that new 
Macintosh users can follow their sequence and learn about 
the features available in Cricket Graph. 

If you are already familiar with the Macintosh, you may 
wish to skip the next section, which runs through a couple 
of examples. A word of warning though: Cricket Graph 
uses some Macintosh features in new and powerful ways 
and therefore you may wish to work quickly through the 
examples even if you are an expert in the ways of the 
Macintosh. 

The best way to learn this package is to begin to create 
some graphs of your own. To speed up this process, two 
examples are presented to show the basic steps in creating, 
customizing and printing graphs. One example is aimed at» 
business and the other at science. Please work through 
both examples (even if you won't be doing graphs of the 
other type) because the two examples combined illustrate a 
number of powerful features available to you in Cricket 
Graph. 
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An Example from Business : 
Select the Open command from the File menu. The 
following dialog box will appear... : 

Click file name and then the Open button 

| (&) Graph Disk ie 

OD Business Data , FMR GN. 
D Science Data 

Click the name "Business Data" that appears in the 
variable selection box. This will select that file name (as 
indicated by highlighting). Then click the Open button. 

The data will appear after a few seconds in a data window. 
From here you could edit the data, but in this case we will 

just go ahead and create some graphs using this data set. 
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Go to the Graph menu and click the mouse button. 
Continue to hold the button down. The available graph 
types are displayed in this menu. To select any one type, 
drag to the icon of that graph and release the mouse button 
(dragging is moving the mouse while holding down the 
mouse button). Go ahead and drag down to the Column 
selection and release. | 
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Fa Column Graph 
Column 

Categories Values 

Each of the columns of data (usually referred to in this 
manual as variables) is named as illustrated in the top row 
of the data window. You may change these names at any 
time. They are originally assigned when the data set is 
created. To select variables for graphing, you simply 

_ Click the appropriate names in a scrolling selection box (as 
illustrated above). Click the variable names as illustrated 
above (note: one variable contains the categories and three 
other variables contain values for these categories for three 
years). 

a a 
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Business Data 

Data from “Business Data” 

30 . 

Values 

1968 1973 1978 1983 Categories 

Year 

A column graph like the one above will be created. 

Notice how the series of three values for each of the 

categories is graphed as vertical bars in a side by side 

fashion. Column graphs such as this are great for 

comparing values over different time periods. 
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Business Data = 

Data from “Business Data” 

30 

Vertical axis label 
can be changed by 

double-clicking on it 

i BB 

1968 1973 1978 1983 

Year 

Once a graph is created, it is easily modified for a 
customized appearance. For instance, the vertical axis 
label is inappropriate (the label was chosen as the first 
variable name in the series of variables graphed and will 
most likely always need to be modified when you are 
graphing multiple data sets). Instead, indicating the units 
used for this measurement would be more appropriate. To 
change it, double-click this label (point to the item and 
press the mouse button twice in rapid succession). 

UUUUUIVEUUU ed a 
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Typing in new Text: 

meeigtetn pales (millions the old text in Sales (millions $} 
this box. Style: | 

[ ] Plain 

(<] Bold 

[_] Italic 

[ ] Underline 

[] Outline 

[]Shadow — Orientation: 

(] Condense © Horizontal © Vertical 

Press OK when LJ] Extend Cancel 
you are finished —— 
making changes 

Double-clicking an item in the graph is the means by 
which you can change things. A dialog box (as illustrated 
above) will appear and you can change the text as well as 
its font, size, style and orientation. For right now, change 
what the label says by typing in "Sales (millions $)" in the 
edit box at the top of the dialog. The graph will be 
redrawn with the new vertical label. 
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Goodies 

Show Tools 

Show Colors 

i trrer Bars — 
Y Error Bars 

Hide Legend 

Add Depth a 

Remove Plot Frame 

Switch Axes 

Add Value Labels 

Record Preferences — 

To add "pizzazz", try selecting the Add Depth command 
from the Goodies menu. The graph will be redrawn with 
a three-dimensional appearance. Adding depth really 
enhances the presentation appearance of bar and column 
eraphs and their stacked counterparts (stacked bar and 
stacked column). 

Business Data 

Double-click on 

an axis to change 

its parameters 
en 
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To illustrate how you might change the values of an axis, 
double-click the vertical axis. The following dialog box 
will appear... 

Vertical (¥) Axis Format 

Axis Ticks — 

Mark Grid 
Minimum: |(AU0T) oo Major: [ 0 

Maximum: {30.000 Minor: XX CT] 

Increment:}] 10.000 Inside: [] 

© Linear O Log Axis on: © Left,,@ Right 

The dialog box appears with the Click on this radio button to have the 
current parameters displayed vertical axis drawn on the right 

All the values used to describe the characteristics of this 
axis will appear in this dialog box. Each of the parameters 
displays the current values of this axis. Click the Right 
radio button to move the axis to the right. 
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Selected text (indicated by gray box) can be moved where ever you wish by dragging 
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The graph is redrawn to reflect the change. Note, 
however, that two labels (the title and horizontal axis 
label) are no longer centered and need to be moved. You 
have already learned that double-clicking an item 1s how 
you go about changing it. To move an item, you simply 
point to it and drag it about the graph. An outline of the 
object will follow the mouse movements. When you let 
go of the mouse button, the item will be redrawn in its 

new location. 

1-13 Chapter 1: Introducing Cricket Graph 



Business Data 

Data from “Business Data’, 

Sales (millions $) 

Go ahead and move the horizontal axis label and title by 
dragging. 

Business Data 

Data from “Business Data. 

Double-click on 

pattern in legend 
to change it 
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To change a pattern, simply double-click the pattern in the 
legend (items such as plot symbols and patterns are always 
changed by double-clicking them in the legend, not in the 
graph). 

1-14 Chapter 1: Introducing Cricket Graph LP ED OER OED ORD CRE TED TER TER TRE TRE TE OEE OER OER UEP ORE. 



h— IO VU TP VU VET VV VOD. 

Current pattern indicated by dark box around the pattern 

Available patterns : : Ll a = 

Clicking on a pattern will select that pattern 

A dialog box will appear with the current pattern that you 
double-clicked selected (as indicated by the box around 
that pattern). To select a new pattern, click the desired 
pattern and then click the OK button. The graph will be 
redrawn using the new pattern. 

You have just created and customized a graph. Cricket 
Graph allows you store the format of a graph (a format 
consists of all the details necessary to recreate that graph 
except the data and any data dependent items). By storing 
formats, you have essentially created a "Graphic Macro’. 
A macro is a collection of a series of commands necessary 
to accomplish a task. The macro can now be executed by 
a single command. Macros are a way to automate the 
repetitiveness of frequently used groups of tasks. For 
instance, suppose you have created a graph with the 
properly selected fonts, arrows, extra text and perhaps 
depth (as in this case) and you wish to create the same 
kind of graph over and over but with different sets of data. 
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Formats — 
Save Format... 
Remove'Format... 

First create the desired graph and customize it (as we have 
just done) and then select Save Format from the 
Formats menu. The following dialog box will appear. 

(4) Graph Disk 

‘Ss Business Date ras Graph Disk 
& Cricket braph | 
Ss Science Date 

Save this Format as: 

Example #1| | 

Enter the name to be assigned to the format and click the Save button 

Name this format "Example #1" by entering the name in 
the text box and click the Save button. 

Formats 
Save Format... 

Remove Format... 

Example #1, 

The format, saved under this name, will be added to the 
Formats menu. 
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To illustrate how effective a "Graphic Macro" can be, put 

away all the windows currently open (by clicking in the 
‘Close Box in the upper lefthand corner of each window). 
Now select the "Example #1" macro that you just created 

(selection is accomplished exactly like any other 

pull-down menu command). 

A series of events will happen. First, since there is no 

data, a dialog requesting the data set to be opened will 

appear. Select "Business Example" again. A dialog 

- requesting which variables to use in creating the graph will 

appear. Select "Year" as the category variable and drag 

through "US", "Canada" and "UK" for the value variables 

(just as we did previously). Instantly after clicking the 

New Plot button, a column graph exactly like the one 

created initially will appear. The graph is drawn from the 

format saved under this macro. In this case we used the 

same data set as before. We could have used another data 

set (in fact, that is exactly what you would do to take full 

advantage of this macro capability in the real world). 
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Let's compare the sales figures for the US for 1968, 1 oF, 
1978 and 1983 by creating a pie graph. 

Graph 

Scatter Line Area 

ah EY 
om Column 

| | AZ | DOH | eck 
Qc DoubleY Text 

Select Pie from the Graph menu just as Au did for the 
column graph. 
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09 | Pie Chart 
Pie 

Categories 
Year 

US 

Canada 

UK 

Again, select the variables desired in the dialog box that 
appears. In the case of pie graphs, only one value can be 
chosen at a time in the righthand variable selection box (as 
opposed to multiple selections in other kinds of graphs). 

Business Data 

Data from “Business Data™ 

A pie graph will be drawn. To highlight a specific wedge 
of the pie, click that wedge and drag it outward from the 
center of the pie. 
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You now have two different kinds of graphs in two ~ 
different windows. This is one of the many powerful 
features of Cricket Graph. To really demonstrate how 
powerful this capability is, let's print the graphs that you 
just created. 

First, anytime we have graphs that contain circles (such as 
pie and polar graphs), we must make sure that we set the 
proper attributes before printing. 

Save Graph 3S 

Save Graph As... 

Go to the Page Setup command and select it. 
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A dialog box will appear allowing you to set various 
parameters. In this case, we are especially interested in 
turning on the Tall Adjusted setting. 

Paper: @ US Letter © A4 Letter 
© US Legal © International Fanfold 
© Computer Paper 

Orientation Special Effects: K Tall Adjusted 
[]50 % Reduction 

frail j [] No Gaps Between Pages 

Tall adjusted is used so that when graphs are printed, 

circles appear as circles instead of being distorted into 

ovals. 
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Save Graph 3#$ 

Save Graph As... 

Now select Print from the File menu to get a printout of 

our graph (in this case, graphs). Anytime you select Print 

or Plot from the File menu, a dialog box will appear that 

lets you set your page arrangement before printing or 

plotting. 
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Graphs in open 

windows 

Selected graph can be resized 

or repositioned on the page 

<—— Reduced page represents 

settings in Page Setup 

Actual printable area bounded 

by gray rectangle 

Grid can be used to aid in alignment 

Grid: Oon @orr 

In Cricket Graph, you have full control of the graph size 

_and position on the page. Notice how a miniature image 
of a page appears on the lefthand side of the layout 
window with the graph in the most forward graph window 
centered on this page. On the righthand side is a scaled 
down image of the other graph that we first created (the 
contents of any other graph windows would appear also). 
By clicking the image of the graph, we can select it (as 
indicated by the gray rectangle around the graph). 

& 
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Once selected, the graph can be moved anywhere on or off 

the page by dragging within this selection rectangle. To 

resize the graph, drag in the little gray box in the lower 

righthand corner of the selection rectangle. _ 

You can drag other graphs onto the page. You can even 

place one graph on top of another since graphs placed 

behind other graphs will show through. 

The image of the page is a scaled version of the settings 

that were set in Page Setup (for instance, you could 

rotate the page so that the images would be printed across 

the widest part of the page). 

After clicking OK (that is, when you have finished 

deciding on your layout) another dialog box will appear 

allowing you to set the print quality if the printer you are 

using is an ImageWriter. This is the standard dialog used 

throughout most Macintosh applications. Graphs look 

best on an ImageWriter when printed in "Best" mode. 

When printing on the LaserWriter, everything is printed in 

draft mode and therefore there is no selection for print 

quality. | 

An Example from Science 
Let's create another graph but this time using a science 

data set. Close all windows that are currently open so that 

we can start with a fresh screen. | 

Select Open from the File menu so that a data set can be 

selected. Select and open the "Science Data". 

This data set contains a variable with time measurements 

versus two other variables containing measured signals 

from a scientific instrument. 
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Select Scatter from the Graph menu. 

Click to select this variable Drag through these names to select 

@ 

e-°, | Scatter Plot 
Scatter 

Vertical (Y) Axis 

New Plot (tance 

Let's graph the time variable along the x axis and the two 
measured signal values along the y axis (to do so, select 
the names as illustrated above). 
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The following scatter graph is created from the data... 

= Science Data 

o 
cs 
e Double-click 
EA 

on) on the plot 

symbol in the 

legend to 

change it 

Suppose you wish to change the plot symbol used in the 
second set of values. Double-click this symbol in the 
legend (remember, the legend serves as a control point for 
changing plot symbols and patterns). The following 
dialog box will appear. 

Current symbol is indicated by dark box around symbol 

Plot Symbol 

Available symbols 

Clicking on a symbol will select that symbol 
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Select a new plot symbol just as you had previously 
selected a new pattern by clicking it and then clicking the 
OK button. 

Science Data 

To select a data 
set for placing 
curve fits, click 
on the symbol in 

the legend that 
represents that 

data set 
eA Signal *2 

yao 

@ 
= 
[| 

& 
i=) 
y=) 

27) 

If you single-click a plot symbol instead of 
double-clicking, the data series represented by that symbol 
is selected (indicated by a gray box around the plot 
symbol). This is very useful in selecting specific sets of 
data on graphs that contain multiple data sets for 
performing regression curve fits, placing error bars or 
deleting data sets from the graph. 

& 

1-27 Chapter 1: Introducing Cricket Graph 



Curve Fit 
simple 

Polynomial |! 
Logarithmic | 
Exponential 

Remove 

For example, select the first data set in the legend by 
clicking its plot symbol. Now choose the Polynomial 
command from the Curve Fit menu. 

The polynomial order 

Click here to decrease order Click here to increase order 

Order of Polynomial: 

After setting order, click here to proceed 

A dialog box will appear requesting that you select the 
degree of the polynomial. By clicking the left arrow in 
the control, the polynomial order will decrease. Likewise, 
clicking the right arrow will increase the polynomial 
order. Set the order to three (the maximum is five). 
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Example Graph = 

Data from “Science Data” 

y = 6.02-5.17x +6.72 x2 -1.248x3 

igi Signal *1 
ER Signal #2 
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@ 
game 
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& 
i) 

ogame 
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Click on the plot 

symbol in the 
legend of the 

data set that you 
| want to be used 

in the curve fit 

The best fitting polynomial curve is overlaid on the graph 
along with the equation that describes that curve. You can 
move the equation to another part of the graph by clicking 
it and then dragging. You can also remove the equation 
from the graph by clicking it and then pressing the 
Backspace key or selecting Clear from the File menu. 
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Now place error bars on the second data set by clicking its 
plot symbol (in the legend). A gray box will surround the 
plot symbol for this data set, indicating that it is selected. 
Now choose Y Error Bars from the Goodies menu. 

1-30 

Goodies 

Show Tools 

Show Colors 

H Error Bars 

Y Error Bars 

Hide Legend 

Sipbich sees 

Rid Uatue Latels 

Record Preferences 

) 
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Click on this button and enter 3 in the text box 

Vertical (Y) Error Bars 

© No error bars in this direction. 

© Use percent of the coordinate as the error. 

© Use the Standard Error of the data. 
@® Use afixederrorof [3 |. 
© Variable contains the errors. 

Signal #1 
Signal #2 

A dialog box will appear allowing you to choose one of 
several ways to specify the error. For this example, click 
the fixed error button and enter a value of 3 in the text 
box. 

Example Graph 

Data from “Science Data” 

y = 6.02-5.17x +6.72 x2 -1.248x3 

G Signal *1 
@ Signal *2 

] 

@ 
a] 

L] 

& 
—H 

rr] 

47] 

The error bars are drawn along with that data set. Note 

that some of the error bars extend beyond the plot frame 

and are therefore not entirely visible. 
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To change the vertical axis minimum and maximum ‘80 
that the entire error bar will be shown in all cases, 

double-click the vertical axis. 

Vertical (Y) Axis Format 

Anis Ticks 
Mark Grid 

Major: {x [| Minimum: 

Increment: Inside: (J 

Maximum: Minor: xX [4 

® Linear O Log Axis on: @ Left © Right 

A dialog box with all the current axis parameters pre-set 
will appear. Go ahead and change the minimum to -5, the 
maximum to 25 and the increment to 10. To change a 
value, drag over that value and enter a new value. After 
you have finished changing the values, click the OK 
button. 
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Example Graph 

Data from “Science Data” 

y = 6.02-5.17x +6.72 x2 -1.248x3 

& Signal *1 
@ Signal *2 

Signal *1 

The graph is redrawn with the vertical axis conforming to 
the new parameters. Notice how all of the error bars are 
now visible. 

Save Graph #S 
Save Graph As..: 

Page Setup... 

Print 

Plot Setup... 

Suppose you were working on a graph and for some 
reason had to stop what you were doing and finish it later. 
With that graph in the active window, select the Save 
Graph command. 
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(2) Graph Disk 

fy Business Data nN Graph Disk 
& Cricket Graph 

Sy Umagewrter 
iS Schence Data 

Enter name to Save this Graph as: 
be used when 

saving graph -—>| Example Graph Cancel 
and then click 

the Save button @ Graph format © PICT format 

A dialog box will appear so that you can enter a name for 
the graph to be saved under. Enter the name "Example 
Graph". You have the option of saving a graph in Graph 
format or PICT format. Saving a file in Graph format 
allows you to recall that graph at a later time and continue 
to customize. Saving a graph in PICT format is a 
convenient way to create MacDraw™ files so that you can 
use MacDraw to further customize or modify the graph. 
Once modified in MacDraw, however, you will not be 
able to read that file into Cricket Graph. Go ahead and 
enter the name "Example Graph" and click OK. 
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To illustrate how you can later recall a saved graph, go 
ahead and close all the windows currently open. Now 
select Open from the File menu. Note that the name of 
the graph you just saved ("Example Graph") now appears 
in the selection box. Clicking this name and then clicking 
the Open button will now load that graph. 

Click file name and then the Open butten 

Graph Disk 

OQ Business Data <> Graph Disk 
OQ Example Graph 

1 Science Data 

The previous examples have illustrated only a few of the 
Cricket Graph features. The rest of the Cricket Graph 
manual goes into each feature in detail. 
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Chapter 2 
Entering and Editing Data 

Graphs are simply visual representations of data. 
Therefore, it is only natural that you must be able to enter 
and edit data with ease. Data can be entered directly into 
Cricket Graph or imported from another Macintosh 
application. This chapter explains how to enter and edit 
data in Cricket Graph’ s data window. Appendix C 
explains how to import and export data between other 
applications. 

Cricket Graph allows you to enter and edit data, whether 
numbers or characters, in a manner consistent with the 
Macintosh. The data window is a series of columns, each 
column having characteristics like MacWrite™. If you are 
familiar with MacWrite then you are already familiar with 
many of the editing operations possible. 

In this manual we refer to the columns as variables. A 
variable is essentially a series of data. For instance, you 
may wish to plot one variable representing months along 
the X (horizontal) axis versus another variable 
representing sales volume along the Y 5 anerae axis to 
create a column plot. , 

& 
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Basic Structure of the Data Window 
The basic structure behind the data window is the column 
format where each column has editing characteristics like 
MacWrite (e.g. cut, copy and paste). 

Home Region - clicking here Double-click here to make window full screen 
returns cursor to row 1 , column 1 Column numbers Column Titles 

Business Data 

Canada 
‘ 1968 } 15.9} 16.2} 
pied 1973 ; 23.1: 17.4; 

Numbers 1978: 24.8: 22.9 
1983 ; 22.6; 25.3; 

Ue eircar = point of insertion 

Scroll Bars - use to view hidden areas of window 

Data collected for a variable is entered down a column. 
The data window may contain up to 40 columns 
(variables) and approximately 2700 rows. The exact 
number of data items that can be entered is dependent on 
the available free memory. 

Each variable can be assigned a name by entering the 
name in the box provided at the head of each column. 
This name is used in all graphs to identify the variable. 

Scroll bars are present along the bottom and right edge of 
the data window. You can use these to scroll data into 
view that extends beyond the edge of the data window. 
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You will also note that across the top of the data window 
are column numbers, and running along the left edge are 
row numbers. Row numbers and column numbers are 
automatically assigned by the program. They will help 
you keep track of your location in a large data set when 
scrolling. 

Clicking in the Home region in the upper left corner of the 
data window will always place row one, column one in the 
top left corner of the data window. This shortcut allows 
you to return to the first column very quickly no matter 
where you are 1n a large data set. 

By double-clicking either in the Title Bar or Size Box, you 
can make the data window grow to full screen size. 
Double-clicking in this area again will make the screen 
return to its original size. 

Text or Numeric 
All operations in a Cricket Graph data window are the 
same whether the text entered is a number or a category 
name (for example, "Jan", "Feb", etc.). 

Names you have given Default name for 
the variables (columns) anew data set 

a Untitled ate == 
Pais Bees 

Column 3 ales /millions 
| 

Default name assigned 

by Cricket Graph 

& 
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You can enter more characters for each value or label than 
you can see in acolumn. However, it is important to note 
that only the first fifteen characters are recognized by 
Cricket Graph. 

Entering a Column of Data 
When no data is present in the window, only one column 
and one row is labeled and marked. To enter data, click 
this column. A flashing vertical line called an insertion 
bar will appear at the top of the empty column. This 
insertion bar is your indication of where entry or editing 
will take place. 

Untitled Data 

Column 1 

|«———— Insertion Bar 

Row numbers will be created 

as each row is entered 

Go ahead and type a data value. After you are finished 
typing the value, press the Return key. The insertion bar 
will now appear on the next line in the column. Note that 
a second column is automatically created after you enter 
the first data value in the column. 
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Untitled Data 

Column 1 Column2 

Data values entered separated 
by the RETURN key 

f=) 

At this point you may enter another data value. You can 
continue down the column in this same fashion until you 
have entered all the values for that variable. 

Entering a Row of Data 
If after entering the first data value you press the Tab key 
instead of the Return key, another column is created and | 
the insertion bar will jump to this new column. Using the 
Tab key after typing each data point is a way of entering 
several columns of data, a row at a time. 
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TAB key was pressed ENTER key was pressed 

a UC 

| 25" = 3 : 

@+ + @ & 

After entering all values for that row, press the Enter key 
to move the cursor to the next lower line, first column. 

You can now enter the next row of data. After you have 
entered the first row of data, you can use the Enter key 
after each data value instead of using the Tab key. 
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Entering Missing Values rs 
Suppose, while entering data, you encounter a missing 
value (for example, the number of sales for a specific 
territory was recorded in 1975 and 1977 but in 1976 this 
number was never recorded). Simply press Return (or 
Enter or Tab, whichever is appropriate) to enter no value 
for that case. Cricket Graph will not plot a data pair when 

creating a graph if any one of the values in the pair is 
missing (two points, referred to as a data pair, are - 
necessary for each point in a graph). 

Untitled Data | 

Editing Data 
The same editing techniques used in MacWrite can be 
used in the data window. One way to correct an erroneous 
value is to click just after the value and then backspace 
over the data (by pressing the Backspace key). You can 

then retype the value. The newly typed value will replace 

the old value. You may also click at the location in a 

value where you wish to begin correcting. The flashing 

insertion bar will appear at that location and all further 
editing actions will occur there. | 
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You can also drag over the data value to select it. The 
characters over which you drag will be highlighted, 
indicating that these characters are now selected. Any 
typing will now replace the selected area with whatever is 
typed. | 

A short cut method of selecting an entire value for editing 
is to double-click the value. Any typing will replace the - 
entire selected area with whatever is typed. 

Cutting, Copying and Pasting 
Dragging over data values in a column selects and 
highlights those values. Cut, Copy and Paste affect the 
selected text. If Cut is chosen from the Edit menu, the 
selected values are removed from the column and placed 
on the Clipboard (the Clipboard is a temporary storage 
area used to hold text or pictures). All numbers in the 
column following the data that is cut will shift upwards. 

Selected Data indicated by highlighting 

Business Vas 
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Copy works much the same way except that the text is not 
removed from the column when it is placed on the 
Clipboard. 

If text is selected when Paste is chosen from the menu, 
the current contents of the Clipboard replace the selected 
text. If you wish to paste new data without replacing 

existing data, click at the location you wish to insert the 
new data. Paste will insert the data at the location 
indicated by the flashing insertion bar. 

Once data values are on the Clipboard, they may be 
moved to another program or even to another data 
window. : 

Editing Variable Names 
Each column represents a variable. You may name the 
column with a variable name that is meaningful to you. 
Variables for graphing are selected by their names. 
Columns are automatically named when created as 
"Column" followed by the column number. To change the 

column name, click the box containing the name. The 

entire name will become selected. Any typing will now 

replace this name. 
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Click on column name to select it (indicated by highlighting) 

Column Names 

assigned by 

Cricket Graph 

You may, of course, wish to change only part of a name 
and not the entire name; clicking a second time in the 
column name box will place the insertion bar at the 
location where you clicked. Normal editing functions are 
now possible. 

Selecting Columns or Multiple Columns 
You may perform an editing operation (such as cut, paste 
or copy) on an entire data column at once. 
Double-clicking a column number selects the entire 
column. 
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Double-clicking on column number selects the entire column 

2S Business SSS 
ray 1 

& 

A number of contiguous columns may be selected by 
double-clicking in a column number, holding the Shift 
key and clicking in the column number of another column. 
All columns between the first and last column will become 
selected and highlighted. For instance, if you double-click 
the column number of Column 1 and then hold the shift 
key while you click the column number of Column 3, 
columns 1, 2 and 3 will become selected. Non-contiguous 
columns cannot be selected. 

Deleting Entire Columns of Data 
After selecting a column, pressing the Backspace key 
will delete the data from the selected column but the 
column will still exist. It will just be empty. If you wish 
to delete the entire column, including the column name, 
click in the column and then hold the Shift key while you 
click in the column number. Pressing the Backspace key 
will now delete the entire column. All columns to the 
right of this column will shift over to the left to fill the 
vacant spot. 
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Selecting Rows or Multiple Rows 
An entire row may be selected by clicking the row 
number. You may also select contiguous rows by 
dragging over the desired row numbers or Shift-clicking 
in the row numbers to expand the selected area. 

Business Data 

Dragging over a row number (or row numbers) selects 
the desired row (or rows) 

Deleting Rows of Data 
After selecting one or more rows of data by dragging over 
the row numbers, you can delete the selected rows by 
pressing the Backspace key. 

PUN Ff FoF Op 
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Multiple Data Windows 
You may have more than one data window open at the 
same time. However, Cricket Graph creates all graphs 
from the data in the frontmost data window (The 
“frontmost data window" simply implies that no other data 
windows are forward relative to this window. This 
frontmost data window may or may not be the active 
window.). If the data set you wish to use in the plot is 
behind another data window, click on the desired data 
window and it will become the frontmost window. 

Highlighted Title Bar 
indicating "Active" window Two data windows 

Business Data _ 
: : : eed 

De pax Seiiiameior 5... semamaannee 
areTe. a Se a PS Per ee ee 
=> science Dats 3 

Data from “Science Data” 
20 : 

Signal eZ 

Signal *1 

Frontmost Data Window 

Active window 
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e Storing Data 
Make the data window the active window by clicking on 
it. Then choose the command Save Data or Save Data 
As from the File menu to save the data on disk. 

Graph Disk 

iS Business Bata ray Graph Disk <—Name of disk 
& Cricket braph : 
i Umagemriter athe Switches from EY Science Bate Drive |<—7 one disk drive 

to another 3 

Save this data set as: 

Business Data 

Name to be used when saving the data 

If the Save Data command is used on data in an untitled 
data window, a dialog box like the one above will appear 
asking you to name the data set. Once named, the data set 
is stored with that name on the disk. If a data set with the 
same name already exists when you use the Save Data 
command, the data in the frontmost data window replaces | 
the old version. 
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Recalling Data 
Data may be recalled from disk by using the Open 

command from the File menu. A dialog box listing the 

data sets and saved graphs on the disk will appear, 

allowing you to select the data set you want to open. 

Click the name of the data set to select it. 

Click file name and then the Open button 

(2) Graph Disk 

D Business Data . “> Graph Disk 

2 Science Data 

The Open button confirms the selection. The Eject 

button can be used to swap disks and get a data set from a 

different disk. If you have an external disk drive or a hard 

disk, you may use the Drive button to switch from one 

disk volume to another. 

Recalling data from disk causes a new data window, 

containing that data, to be opened. 

If you wish to bring data into Cricket Graph, you may do 

so by one of several methods. Quite often, you may wish 

to transfer a small amount of data from another 

& 
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application, such as a statistical package, into Cricket 
Graph. Small amounts of data can easily be transferred 
via the Clipboard. Larger sets of data can be imported 
into Cricket Graph by first saving the data into TEXT files 
or SYLK files (SYLK is a format used by Microsoft in its 
Macintosh products). 

Importing / Exporting with Cricket Graph 
Data from Cricket Graph can also be transferred to another 
application either through the Clipboard or by first saving 
the data. All data saved by Cricket Graph is saved in 
TEXT file format and therefore can be read by many other 
Macintosh applications. 

Most importantly, graphs created by Cricket Graph can be 
exported to other applications by one of two methods. 
The most common method is to copy the graph to the 
Clipboard and then paste into the other application (such 
as MacWrite™, Microsoft Word or MacPaint™), For 
programs such as MacDraw™ or MacDraft™, saving the 
graph as a PICT file will be most beneficial. 

Appendix C explains in detail the ways you can import 
and export data and graphs between Cricket Graph and 
other applications. Several examples are also illustrated in 
that appendix. It is highly recommended that you read it. 
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About Graph... 

Scrapbook 

Note Pad 

Calculator Chapter 3 

Alarm Clock The Apple Menu 
Key Caps | 

Control Panel 

Chooser 

The Apple menu is standard in most Macintosh 
applications. On this menu you have access to 
information about the program and any of the desk 
accessories that are installed in the System file. 

About Graph... 
The About Graph command displays information on the 
program such as version number and publisher. The 
names of the program authors are also listed. If you need 

to contact the publisher, you will find the address in this 
window. Click anywhere to close this box. 

- Desk Accessories 

Choosing any of the desk accessories opens the accessory 

so you can use it. You can use Cut, Paste and Copy on 

the Edit menu to transfer information from many of the 

desk accessories to your data window. A desk accessory 

may be closed with its close box or with the Close option 
on the File menu. . 
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You can install desk accessories of your choice using 
Apple's Font/Desk Accessory Mover (your local Apple 
dealer should have details). Therefore, the kinds of desk 
accessories that are available can vary from System file to 
System file. The System file included with the Cricket 
Graph package includes several accessories that are worth 
special mention. 

Chooser 
The Chooser desk accessory allows you to send all print 
requests to either a LaserWriter or ImageWriter. 

Devices currently not connected are Click on the Macintosh port 
displayed in gray you wish to use 

Chooser 

Mle pvr , Select printer port 

aS 

Click on the device you wish to print with 

To print using a LaserWriter, the printer must be 
connected to your computer using AppleTalk (Apple's _ 
networking scheme). Your local Apple dealer should be | 
able to give you specifics about this network. The 
LaserWriter must be connected to the printer port (labeled 
with an Icon of a printer). The connection can be made at 
either serial port on the back of your Macintosh if you 
wish to print on the ImageWriter. Click on the icon of the 
port you will be using. 
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Scrapbook nrtner : 
One especially useful desk accessory with which you will 
(or should) become familiar is the Scrapbook. The 
Scrapbook is an area where you can store graphic images 
or data. Essentially, it is like the Clipboard for | 
transferring items between applications with the exception 
that the Scrapbook can hold multiple items while the 
Clipboard can hold only one item at a time. 

Picture of item in Scrapbook 

You may not be able to see the 

entire item, but it is there! 

Scrapbook 

Data from “Business Data™ 

30 

1968 1973 1978 

1u2 

— number of items in Scrapbook Data will be stored as "TEXT" 

! Number of this item in Scrapbook Graphs as “PICT”: 

Use Scroll Bar to view selections in Scrapbook 

VOD OD BH DOV OD db 
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If you wish to transfer two graphs from Cricket Graph 
over to another application, for instance, you would do the 
following... 

(1) | Choose the Scrapbook desk accessory from the Apple menu. 
Move the open Scrapbook off to one side of your screen. 

(2) Click on the first graph that you wish to copy to make it the 
active window 

(3) Select Copy from the Edit menu 

(4) Click on the Scrapbook to make it the active window 

(5) Select the Paste command from the Edit menu. The first 
graph is now in the scrapbook. 

(6) Click on the second graph that you wish to copy to make it the 
active window. 

9? § 7 ff fi (7) Select Copy from the Edit menu. 

(8) Click on the Scrapbook window to make it the active window. 

(9) Select Paste from the Edit menu. The second graph is now in 
the Scrapbook also. 

(10) Leave Cricket Graph by choosing the Quit command from the 
File menu. 

(11) Both graphs are now in the Scrapbook. Start the other 
application. You can paste the graphs into this application 
(if this application can handle MacDraw type pictures) by 
reversing the sequence of steps that you used to get the graphs 
into the Scrapbook. 

Multiple graphs can be transferred in this way. You may 
find this very useful if you wish to include a number of 
graphs in a report that you are writing with MacWrite or 
Microsoft Word. 
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Keycaps 
_ The Keycaps desk accessory is useful for viewing the 
correspondence of keys on the Macintosh keyboard to 
characters in a selected font. This is very useful when you 
want to enter mathematical symbols or Greek characters 
which are available in many of the Macintosh fonts. 

Venice 

Cool la eee tee eg tee Oe OL O a OLR EOL ONO DOPOD DOR O OOO oO OO BO De 
oi HH ori tt rth bt Phe bt ht et Pt Pr ee be oe ee Pe Pe Pt ee eh ee ee ee he Pe ee ee er er ee er ee ee 
ete ht bt oe et Pe et ot Pe et he bt ee oe Oe he ee ee ee ho he Pe ee ee ee ee be bt ee ee ee ee ee eee ht ee he ee be oe HMMM PPMP PPP 

ert tt br et Prt et ht ee Pe) ree Pt te teh Pe et Pe ee bee be et Pe ee ee et Pe Pe eT Coe et be bt oe ete ee Pet et Pe tt ee oi hh Phe eh Pte ht et Pe Pe Pee Pt Pe he oe ee he ee Pe oe Pe oe Peo ee he Pt he ee Pe he Pe ee Pt SH re et et ee Pe ee ot Pe ee eS oe oe Pe oe Pe Pe Pe Pe Pe ed Pee ee Pe Pe et oe te Pe Pe ot Pe 

BOAO OO 
sesesesesesezesstegecececesscssecescccgesesesesececscececeseceseeese seco se tose se ceteceeelee es esececssesescceces possgshecesetesocecesecstececesstesesesesssesecetotosesesesssesecesecesesocesscaserstetesesesespsececetececescces 

Notice that when you choose this desk accessory, a menu 
selection is added at the top of the screen. This menu is 
labeled Keycaps and allows you to select a font. By 
selecting the desired font, you can then view exactly what 
key is to be pressed to create a certain character out of that 
font. 
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New 

Open... 30 

Close 36K 

Save Graph S$ 

Save Graph As... 
Saar ee ene ero) eee | Ch apter 4 

Page Setup... é 

Print ber The File Menu 

Plot Setup... 

The File menu includes the commands that let you open 
data sets, save data sets on disk, open or save a graph, 
send your results to an output device, and quit the 
program. | 

New 
The New command opens a new, untitled data window. 
Cricket Graph allows you to have more than one data set 
open at the same time. You can create a new data window 
even if you already have a data set on the desktop. You 
are restricted only by the amount of memory available in 
your machine. 

Open... 
The Open command opens an existing data set or graph 
on the disk. You can open a data set even though you 
may already have another data set open. : 
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Click file name and then the Open button 

Graph Disk 

D2 Business Data ee as Graph Disk 
D Science Data 

A dialog box listing the data sets and graphs on the disk 
will appear, allowing you to select the file you want to 
open. To confirm the selection, you may click the Open 
button or double-click the selected file's name. The Eject 
button can be used to swap disks and get a data set froma 
different disk. If you have an external disk drive or a hard 
disk, you may use the Drive button to switch from one 
disk volume to another. 
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Close 
The Close command closes the currently active window. 

™ Do you want to save the 
2 changes made to ‘Business 

Data’ before closing? 

Cancel 

If you close a data window in which changes have been 
made to the data, a dialog box will ask you if you wish to 
save the changes. You may choose either to save the 
changes, cancel the operation, or discard the changes. 

Choosing Close has the same effect as clicking in the 
close box of the active window. 

Save Data / Save Graph 
The Save command works in one of two ways depending 
on whether the active window is a data window or a graph 
window. | 

If the active window is a data window, use this command 
when you want to update the data set on disk after making 
changes to it. 
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Title to be used in saving data set. If the data 2 
"has an existing name, it will be listed here. Name of disk 

Save this data set as: ' Graph Disk 

Cancel Drive 

SLRS AL ST TESTS 
ARETE ES EDS EPR SEUIET 

Switches Drives Ejects the disk 
Causes the data to be saved 

Returns to the program 

without saving the data 

If the Save Data command is used on data in an untitled 
data window, a dialog box will appear asking you to name 
the data set. 

icon for saved data 

Business Data 

Once named, the data set is stored with that name on the ~ 
disk. If a data set with the same name already exists when 
you use the Save Data command, the data in the active 
data window replaces the old version. 
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Graph Disk 

fy Husiness Data “> Graph Disk 

& Cricket Graph 
fy fmagewsiter 

™ Science Data 

Enter name to Save this Graph as: 
be used when ; 

saving graph ——>| Example Graph| Cancel 
and then click 

the Save button @® Graph format © PICT format 

If the active window is a graph, you will be able to save 
the graph to a disk file by using the Save Graph 
command. A dialog box (like the one above) will appear 
and you can give the graph a name. You can select one of 
two file formats in which to save the graph, Graph format 
or PICT format. 

icon for graph saved in Graph format 

Example Graph 

4 FT 

 |eon for graph saved in PICT format 

Example Graph 
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If you select Graph format, the graph can be reloaded into 
Cricket Graph at a later date and you can then continue to 
modify it. The PICT format saves the graph in a format 
that programs like MacDraw can read. Therefore, if you 
save a graph in PICT format, you will be able to open this 
file from within MacDraw. Appendix D illustrates how to 
do that. 

Save Data As... / Save Graph As... 
The Save As command is used to save a data set or graph 
on disk under a new name or on a different disk. 

(4) Graph Disk 

[Ss Husiness Date 

H Cricket Graph 
fy tmagemriter 

ey Selence Data 

cy Graph Disk <~—Name of disk 

Name to be used when saving the data 

If the active window is a data window, a dialog box will 
appear asking you to name the data set. If you wish to 
save the data set on another disk, you may use the Eject 
button to swap a disk for the one currently in the drive. If 
you have an external disk drive or a hard disk, you may 
also use the Drive button to direct the file to the hard disk 
or the external drive. 
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If the active window is a graph window, you will be asked 
to name the graph and you can select Graph format or 
PICT format. You can switch drives and eject disks just 
as you do when you save data. 

- Setup... 
The Page Setup eaunend lets you specify the size of the 
paper on which you will be printing information and how 
it will be printed. The dialog box that you will see 
depends upon which printer is currently selected. The 
following example assumes the currently selected printer 
is an ImageWriter. 

You can use the Orientation selection in Page Setup to 
rotate the page so that printing occurs across the widest 
part of the page. 

| ImageWriter 

Paper: © US Letter © A4 Letter 
© US Legal © International Fanfold 
© Computer Paper 

Orientation Special Effects: [x Tall Adjusted 
[]50 % Reduction 

frat 7 [] No Gaps Between Pages 

Select Tall Adjusted in this dialog box to print graphs to 
a true scale (so circles will be printed as circles instead of 

as ovals). 

Page Setup is dimmed if there are no windows currently 

on the desktop or if there is no printer resource on your 

disk. 
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Print ‘ 
The Print command produces a printed copy of the 
currently active window using the settings specified in 
Page Setup. If the active window contains a graph, you 
will be presented with a miniature page layout form. | 

Contents of Other Windows 

Contents of Active Window 

: | Page Border 

Grid Control 

| 
Grid: O a Off 

The outline of the page on the left side of the window 
reflects the current settings of Page Setup, such as size of 
paper and orientation. Images of all graphs in open’ 
windows will appear in this window. You can resize or 
reposition one or more of these graphs on the page (further 
details can be found in Chapter 13: Getting It On Paper). 
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If the active window was a data window, the data set will | 
be printed. If necessary, the printing of the data set will 
occur over several pages. 

Plot Setup... 
After choosing the Plot Setup command, you will need to 
set the options as desired in the plot dialog. 

Paper: @®8 1/2 H 11 Tall ©O8s 1/2 11 Wide 

© 11K 1? Tall ©11# 1? Wide 

Speed: @ Fast OMedium OSlow 

Pen Size: @® Narrow (.3mm) © Wide (.? mm) 

Scale Fonts: © Yes @® No 

Connector: @ Modem © Printer 

Minimize Pen Changes: © Yes © No 

Color Assignments to Plotter Pens: | 

Black Kaloo} Green Magenta 
White Blue Yellow 

Red Cyan 

This dialog is specific for the type of plotter that you will 
be using and allows you to set pen colors as well as other 
operating characteristics (details are not explained here, 
refer to Appendix F: Using Color Plotters). 
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Plot ae 
The Plot command sends your graph to a color plotter 
connected to one of the serial ports on the back of your 
computer. As with the Print command, you will be 
presented with a page layout window. 

The page layout for the plotter works exactly as described 
under the Print command. Details on selecting colors and 
other options can be found in Appendix F, which 
discusses plotters and their use. 

Quit 
The Quit command exits Cricket Graph and returns to the 
Finder. If any changes were made to the data, you will be 
asked if you wish to save the changes before returning to 
the Finder. 

mf. 9 7.9 7 PP Pw P 
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Copy Data 

Paste 36U 

Clear 3B 

Select All 

Chapter 5 
The Edit Menu 

Show Clipboard 

The Edit menu contains the standard Macintosh editing 
commands. It also contains an option that allows you to 
show or hide the Clipboard and its contents. 

Undo 
The Undo command is used by some desk accessories to 
undo your last action. In Cricket Graph, Undo serves a 
slightly different purpose as well. If the active window 
contains a graph with several data sets on the graph, each 
time you select the command Undo, the last data set 
drawn will be removed from the graph. You can Undo all 
overlaid graphs in the reverse order from the order in 
which they were added to the graph. You can Undo only 
up to the last remaining data set on the graph. 

Cut 
The Cut command removes selected text from the data 
window and places it on the Clipboard, replacing the 
previous contents of the Clipboard. The text on the 
Clipboard can be pasted back into a Cricket Graph data 
window or the Scrapbook, or even another application. 

& 
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Copy Data / Copy Picture 
The Copy Data command copies selected data in a data 
window to the Clipboard. The previous contents of the 
Clipboard are replaced. . : 

Business Data 

= Clipboard 

1968 15.9 16.2 13.0 
1973 23.1 17.4 12.1 
1978 24.8 22.9 15.4 
1983 22.6 25.3 9.4 

The Copy command differs from the Cut command in 
that it does not remove the item it has copied from the 
front window. 
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If the front window contains a graph, this command reads 
Copy Picture on the menu. Selecting Copy Picture 
copies a picture of the entire graph to the Clipboard. 

Business Data 

Data from “Business Data” 

2 ©80000080000000000000000000000200000 00008000 gaan gcc eonss0000000000000 ETD vacccce 

SOOO fer oe eo eee 

Oe Og EE ts oe 

© 000000000000000000000 4g 4 py 000000000 am ooe 

i HELE 
13 8661578 15 19 

Your 

1983 

The Paste command replaces the current selection 
(usually the insertion point) in a data window with the 
current contents of the Clipboard. If the Clipboard 
contains graphic images instead of text, the Paste 
command is dimmed and inactive. 

The Clear command removes the selected text from the 
data window. Clear also removes an optional item from a 
eraph if the item 1s selected. Once Clear has been used 
on a selection, you cannot recover that selection. 

& 
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Select All 
The Select All command selects all of the data in the 

_ active data window. This may be useful if you wish to 
move the entire contents of the data window to the 
Clipboard. 

Business Data 

Selected Data 

Show Clipboard / Hide Clipboard 
Use the Show Clipboard command to display the current 
contents of the Clipboard. If the Clipboard is already 
visible, this command changes to Hide Clipboard. 

Clipboard 
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The Clipboard is a temporary storage area for pictures, 
graphs and text. Anytime you use the commands Copy or 
Cut from the Edit menu, the items selected at the time are 
moved to the Clipboard. The most common form of 
importing and exporting data is by way of the Clipboard. — 
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Sort... 

Recode... 

Transform... Chapter 6 
Simple Math... The Data Menu 

Count Frequency... 

Smooth... 

The Data menu provides commands to manipulate your 
data. You can sort, recode, or transform data. You can 
also get a frequency count of the number of times each 
category or number occurs. All Data menu commands 
apply to the frontmost (not necessarily active) data 
window. If there are no data windows on the desktop, 
this menu 1s inactive (indicated by the gray appearance). 

Sort... 
Cricket Graph allows you to sort the rows in an entire data 
set according to the order of a particular column. Sorts 
may be done in ascending or descending order. All values 
in the same row as the element being sorted are moved 
along with that element. You can sort alphabetic as well 
as numeric data. Alphabetic sorts use normal alphabetic 
ASCI order (full details on sorting order can be found in 
Appendix B: Technical Details). | | 
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Sort the Data 

@® Ascending order 

© Descending order 

Cancel 

Simply choose the variable on which to sort and your 
choice of ascending or descending order. The sorting | 
algorithm keeps tied values in their original order during 
ascending sorts, and reverses the order of tied values 
during descending sorts. Tied values are values that are 
equivalent to each other (the values may be numbers or 
alphabetic characters). Preserving the order of tied values 
allows you to order the data by several variables. 

PPR PPAANAANAANANHAND 
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For example, to order a data set by cities within states you 
would sort first on the secondary category Sei and then 

GCE UCUEUd 

on the primary category (states). 

pases: 

States Cities 

Marulaad | Baltimore 
Primary Category Pennsylvania: Philadelphia | Secondary Category 

Maryland } Rockville | 
Virginia ; Vienna 

Delaware i Wilmington 
Virginia : Annandale 

Maryland } Annapolis 
Maryland } Ocean City 

States Cities 

Virginia 3 : 
Maryland } . Annapolis 
Maryland } Baltimore 
Maryland } Ocean City 

Pennsylvania! Philadelphia 
Mary land } Rockville | 
Virginia ; Vienna 

Delaware Wilmington | 

States Cities 

Sort by “Cities~ 

Annandale 

Sort by “States” 

Delaware | : Wilmington 
Maryland Annapolis 
Maryland Baltimore | | Sorted by Cities 

Sorted by States Maryland; Ocean City within States 
Maryland : Rockville 

Pennsylvania: Philadelphia 
Virginia ; Annandale 
Virginia ; Vienna 
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Recode... : 
You may use Recode to change one variable so that any 
cases with a value in a specified range are recoded into a 
single code. You are given great flexibility because the 
beginning and ending of a specified range may be either 
numeric or alphabetic. The specified recoded value (the 
value to replace all values in the designated range) may . 
also be numeric or alphabetic. 

If the minimum or maximum is alphabetic, the rules that 
apply to a sort (explained above) are used for making the 
comparisons. However, for recoding, lower case and 
upper case characters are viewed as the same. If one of 
the items specified in the range is alphabetic, they will 
both be treated as alphabetic. For example, if the 
minimum of the range is entered as "2" and the maximum 
is entered as "Red", the "2" will be treated as the 
alphabetic character and not as a number. 

The order of alphabetic characters goes from "A" to "Z" 
with "A" having a lower value than "Z". Characters for 
numeric digits and most common punctuation marks have 
lower order than alphabetic characters (a list of the order 
used in deciding recode ranges can be found in Appendix 
B: Technical Details). 
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Low end of range Words change to match 

Selected variable operators chosen 

Comparison operator 

Recode Data ©> Values 

Original Column 

Year <> ere ERE SEE STS SD 

US | 

Canada 

UK 

Destination Column: 

==) 
Name to be given new recoded column High end of range 

All values in range will be recoded to this value 

First select the variable you wish to recode. On the nght 
hand side of the dialog box you will see three text boxes 
with mathematical comparison symbols beside them. 
Decide what interval of the data you wish to recode. The 
smallest number or label in the interval should be entered 
in the first text box. You must then decide whether the 
recode should occur if a data value is greater than, greater 
than or equal to, or equal to this minimum value of the 
interval. Select the comparison you desire. 

6-5 Chapter 6: The Data Menu 



If you are recoding a range instead of a single value, enter 
the maximum value or label of the interval to be recoded 
in the second text box. Again you must decide which 
comparison is to be used for recoding data that is at or 
below the maximum interval value. Finally, in the third 
text box you must enter the new value to which data in the 
selected range will be recoded. All data falling within the 
interval and meeting the comparisons that you have just 
specified will be changed to this value, which may be 
either numeric or alphabetic. 

A text box at the bottom of the dialog window requests the 
name of the column in which to place the recoded results. 
Unless you specify a destination column name that is 
already present, the recoded data will be placed in the next 
available empty column. If you type a column name that 
already exists, that column's contents will be replaced with 
the recoded values. 
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For example, if you wish to recode all states whose first 
letter is between A through M then you would answer the 
following dialog as indicated. 

Select range as all states whose first letter is A-M _ 

(Note: <N is chosen to set upper limit as M) 

Recode Data Values greater 

than or equal to 

Original Column 

less than | | 

States within range will be recoded to this value 

The recoded data will appear as follows... 

Next available empty column 

Maryland } Baltimore } 
Pennsylvania: Philadelphia: Pennsylvania 

Maryland } Rockville } 1 
Virginia : Vienna : Virginia 

Delaware i Wilmington } 1 
Virginia } Annandale : Virginia 

Mary land } Annapolis } 1 
Maryland; Ocean City] 

1 
2 
3 
4 
S 
6 
7 
8 

5 i 

Original Data Recoded Data 
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Transform... | 
The Transform command allows you to perform a 
mathematical transformation on a column of your data and 
create a new column of data. The great flexibility in 
transformations provided can be very handy in both 
science and business applications. 

Data Transformation 

Variable: Operations: 

© In(x) © running sum 

Olog(x) ©percentages 

© e* © 2-scores 

O sin(x) © cos(x) 

© n® derivative 
n= 

O yn power 

Destination Column: 

Select the name of the variable to be transformed. You 
may then choose which of the listed transformations to 
perform by clicking the appropriate button. 

‘The In(x) transform computes the natural logarithm and 
log(x) computes the base 10 logarithm. 

The e* transform computes exponentials. 

PRP PpseerArArAAARnANRA LP 
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Sin(x) and cos(x) compute sines and cosines 
respectively. Both the sine and cosine transforms expect 
initial values expressed in radians. To convert degrees to 
radians you must first multiply all values by 3.14 (the 
value of "pi") and then divide by 180. You can 
accomplish the multiplication and division using Simple 
Math from the Data menu. | 

Running sum simply adds up all values from the 
beginning of the column to that point and uses the 
accumulated sum as a replacement for the actual value. 

Percentages are calculated using the sum of all values in 
the column as the denominator. 

— yen VENUE 3 
Sum of Values 
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Z-scores are the number of standard deviation units éach 

value is from the mean of the data. The mean and 
standard deviation of the data are calculated and the 
Z-score for each value (we'll call the value "x") is 
computed as follows... : 

. X — Mean 

~ Standard Deviation 
l 

For instance, the Z-transform of a data value is 1.8, that 
means the value is 1.8 standard deviation units away from 
the mean. 

If you click either the nth derivative or the x" transform, 
the text box to the right of these selections will become 
active and you may enter the value of n. poet Pent Pee | is | en | UL | UE 

Values [f"s* - ¢ eee a 
Derivative Derivative — Note that for each 

order derivative, 

you lose a value 
at the beginning of 
the series 

A first order derivative is the slope at that point and is 
computed by finding the difference between each adjacent 
value. Second order derivatives are computed using the 

P| ee | | | a 
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difference between the first derivative values (in other 

words, the differences between differences). Each higher — 

order derivative is computed in the same manner. 

Data Transformation 

Variable: Operations: 

© In(x) © running sum 

© log(x) © percentages 

© e* © 2-scores 

© sin(x) © cos(x) 

nth derivative 
4 (2.00, @® x" power 

Destination Column: 

The x" transform can be very valuable because of the 

wide range of transforms that can be obtained using this 

option. Values of this power do not have to be integers — 

and may be either positive or negative. 

In fact you can obtain roots or inverses with the x" 

selection. For instance, suppose you wish to transform a 

data set to obtain the square roots of the data. The square 

root of x is equivalent to x raised to the 1/2 power. You 

would simply enter 0.5 to obtain this result. 

Square Root of X = Wie. 305 

Cube Rootot xX = xX” = 3 

a 
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You may also obtain the inverse of the data, in other 
words, 1 divided by the data value. The inverse of a 
value, 1/x, is equivalent to x. Therefore, you may 
obtain such a transformation by selecting x" and entering 
-1 in the associated text box. 

ly Xx = a! 

Bip owen 

After you select which column is to be transformed and 
which type of transformation to perform, the column 
containing the transformed data will automatically be 
placed in the next available empty column in the data 
window unless you specify the name of a column that 
already exists. In that case, the results will replace that 
column. 

Simple Math... | 
With Simple Math you may add, subtract, multiply or 
divide one column by another column or a constant. This — 
option is very handy if you have data with extremely large. 
or small values. For example, suppose the data you are 
about to graph contains numbers ranging around 
10,000,000. With numbers this big, the axis labels on the 
graph would look a little messy. 

Scaling the data by dividing all values by 1,000,000 will 
make this graph look neater. You would then change the 
axis label to say that the values graphed are in units of one © 
million. 
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Simple Math Data Transformation 

Destination Column: 

Select the variables to be used in the mathematical 
operation. The order of selection is important in 
subtraction and division. The variable selected in the 
lefthand box will always be operated on by the variable in 
the righthand box. 

For instance, 1f you choose subtraction, the variable in the 
righthand box will be subtracted from the variable in the 
lefthand box. The order of selecting variables for the 
mathematical operations is from left to right, just as you 
would write them on paper. 

If you want to perform the same calculation with several 
variables, you can select more than one variable in the 

righthand box. If you chose both Canada and UK in the 
righthand box with the "+" operator selected, for example, 
the transformed result would be US+Canada+UK. If you 
chose the minus sign, the result would be US-Canada-UK. 

& 
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Simple Math Data Transformation 

Constant: 

‘Destination Column: 

By clicking the Constant text box, you indicate to Cricket 
Graph that you wish to use a constant value rather than 
another column. 

The righthand variable selection box will become gray and 
inactive and the Constant text box will darken and become 
active. Simply enter the constant that you wish to use. 
The order of operation is the same as above. The constant 
is a replacement for the variable that would normally be 
chosen in the righthand selection box. 

The mathematical results will be placed in the next 
available (empty) column in the data window unless you 
specify the name of a column that already exists. In that 
case, the results will replace that column. 

To get the average of four variables you could first 
perform one operation that adds the four of them together, 
and then perform a second operation to divide the sum by 
the constant 4. 
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Count Frequency... 
You can count the number of occurrences of a value or a 
category in a column by using the Count Frequency 
command. This is useful when you want to put raw data 
in a form from which you can draw bar or column graphs. 

Count Frequency of Categories 

Cancel 

- Select the column that contains the values of interest. The 
next two available columns (empty columns) in the data 
window will be used to store the results. 

& 
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Cricket Graph creates one column with the unique names 
of the values or categories and a corresponding column 
containing the frequency of occurrences for each. 

Untitled Data 

Values 

1 
2 
3 
4 

-) 
6 
7 
8 
9 

oF al 

Columns created by using 

the Count Frequency command 

Smooth... 
With the Smooth command, you can take very irregular 
data and average it out so as to make a graph of the data 
appear much smoother. The technique used here is a 
sliding or running average smooth. 
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23/5 

26/5 
24/5 
| “ene 

Smoothed Data 
(width=5) ~ blank blank ne tik @6 S248. 44 dee 52 48 4.4. etc... 

That means that if you performed a smooth with a smooth 
width of 5, for each group of 5 values, the 3rd value in the 

eroup will be replaced by the average of those 5 values. 

Smooth Data 

Smooth Width (add # of points): [9 | 

Cancel 

To perform a smooth, it is only necessary to select the 
column containing the data and the smooth width. 
Smooth widths should be odd values. If you enter an even 
value, the next higher odd value will be used instead. — 

x 

& 
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Results are stored in the next available (empty) column. 
_ An automatic name is given to that column indicating the 
chosen smooth width, but you are encouraged to change it 
to a name that suits you. 

rmrPrHP HP PHP PPA 
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Graph 

eater Line 

Chapter 7 
The Graph Menu 

= 
Qc DoubleY Tex 

The Graph menu is probably the most used menu in the 
program. It is here that you select the type of graph that 
you wish to create. This menu contains icons, as well as 
names, to allow you to get the "feel" of the types of graphs 
you can choose. Selecting your graph is as easy as 
clicking over the menu, dragging to the desired graph type 
and letting the mouse button go. 

There are twelve available graph types with many 
variations available for each. Some suggestions and hints 
for each kind of graph are discussed in this chapter. It is 
also advisable to refer to Appendix A for suggestions to 
keep in mind when creating graphs for presentations. 

Examples for each kind of graph are also presented. The 
examples have been "enhanced" using facilities that are 
readily available in Cricket Graph (see Chapters 8 and 10). 
These illustrations serve as an example of how you can 
customize your own graphs. 
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Selecting Variables 
After selecting a type of graph from the Graph menu, you 
will be presented with a dialog box requesting the 
variables to graph. You may choose one variable for the x 
or categorical axis and one or more variables for the y or 
value axis. 

Type of Graph chosen 

=, iy 

| Types of Columns needed 

Fa Column Graph 
Column 

Categories Values 

Cancel 

Only one selection allowed in this box 

Multiple selections allowed in this box 

If you wish to have several sets of values overlaid with 
one another on the same graph, you may drag through the 
desired variables in the right hand scroll box (except for 
pie graphs). The variables you select do not have to be 
next to one another going down the column. You can 
drag through several variables, skip a couple of variables, 
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and then drag through some more variables. Clicking a 

selected variable (indicated by being highlighted in black) 

will toggle off that variable selection. 

Remember though, if you choose to overlay graphs in this 

manner, the data sets must all have the same x-axis or 

categorical variable. Therefore, you can only select one 

variable in the lefthand scroll box. | 

Though the number of overlays you can create is 

theoretically limited only by the available memory, you 

have up to sixteen unique plot symbols or patterns to 

choose from in Cricket Graph. A graph containing more 

than sixteen sets of data would be confusing because some 

of the symbols or patterns would have to be used more 

than once. As a matter of practice, you would not want to 

overlay that many sets of data anyway. Refer to the 

section on "Do's & Don'ts of Creating Effective Graphs" in 

Appendix A for tips and suggestions. 

If the active window contains a graph that is of a type 

compatible with your new selection (1.¢., it is appropriate 

to overlay one over the other), then the Overlay Plot 

button becomes active. This is how you can overlay a set 

of data on a graph that already exists. 
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Scatter : 
The scatter graph is typically used as an analytical tool to 
explore the relationship of one variable with another. 
Each plot symbol can represent a different set of data and 
many sets may be overlaid (placed on top of one another) 
on the same graph. Each new set of data will be 
represented by a new plot symbol (up to Cricket Graph's 
maximum of 16). 
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The variables need not be dependent and often are not. 
Large data sets (1.e., greater than 100 data points) are 
ideal candidates for scatter graphs. In fact, for very large 
data sets (i.e., greater than 1000) a small plot symbol (a 
simple dot) is available and is recommended so that the 
plot symbols do not become overcrowded on the graph. 
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The data representing the x-axis (horizontal axis) may be 
either numbers or categories. Cricket Graph will accept 

both. However, the y-axis (vertical axis) must always be 

represented by numbers. Cricket Graph will warn you that 

it cannot complete the graph if you choose a variable for 
the y-axis that does not contain numbers. 

Scatter graphs are usually the basis for best fit lines (using 

one of several regression equations) or placing an 

interpolated line (a form of electronic French Curve). 

Science Data 
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A regression line may be calculated and drawn through the 

data points or a Stineman interpolation may be used to 

draw a smooth line through each and every point. These 

options are available on the Curve Fit menu, which is 

described in Chapter 9. 

For each measured data value, there exists a known or 

computed error in that measurement. Many scientists use 

error bars in graphs to represent this error. Cricket Graph 

allows you to place error bars in both the horizontal (x) or 

vertical (y) directions. The method for doing so is 

described in Chapter 10 (The Goodies Menu). 

& 
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‘Line 
Line graphs are ideal for depicting trends over time or the 
distribution of one variable over another. Many points can 
also be represented in this type of graph, making it the 
ideal kind of graph if the number of data points makes 
other forms of graphs (e.g., column graphs) hes too 
cluttered. 

Untitled 

Comparison of Experiments 

Signal *1 
4 Signal *2 

om 
A) 
aed 
_— 

2 
> 

Ted 
i] 
== 
pe 

E 
ed 

r= 

LJ 

& 
mn 

ome 
27) 

Time (minutes) 

The data representing the x-axis (horizontal axis) may be 
either numbers or categories. Cricket Graph will accept 
both. However, the y-axis (vertical axis) must always be 
represented by numbers. Cricket Graph will warn you that 
it cannot complete the graph if you choose a variable for 
the y-axis that does not contain numbers. 

As with scatter graphs, you may add HTRRIRASON lines and 
error bars. 
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Area 
An area graph with only one set of data being graphed is 
no more than a line graph with the area under the line 
filled in. Area graphs begin to take on a different 
perspective, though, when you add multiple sets of data to 
the graph. As different sets of data are added to the area 
eraph, the line drawn for each set is successively added to 
the value of the previous set. This is useful for looking at 
large sets of data where a comparison is to be made about 
different sets of data over time or among categories. 

Area graphs consist of a series of 

data successively added together 

& 

7-7 Chapter 7: The Graph Menu 



The data representing the x-axis may be either numbers or 
categories. The y-axis must always be represented by 
numbers and Cricket Graph will warn you that it cannot 
complete the graph if you choose a variable for the y-axis 
that does not contain numbers. 

Untitled 
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Bar 
Bar graphs are ideal for representing comparisons of 
values collected for a number of categories. The 
categories may be months, years or just about anything 
that distinguishes one group from another. One axis is 
always a representation of numbers. Multiple sets of 
values for each category may be placed side by side, 
making comparisons and contrasts effective. 
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The bars in a bar graph are horizontal with the categories 
being grouped along the vertical axis. 

The data representing the y-axis may be either categories 
or numbers. However, the x-axis must always be 
represented by numbers. Cricket Graph will warn you that 
it cannot complete the graph if you choose a variable for 
the x-axis that does not contain numbers. 

Error bars in the horizontal (x) direction may be placed on 
the bars for each set of data (more details in Chapter 10: 
The Goodies Menu). 
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Column | 
A column graph is like a bar graph except in its orientation 
on the page (in fact, many people confuse column graphs 
with bar graphs). The bars in a column graph are vertical 
with the categories being grouped along the horizontal axis 
and the values for each category along the vertical axis. 
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The data representing the x-axis may be either categories 
or numbers (but like bar graphs, the numbers will be 
treated as categories). The y-axis must always be | 
represented by numbers and Cricket Graph will warn you 
that it cannot complete the graph if you choose a variable 
for the y-axis that does not contain numbers. 

Error bars in the vertical (y) direction may be placed on 
the bars for each set of data (more details in Chapter 10: 
The Goodies Menu). 
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Pie 
Pie graphs are ideal for comparing the relative sizes of 
various categories and the percentage that each category 
adds to the whole (the sum of all contributions). Often, 
one of the slices is dragged out from the pie to emphasize 
that category. 

Untitled 

US Sales 

Quarters 

Typically, one variable contains the category names and 
one variable contains the associated values for each of the 
categories. Negative values cannot be represented with 
this type of graph and Cricket Graph will warn you if it 
encounters any values less than zero. 

See, 

® 

* 
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Stacked Bar 
Stacked bar graphs are ideal for presenting comparisons of 
values for several sets of values and their contribution to 
the whole. Stacked bars are created for several categories 
and the categories may be months, years or just about 
anything that distinguishes one group from another. 
Multiple sets of values for each category may be placed 
end on end for each category, making comparisons and 
contrasts effective. 
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The bars in a stacked bar graph are horizontal, with the 
categories being grouped along the vertical axis and the | 
values for each category along the horizontal axis. 
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Remember, though, each bar is laid end to end with the 
previous bars for each category. Negative values cannot 
be used in this type of graph. If Cricket Graph runs across 
a value less than zero, it will warn you that it cannot 
complete the graph. 

The data representing the y-axis may be either categories 
or numbers (numbers will be treated as categories). 
However, the x-axis must always be represented by 
numbers. Cricket Graph will warn you that it cannot 
complete the graph if you choose a variable for the x-axis 
that does not contain numbers. 

8 
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Stacked Column 
The bars in a stacked column graph are vertical with the 
categories being grouped along the vertical axis and the 
values for each category along the horizontal axis. Each 
bar is laid bottom to top with the previous bars for each 
category. Itis very much like a stacked bar graph except 
for its orientation. Negative values cannot be used in this 
type of graph. If Cricket Graph runs across a value less 
than zero, it will warn you that it cannot complete the 
graph. 
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The data representing the x-axis may be either categories 
or numbers (numbers will be treated as categories). 
However, the y-axis must always be represented by 
numbers. Cricket Graph will warn you that it cannot 
complete the graph if you choose a variable for the y-axis 
that does not contain numbers. 
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Polar 

A polar graph is an entirely different type of graph that is 
used quite frequently in science and engineering. The 
axes for this type of graph are drawn using the polar 
coordinate system (most other graphs are drawn on a 
rectilinear coordinate system). 

Untitled 
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The graph is created by plotting data points that aré 
described as the distance from the center of a circle (the 
radius) and their relative angle (in degrees) from a 
reference point. The reference point is typically at the 3 
o'clock position if you were looking at a clock. The 
degrees increase from this point of reference as you go 
counter-clockwise. 

Radius 
(distance from center) 

Angle 
Cin degrees) 

Points described by Angle and Radius 

The Polar graphs created in Cricket Graph can use a 
variety of plot symbols. Therefore, several sets of data 
can be overlaid on the same plot. 
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After you select the Polar Graph option in the Graph © 

menu, you will be presented with a dialog requesting the 

variables to graph. 

Polar Graph 
Polar 

You can choose one variable for the measured radius and 

one variable for the measured angle. 

It is best to graph one set of data at a time in this case. 

Later on, after the graph is initially created, you may go 

back and lay another set of data on the graph. The 

reasoning for this is that each set of data may have 

different radii and different angles. Overlaying another set 

of data is accomplished by making sure the polar graph to 

be overlaid is the active window, selecting Polar from the 

Graph menu, picking the new variables and clicking the 

Overlay Plot button instead of the New Plot button. 

& 
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QC 
Quality control graphs are statistical devices used for the 
study and control of repetitive processes. The goal of 
quality control graphs may be summarized as follows: 

(1) a method for defining and setting management goals 
(2) an instrument for attaining and tracking those goals 
(3) a way of judging whether those goals are being met 

Cricket Graph offers eight varieties of quality control 
graphs. By no means can the theory behind these graphs 
be explained in this manual since it typically requires an 
entire textbook. However, the purpose for each graph and 
its expected input are briefly explained. You are 
encouraged to use the literature listed in the references at 
the back of this manual if you need further information on 
the theory behind these graphs. 

Quality Control Graph Type 

®HR © NP 

OS OP 

OR Oc 

OS Ou | 
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You will find that all quality control graphs have certain 
common characteristics. The line plotted is usually either 
raw counts of the number of nonconformities encountered 
in a sample or a computed value taken from the sample. 
The average of these values is then graphed as a central 
line (in the case below, it is labeled X with a double bar 
above it). From the data, statistical computations are 
performed which compute an acceptable deviation from 
the average. The central line plus and minus this 
deviation determine the upper control limit (UCL) and the 
lower control limit (LCL), respectively, which are graphed 
as heavy lines. Sometimes a quality control graph will not 
have a lower control limit due to the fact that it was 
computed as being zero. 
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Any values falling outside these computed control limits 

are suspect and should be scrutinized. A number of other 

criteria can also be used along with control charts to 

measure and track control. A good book on statistical 

quality control will point these out. | 

8 
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The differences between the eight QC graph types ° 
basically lie in the kind of data expected and the 
computation of the midline and control limits (the 
computations for each of the QC types are listed in 
Appendix B: Technical Details). 

The first four quality control graph types are simply 
variations on how the central line and control limits are 
determined. Two graphs are created when you choose any 
one of these first four control graphs. 

In the first graph, the central line represents the average of 
sample means (denoted by an X with a double bar over it) 
or the average of medians (denoted by X with a tilde and a 
bar over it). The control limits may be based on the 
average of the sample ranges or the average of the sample 
standard deviations. 

In the second graph for each of these four quality control 
types, the computed ranges or standard deviations for each 
of the samples are plotted along with control limits. 

The NP graph 1s used to track the number of items found 
to be nonconforming. All samples must be of the same 
size to use this type of graph. The data expected is the 
actual count of nonconforming items found in each 
sample. A dialog will appear requesting you to select the 
column containing the number of items found 
nonconforming in each sample and the sample size. 
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The P graph is essentially a graph of the proportion of 

nonconforming items in a sample with samples being 

taken over a period of time. The samples may or may not 

be the same size but corrections must be made to the 

control limits if the sample sizes vary by more than 25%. 

Cricket Graph will continue to finish the graph if sample 

sizes do deviate by more than 25%, but a warning will be 

posted and the control limits should not be accep
ted. 

A dialog box will appear requesting you to select the 

column containing the number of items found 

nonconforming and a column specifying the size of the 

sample from which these items were taken. 

The C graph is essentially a graph of the number of 

nonconforming items per unit of constant size. A dialog 

box will appear requesting you to select the column 

containing the number of items found nonconforming per 

unit. 

The U graph is like a C graph except that counts are the 

number of nonconforming items per unit of varying size. 

A dialog will appear requesting you to select the column 

containing the number of items found nonconforming and 

a column specifying the size of the unit used to obtain this 

number of nonconformities. 

& 
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Double Y | ‘ 
The double Y axes graph allows you to graph two 
variables on the same graph that may be on entirely 
different scales. For instance, suppose you were running a 
biological experiment and wanted to graph the cell count 
of bacteria over time versus a measured charge over that 
same time period. 

The horizontal axis must be equivalent for both sets of 
values but the two sets of values used for the vertical axis 
can be measured on entirely different units of scale. This 
kind of graph is especially useful for comparing combined 
trends when the two sets of data cannot be measured in the 
same units. 

Double ¥Y Axes Line Graph Select two from 
DoubleY this selection box 

Horizontal (H) Axis Vertical (Y) Axis 

Time 

Cell Count Cell Count 

Charge Charge 

Cancel 

After selecting DoubleY from the Graph menu, a dialog 
box will appear. Select one variable for the horizontal 
axis and two variables for the vertical axes. Only two 
variables can be selected for the vertical axes. 
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One variable is graphed with its units of scale on the left 
and the other with its units of scale on the right. The two 
vertical axes can be switched using the Switch Axes 
command from the Goodies menu (more about that in 
Chapter 10). Each axis can be changed independently 
(e.g., min, max, etc.). | 

8 

7-23 Chapter 7: The Graph Menu 



Text 3 . 
This type of graph is sometimes used when you wish to 
create a slide or image that contains only words. It is 
quite useful for creating blocks of text and then, using 
Cricket Graph's page layout capabilities, placing this 
block of text next to another graph in page layout before 
printing. 

———————————— Untitled 

Sn a text graph, you can... 
@ include text & select Font, Size and Style 

®@ include rectangles & rounded rectangles 
® include lines & arrows 
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After you select the Text menu command, a blank 
window will appear. If the Tools window is not visible, it 
will be made visible. With the Tools window, you can 
place text, rectangles, lines and arrows in this empty 
window (the Tools window and its use are fully described 
in Chapter 10: The Goodies Menu). 
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Combination of Column and Line 
You can create a graph that is a combination of column 
and line graphs. First graph one or more sets of values as 
a column graph. Then select Line from the Graph menu. 
You can choose one or more sets of values for the vertical 
axis. You must choose the same variable for the 
horizontal axis as you did for the column graph. By then 

clicking the Overlay Plot button, you will place the line 
on the column graph. 
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Chapter 8 
Changing Items in the Graphs 

Once you have created a graph, you can change almost 
anything on it easily and quickly by using one of three 
methods. 

To move an object, just point to it and drag. 

To change an object, just point to it and 
double-click, A dialog box will appear that lets you 
accomplish more complex changes. 

To select a part of the graph for changes, just point 
to it with the cursor and click. This is used for 
placing error bars, performing curve fits and 
selecting colors. 

If you are not familiar with the methods of selecting, 
dragging, and double-clicking please refer to the 
Macintosh Guide that came with your machine. 
Everything on a graph can be customized or changed by 
just doing one of these operations. 
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This chapter describes how to change items on a graph. 
The next chapter describes how you can use additional 
tools to add text, rectangles, lines and arrows to your 
graph. To illustrate the areas where you can click to 
change various parts of the graph, they will be inverted 
(highlighted in black) in the illustrations. 

Changing an Axis 
To change an axis, you simply point to the desired axis 
and double-click (Note: To change a polar axis, 
double-click the labeled horizontal line passing through 
the origin of the graph). 
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Depending on what type of axis was double-clicked, one 
of two dialog boxes will seem to zoom out. In these 
boxes are a number of items or details about that particular 
axis. Any one of these items can be changed. | 

If the axis was a numerical axis then the following dialog 
will appear... 

Vertical (Y) Axis Format 

Axis Ticks 

Mark Grid 

Minimum: 0.000 Major: bX a 

Maximum: |20.000 Minor: XxX CJ 

Increment:| 10.000 Inside: (] 

© Linear OLog Axis on: © Left O Right 

The minimum, maximum and increment items are text 
boxes that contain the current settings of these items. To 
change any one of them simply click the value you wish to 
change, then type in the new value. All the standard 
Macintosh editing features can be used to change or edit 
this value. 

By clicking either the linear or log radio button (they are 
called radio buttons because only one of the two can be on 
at any given moment), you can choose whether that axis 
will have a linear scale or a logarithmic scale. 

& 
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The check boxes for the tick marks and grid lines (both 
major and minor) can be turned on or off by clicking 
them. The tick marks can be placed on the inside of the 
axis by turning the Inside option on. An "x" appearing in 
the box indicates that it is on. 

Minor Tick Marks 

10 

major major and minor 
tick marks and grid lines tick marks and grid lines 

If the axis you are changing is a vertical (y) axis, you may 
also use the radio buttons to choose whether it will appear 
on the left or right side of the graph. 
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If the axis was categorical then the following dialog will 
appear... | 

Vertical (¥) Axis Format 

Ticks 

Mark Grid 

Major; ([] [4 

Minor: xX. [] 

Inside: ([] 

flnis on: @ Left © Right 

With a categorical axis, you have the option of turning on 
or off the major and minor tick marks and grid lines. You 
cannot (nor would it be appropriate to) change minimums 
and maximums or convert to log scales. Vertical 
categorical axes can also be placed on either the left or 
right. The tick marks can be placed inside the axis by 
clicking the Inside option. 

Minor Tick Marks 

Major Tick Marks 

Major & Minor Tick Marks for Categorical Axes 
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Changing the Tick Labels 
By double-clicking either one of the tick label regions, 
you can change the font, style and size of the tick mark 
labels. 

Business Data 
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The following dialog will appear with the current settings 

pre-selected... 

All fonts 

; as a currently 
Vertical (Y) Axis Tick Labels sastalled in 

; . ae System file 

Style: Font: are displayed 

[X] Plain 

[] Bold 
= You can click 

i TT HE on an available 

[] Italic BEE font size 

(] Underline HE 

[] Outline 
? pets 

i ion: aser Writer, 
C] Shadow Orientation: A cineite 

C] Condense ® Horizontal © Vertical shedesired 
font size 

[] Extend Notation: 

| ® Decimal © Scientific 

Digits: \ regular decimal 
‘notation can be 

selected as well 

Cancel as the number of 
decimal digits 

Scientific or 

You can also choose either a vertical or horizontal 

orientation for the labels. A vertical orientation means 

that the text will be printed going up the graph, rather than 

across the graph. Both vertical and horizontal tick labels 

can have a vertical orientation. 

® 
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Changing Plot Symbols or Bar Patterns | ; 
All patterns and symbols are changed by double-clicking 
the symbol or pattern in the legend. Clicking the symbol 
or pattern in the graph itself will not allow you to change 
that symbol or pattern. The reason for this is that you 
might have a thousand or more points in the graph. 
Locating and distinguishing one symbol or pattern from 
another could present a problem. Therefore, Cricket 
Graph uses the legend as the control area for changing 
symbols and patterns. 

To change, double-click the desired pattern or symbol. 
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If the item you double-clicked is a pattern, then you will 

be presented with the following dialog box... 

BZOaZURea 

The pattern you clicked comes up pre-selected. This is 

indicated by the black box around the pattern. You have 

sixteen patterns from which to choose. Clicking a pattern 

will select that pattern. After you click the OK button, 

the pattern that was used in the graph will be changed to 

the new selection. 

ft 
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If the item you double-clicked is a plot symbol, the = 
following dialog box will appear with that symbol 
pre-selected... 

Plot Symbol 

Notice that the last symbol is a simple dot. This is very 
useful if you have a very large data set and the plot 
symbols are overcrowded on the graph. Click the new 
symbol you wish to use and then click the OK button. 
The new selection will replace the symbol that was 
previously used. 
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Changing the Legend 
By double-clicking the text in the legend, you can bohaae 

the way the legend will appear. 
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The following dialog box will appear with all the current 
settings pre-selected... 

All fonts 

currently 

installed in 

System File 

are displayed 

>] Plain 

[ ] Bold 

[] Italic 

You can click 

on an available 

font size 

[] Underline 

[_] Outline 

[_] Shadow Border: you can enter 

[] Condense @None OL__] the desired 

If using a 

LaserWriter, 

font size 

You can change the font, style and size used for the text in 
the legend. You can also choose to have a border 
surround the legend. 

The legend can also be moved within the graph. Click in 
the legend area and drag the outline of the legend to the 
new location. After you release the mouse button, the 
legend will be redrawn at that location. 
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Changing Text 
Each time a new graph is created, several text items are 

automatically placed on the graph. These include the 

eraph title and labels for each of the axes. Cricket Graph 

tries to determine the best words to place in each line of 

text but you are encouraged to change them. In fact, after 

overlaying several sets of data in a graph, you will almost 

certainly need to change the vertical axis label - perhaps to 

indicate the units used in the measurement (e.g., "Millions 

of Dollars"). : . | 
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To change text, double-click it and the following dialog 
with the current settings for that text pre-selected will 
appear... 

Displayed text can be edited or replaced 

Text: All fonts 
Data from "Business Data" currently 

installed in 

Style: Font: ize: System File 
* are displayed 

[_] Plain 

[x] Bold You can click = Italic 
ay a available 

: 
SHeis 

Ont size 
(_] Underline 
[-] Outline : : aS ‘t C] Shadow yd sprees ane jalan enter @ Horizontal © Vertical the desired [_] Condense 

font size 
[] Extend Cancel 

The text box at the top of the dialog contains the current 
text selection. By using the standard Macintosh editing 
conventions you may change what the selected text will 
say. You can also change the font, style and size to be 
used. Either a vertical or horizontal orientation may also 
be selected. | 

A set of tools are available in Cricket Graph, described in 
Chapter 10, that let you replace any labels or titles you 
have accidentally removed. These tools also allow you to 
add additional text to the graph. 
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Resizing the Plot Frame 
The area in the graph where the data values are drawn is 
called the "plot frame." The plot frame is a framed area 
within the window region which is usually bounded by 
axes. 

Business Data 
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i select the plot frame. 
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If you click the mouse within this frame, an outline will | 
appear around the frame. You may move the frame — 
around within the window by pressing the mouse button 
down inside the frame and dragging. Dragging the gray 
rectangle at the lower right corner of this frame will 
change the size of the plot frame within the window. 
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You may find this option useful if you would like to place 
a lot of text along one side of the graph and wish to drag 
the plot frame off to one side of the window to See room 
(as illustrated below). 

Business Data 

Data from “Business Data” Plot Frame was 
repositioned and 

—_—— resized to make 
room for text. 

Graph showing 

US sales versus 
| Mus sales in Canada 

Hi Canada and the United 
UK Kingdom. Millions 
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Year 
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Exploding a Pie Graph 
In pie graphs, emphasis can be placed on one or more of 
the categories (each category comprising a slice of the pie) 
by dragging that slice or slices out from the center of the 
pie. This is referred to as "exploding" the pie. 

Business Data 

— Dragging a slice of the 

——______—— Pie Graph can be effective 
in emphasizing that slice. 

Simply click the slice you wish to explode and drag that 
slice. The wedge of the pie will only move along a line 
radiating from the center of the pie outwards. This will 
help you keep individual wedges of the pie aligned 
properly. 

If you add depth (for a 3-D effect), you will still be able to 
explode individual slices of the pie. 

& 
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Deleting a Set of Data | 
Cricket Graph allows you to overlay multiple sets of data 
on most types of graphs (pie graphs and quality control 
graphs are exceptions). There are a couple of ways to 
remove a data set from a graph once the graph has been 
created. 

If you wish to remove the last data set drawn on the graph 
(last one listed in the legend), simply select Undo from 
the Edit menu. Each time you select the Undo 
command, the last data set drawn on the graph will be 
removed. You can keep on undoing data sets until you get 
to the last data set on the graph. This last data set cannot 
be undone (there wouldn't be any data to graph then!). 

Business Data 
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A more flexible way to remove data from a graph is to 
click its plot symbol or pattern in the legend. This selects 
that data set. Once the data set you wish to remove is 
selected (indicated by a gray box around the plot symbol 
or pattern), you can press the Backspace key or select the 
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Clear command from the Edit menu. If you have the 
optional Macintosh numeric keypad, you could also press 
the Clear key to delete the data. 

When you remove data from a graph, the axis parameters 
(minimum, maximum and increment) are not recalculated. 
You may find that after removing a data set, you need to 
change the minimum and maximum to present a better 
looking graph. 

er: 

8-19 Chapter 8: Changing Items in the Graph 



G
C
U
V
U
E
V
O
V
U
E
V
O
E
V
E
D
E
R
Y
E
D
S
 



MIO OT CVC Vee ea ee 

Curve Fit 

Simple 

Polynomial 

L ithmi 

eal Chapter9 
The Curve Fit Menu 

Remove 

The Curve Fit menu allows you to fit a variety of curves 
to a scatter or line graph. Therefore, this menu is only 
enabled when the frontmost and active window contains a 
scatter, line or double Y axes graph. The curves you can 
select include four types of regression and an interpolation 
routine that fits curves through every point as though an 
artist had used a French Curve. 
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Selecting the Data to Fit | 
If you select a curve fit option for a graph that contains 
more than one set of overlaid data, the curve will be fitted 
automatically to the last set of data added to the graph. If 
you would like the curve fit to be performed on a specific 
set of data, click the data's plot symbol once in the legend. 
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A dotted rectangle will appear around the plot symbol to 
show that it is selected. Select the command for the curve _ 
fit you would like from the Curve Fit menu. If your data 
set is large, the computer may take a few moments to 
calculate the best fit line before it begins drawing i line 
through the data points. 
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The Various Regression Fits 
You can select one of four types of regression: simple, 
polynomial, exponential, and logarithmic. The equation 
computed during the regression is placed on the graph. 
You can alter or move the equation exactly the same way 
as you can change any other text item placed on the graph 
(changing text is fully described in Chapter 8). 

The equations used to fit the regression curves are as 
follows... : 

Simple: — Y; = aX; +b + error 

Polynomial: Yj; =a ,X; + anX.2 +... + a,X;" + error 

Logarithmic: Y;=a* X; b error 

Exponential: Y;=a* 10(6*A1) 5 error 

The polynomial order 

Click here to decrease order Click here to increase order 

Order of Polynomial: 

After setting order, click here to proceed 

If you selected the polynomial curve fit, a dialog box will 
appear where you can enter the order of the polynomial. 
The order of the polynomial can be as high as five. 

& 
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Interpolation | ’ 
An interpolation routine is also available in the Curve Fit 
menu. 

Regression fits try to obtain the "best" fit through the data 
points and summarize by describing the data with an 
equation. The regression line may or may not pass 
through all the data points. Interpolation differs from the 
regression fits in that the fitted line is required to pass 
through each and every point. Interpolation is the 
equivalent of using an electronic "French Curve". 

There are at least four popular methods of interpolation. 
The Stineman interpolation was chosen for Cricket Graph 
because it is the "best behaved" (a reference is listed in the 
back of this manual). All interpolation routines can get 
messed up under certain circumstances. 
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The Stineman routine will perform better than other 

routines under a wider variety of conditions, but it can 

also get confused if the data points are difficult to fit. 

When the interpolation routine is unable to fit a good line, 

you will know because the fitted line will look absolutely 

awful. If this happens, your graph would probably look 

better if you try fitting a regression line instead. 

Removing a Fitted Curve 
By selecting a set of data, clicking in the legend on its plot 

symbol just as you would for placing a fitted curve, you 

can then choose the Remove command from the Curve 

Fit menu to remove any lines currently fitted through the 

selected data. Removing the curve does not remove the 

equation. To remove the equation representing a fitted 

curve, click it and then press the Backspace key. 
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Goodies 

Show Tools eT 

Show Colors 

H Error Bars 

Y Error Bars 
(onion eka oie Chapter 10 

Hide Legend 3€L } 

Add Depth #3| The Goodies Menu 
Remove Plot Frame 3F 

Switch Axes 

Add Value Labels 
0000009 00000000000000008 0000508000000 088 008000000209 009RH 2000000000 0000000090000000009 

Record Preferences 

The Goodies menu contains a number of useful options 

for each of the graphs that you may create. These 

commands typically add something to the graph in 

addition to what is already there. Many of the commands 

simply toggle a feature on or off. 

Several of the menu commands have keyboard 

equivalents. For instance, to toggle between "showing" or 

"hiding" the legend, you can press the combined key 

sequence Command-L that corresponds to that menu 

command (as illustrated on the right hand edge of the 

menu). After you learn these keyboard equivalents, you 

will no longer need to go to the menu to toggle a feature 

on or off; simply press the keyboard equivalent and watch 

your graph change right before your eyes. 
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Show Tools / Hide Tools ; 
The Cricket Graph Tools window allows you to place a 
number of items on a graph or in an empty window such 
as that created when you select Text from the Graph | 
menu. Placement of these items is entirely up to you. 
You can also change their position or size. With added 
text, you can change the font, style and size as well as its 
placement. | 

@ File Edit 
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By clicking the A in the Tools window, you select 
alphabetic text as the next item to be added to the graph 
(the "A" will appear gray indicating that it is the tool that 
was selected). Simply click the location in the window 
where you wish to place this text. The location where you 
click will be considered the center point and the text you 
specify will be centered about this point. 
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Immediately after the click, a dialog box will appear (this 
is the same dialog used for changing text as described in 
Chapter 8). You can enter the text in the text edit box 
along the top of the dialog. All standard editing functions 
are available if you wish to change what you have entered. 
You can also select the font, style and size as desired as 
well as a vertical or horizontal orientation. After you click 
OK, the text will appear in the location that you originally 
chose. 

Text: 

This is my new Text} <- Enter the text 
. : aS you wish added 

Style: Font: and select the 
X Plain Geneva style, font and 
q Bold size desired. 

0 

[_] Italic 

[] Underline 

[_] Outline 
C] Shadow Orientation: 

[1] Condense © Horizontal © Vertical 

Cl] Extend 

After you place the item you selected from the Tools 
window on the graph, that tool becomes inactive. Each 
time you wish to add another item from the Tools 
window, you must select that item by clicking it in the 
Tools window. | 
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Rectangles and rounded rectangles can be added by 
clicking the appropriate tool, moving the cursor to the 
desired location and clicking. While continuing to hold 
the mouse button down, drag the mouse. An outline of a 
rectangle will follow the movements of the mouse as long 
as you have the button down. Releasing the button will 
place the rectangle at the location indicated by the outline. 

oP Pp 
) 

PnP OPM MMO HP PM HP A 

Science Data 

Drag inside gray rectangle 
to reposition 

This is my new Text! 

900000000000009002000 gH ognecennavon[D 

a (else Resize by dragging 

Selected item 

To change the position of the rectangle, click it to select it 
and then drag the object to the new location. By dragging 
within the gray square in the lower right corner of the 
selection rectangle, you can resize the rectangle. To 
remove the rectangle from the graph, click it to select it 
and press the Backspace key, press the Clear key ona 
numeric keypad, or choose Clear from the Edit menu. 
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Lines and arrows can be added by clicking the appropriate 
tool and then clicking the location of the graph where you 
wish to position one end of the line or arrow. In the case 
of arrows, this first point will be considered the head of 
the arrow. Dragging the cursor then positions the other 
end of the object. Note that the line or arrow tracks the 
position of the mouse as long as you hold the button | 
down. Releasing the button fixes the line or arrow at its 
current position. | 

To move a line or arrow, click the object to select it. If 
you then click and hold the mouse button at one end of the 
line or arrow, you can drag that end while the other end 
stays fixed. Dragging on the center of the line or arrow 
moves the entire object without changing its orientation. 
To remove the line or arrow from the graph, click it to 
select it and then press the Backspace key, press the 
Clear key on a numeric keypad, or choose Clear from the 
Edit menu. | 

Show Colors / Hide Colors 
Why color? The computer may not be able to display in 
color but a number of output devices (e.g., printers, 
plotters and film recorders) are available that allow you to 
use Cricket Graph to create color graphs. 

The colors command allows you to toggle a color palette 
visible or invisible. Eight colors are available and any 
item in the graph can be set to one of these colors. The 
next chapter deals entirely with color selection and the 
color palette. Please refer to it for details. 
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X Error Bars 
Scatter, line and bar graphs in technical reports or journal 
articles often contain error bars to denote the error 
associated with that measurement. 
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By choosing X Error Bars, you can place horizontal 
error bars on your scatter or line graphs (if the horizontal 
axis is numerical in nature). X error bars can also be 
placed on bar graphs. The error bar for a bar plot extends 
past the bar and represents half the error. 

Horizontal (H) Error Bars 

@® No error bars in this direction. 

O Use percent of the coordinate as the error. 
© Use the Standard Error of the data. 
O Use a fixed error of 
© Variable tmnt: contains the errors. 

Cancel 

Error bars are specified individually for each set of data on 
your graph. To select the data set which is to receive error 
bars, click that data set's symbol or pattern in the legend to 
select it. If you do not select a data set before choosing X 
Error Bars on the menu, the error bars will be drawn on 
the last set of data added to the graph. 

a 
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The errors used in placing the error bars are determined in 
one of four ways: 

(1) If you select the first option to use a percentage of 

(2) 

(3) 

(4) 

the value for that point, the value you enter in the 
text edit box is divided by 100 and then 
multiplied by the value of each data point. 

If you select this option, the standard error of the 
of the data will be used to compute the error 
values. The standard error is the standard — 
deviation divided by the square root of the number 
of data values. 

If you know that the error is a fixed amount for all 
data points, then use the fixed error option. After 
you click the associated radio button, the text 
box becomes active and you can enter the value of 
the known error. 

Each measured value (a data point) may have a 
unique error associated with it. Cricket Graph 
allows you to enter the error for each data point 
in an associated column (each error value must be 
in the same row as the data point with which it is 
associated). After you click the radio button 
for this option, you may then click the name of 
the column that contains these error values. 
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Y Error Bars 
Error bars may also be graphed in the vertical (y) 
direction. In fact, error bars seen in the literature are 
mostly used to denote an error range about y values. 

Y error bars can be placed on either line, scatter or column 
graphs. On column graphs, the error bar extends from the 
column and represents only half the error range. 

You can select the way in which Cricket Graph determines 
error values to use in drawing the vertical error bars in the 
same way you make the selection for horizontal error bars. 
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Show Legend / Hide Legend 
The legend is used by Cricket Graph as the control point 
for changing patterns and symbols in a graph. It is also - 
good practice to label clearly each series placed or 
overlaid on the graph. There are times, however, when 
you may not wish to have a legend visible on your graph. 

When you select Hide Legend, the legend will be 
hidden. If the legend is already hidden, the menu 
command will read Show Legend and selecting it will 
then show the legend. 

If you need to change a plot symbol or pattern and the 
legend is hidden, you can use this menu item to make the 
legend temporarily visible, change the item, and then hide 
the legend again. 

Add Depth / Remove Depth 
Any of the graphs created in Cricket Graph can be jazzed 
up by adding depth. Selecting the Add Depth command 
simply adds depth to the graph in the active window. If 
the currently active graph already has depth added, the 
menu command will read Remove Depth and, of course, 
will remove the depth and restore the graph back to its 
original flat appearance. 
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Adding depth to the graph above will cause this graph to 
change appearance as illustrated below. 
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Notice how this feature can be used to advantage to ‘add 
pizzazz to a graph for a presentation. Although you can 
change scatter, line, quality control, Double Y and polar 
graphs to show depth, it is not recommended for these 
graph types. In fact, there is no added information gained 
by adding depth to these graphs and the information 
content is only confused by doing so. | 

Add Plot Frame / Remove Plot Frame 
You can use the Add Plot Frame and Remove Plot 
Frame commands to turn the frame around a plot on and 
off. Whether or not you should have the frame placed 
around the graph is strictly a matter of preference. The 
frame is the box drawn around the graph. It is usually 
bounded on two sides by the axes and tick marks. 

Business Data 

Data from “Business Data’ 
: | Top and right 

se edge of plot frame 

0 ee Re Te Pe 

1968 1973 1978 1983 

Year 
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Removing the frame will alter the graph to look like this... 

Business Data 

Data from “Business Data” : 
The plot frame has 

30 been made invisible 

(Compare with 
previous illustration) 

1983 1968 1973 1978 

Year 

Switch Axes 
The Switch Axes command provides a quick way to 

switch between bar and column graphs. The command 

switches the vertical and horizontal axes of the graph in 

the active window. 

You can also switch the axes of scatter and line graphs as 

long as both axes are numerical, the graph contains no 

regression lines, and the graph does not have any column 

eraphs overlaid on it. 

If the active window contains a double Y axes graph, the 

Switch Axes command will switch the two vertical axes. 

8 
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Add Value Labels / Remove Value Labels 
You may add or remove value labels on bar, column or 
pie graphs. Value labels for bar and column graphs are 
the actual numerical values for each bar. For pie graphs, 
where you are interested in comparing the percentage 
contribution of each category to the sum of all categories, 
the value labels are expressed in percentages. 

op 
You can toggle the labels on or off by using this 
command. 

With Labels : Without Labels 

Record Preferences 
The Record Preferences command allows you to change 
the way graphs look when Cricket Graph first draws them. 
Many hours went into determining the default (automatic) 
settings used to draw each of the graphs. Not everybody 
will agree, of course, and therefore you can reset the 
default values used by Cricket Graph. : 
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To use this command, you must modify a graph with the 

appropriate fonts, tick marks, etc. The actual items set by 

this command are listed in Appendix B (Technical 

Details). 

A graph must be in the active window to use this 
command. 

After you select Record Preferences, the values for all 

default settings will be taken from this graph and will 

replace the previous settings. The default values from 

now on will be the current settings of this graph. 

: Make the new Preferences 
2 permanent? 

After selecting this command, you will also be asked 

whether you wish the default values to be changed 

permanently. If you answer Yes, the recorded values will 

alter the default values in the program and save these 

changes to the program on disk. The next time you start 

Cricket Graph, these newly recorded values will be used 

until you change them again. 

8 
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Chapter 11 
Selecting Colors 

The Color Palette 
The Show Colors / Hide Colors command from the 
Goodies menu will toggle the color palette visible and 
invisible. | 

Goodies 

Hide Tools 

Shou Colors , 
@noceaccacensacccvenscesgucocecooaesccoosvescCennD F WaccccscenseconsensosseosssD0RN0S 

The color palette is used to view current color settings of 
selected items in the graph and to reassign colors to these 
items. 
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To view the current color setting of an item, click that 
item to select it. A gray line will appear around that item 
to indicate that it is selected. The palette will indicate the 
current color setting of this item by highlighting the color 
in black. For instance, to find the current color setting of 
the third pattern in the legend, click it and note that a color 
in the palette will become highlighted indicating that 
item's current color setting. | 

You can set the color for just about anything in a graph. 
The rest of this chapter breaks the items in a graph into 
logical blocks and shows exactly where you would click to 
select and set the color of the various items. 
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Changing Grid and Axis Colors 

The axes, tick marks and erid lines are all set to the 

same color and can be reset to another color only as a 

eroup. To select the axes and grids, click anywhere 

on one of the axes. A gray selection rectangle will 

become visible around the plot frame (the rectangle 

enclosing the actual bars or plot symbols and bounded 

by the axes). 
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The gray rectangle indicates that the axes and grid 

lines are now selected. The current color setting of 
the axes and erid lines is highlighted in the color 

palette. By clicking another color, you can reset the 

color setting for these items. 

8 
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Changing Tick Label Colors 
Clicking the area containing the tick labels will place 

a gray rectangle around the labels indicating that they 

are selected. The labels for any given axis have to be 

set aS a group. 
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The current color of the selected labels is highlighted 
in the palette. Clicking another color will change the 

color settings of the labels. 
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The tick labels for vertical and horizontal axes can be 

set separately. 
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Changing Colors of Symbols and Patterns 

The legend is always used as a control point for 
changing plot symbols and patterns. Setting colors is 

no exception. To change the color setting of a 

particular pattern or plot symbol, click that item in 

the legend. 

Ei Canada 
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| Magenta § 
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Year 

A gray rectangle will become visible around the _ 

pattern or symbol, indicating that it is selected. The 

current color setting of the symbol or pattern is 

highlighted in the color palette. Clicking another 

color will reset the color setting of the selected 

pattern or symbol. 
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Changing the Legend Color 

The frame around the legend, if any, is set to the same 

color as the axes. Changing the color of the axes will 

change the legend frame color. Selecting the legend, 

though, will allow you to change the color of the text 

within the legend. 

Clicking the area containing the text of the legend 

will select the legend as a whole. The gray rectangle 

that appears around the legend indicates that it is 

selected, 
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The current color of the legend text is indicated in the 

color palette by highlighting. Clicking another color 

will reset the color of the legend text. 
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Changing Colors of Text, Rectangles, Lines ' 

and Arrows 

By clicking any of the text items within a graph, you 

can select that item. The selected item is indicated by 

a gray rectangle about that item. 
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After selecting a text item, the current color of that 

item is indicated in the color palette by highlighting. 

Clicking another color will reset the color of this 

item. 
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Any of the items that come from the Tools window (text, 
rectangles, rounded rectangles, lines and arrows) can be 
selected by clicking them. A gray rectangle will appear 
around the selected item indicating that it is selected. 
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The color palette will indicate the current selection of the 
selected item by highlighting that color in the palette. 
Clicking another color in the palette will reset pe color of 
the selected item. 

Printing in Color 
If you are sending the graphs to an output device that _ 
currently supports color printing, the graphs will be 
produced with the colors you selected. Such devices 
include color plotters (Apple, Hewlett Packard, etc.) and 
the ImageWriter II with color ribbon. Special versions © 
of the software are also available which operate high 
quality color film recorders and high quality printers. 
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Formats 

Save Format... 

Remove farmat Chapter 12 

pe fu Just eet The Fornrake Mena 

The Formats menu gives you a very powerful capability 
to recreate graph types with the selection of a single menu 
command. More importantly, you create new formats that 
are added to the menu. The term "macro" applied to 
computers means the bundling of a sequence of events into 

a command so that these sequences can be applied over 

and over by the selection of a single command. The 
Formats menu essentially allows you to create "graphic 
macros’. 

Creating a Format 
A format is simply all the instructions necessary to 
recreate a graph (including everything such as extra text, 

lines and arrows), without the data or data-dependent 

items (such as an axis minimum or maximum). Refer to 

Appendix B for a list of the items that are being saved in a 

format. 

To create a format, you simply use Cricket Graph to create 

a graph of the type you want. You can add arrows, lines 

and text. All fonts, sizes and styles for each group of text 

can be selected by you. You can also choose the patterns 

and symbols to use in the graph as well as the color 

selections. After you have designed the graph the way 

you would like, you select the Save Format command 

from the Formats menu. 
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Saving a Format : 
After choosing the Save Format command, you are 
presented with the following dialog box... 

Graph Disk | ; 

iS Business Data <> Graph Disk 
& Cricket Graph | 

Science Data 

Save this Format as: 

Enter the name to be assigned to the format and click the Save button 

After you have typed in the name and clicked Save, the 
format is saved in a file on disk and added to the Formats 
menu. | 

Although you can save a format to any disk, the format 
will be added to the Formats menu only if you save it to 
the same disk from which you are running Cricket Graph. 
Use the Drive button to select the disk on which to save 
your format. 
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Recalling a Format 
To recall a format, simply select its name on the Formats 
menu just as you select any of the other menu commands 
in Cricket Graph. However, this menu is a scrolling 

menu. If the number of formats exceeds the number that 
can be displayed due to screen limitations, you can scroll 
through the menu. As you drag through the menu items 
and near the end of the menu, the menu will begin to 
scroll so that you can access the remaining formats. 

oe 
Save Format.. 

Remove Format. 
You can scroll through 

the menu if the number 

of formats exceed what 

is initially visible. 

Ragen esac 

Formats that you 

save will be listed 

in this menu 

One of two things will happen if you select a format that 
you added to the menu, depending on what is in the active 
window or if there are no active windows at all. 

If the active window contains a graph, selecting a format 
forces this pre-existing graph to the format selected (if that 
is possible). Cricket Graph first checks to see if the kind 
of graph specified in the format is of a type compatible 
with this type of graph. If both axes of a scatter plot were 
numerical and you tried to force this graph to a format 
designed for a pie graph, Cricket Graph would warn you 
that the data in the scatter graph is not compatible for use 
in a pie graph. 
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If the active window is not a graph or there are no © 
windows on the desktop, you will be presented with a 
dialog box to select the data to use in the new graph. 
After you have chosen the necessary variables, the graph 
will be created using the format that you selected from the 
menu. | 

Hint: It is suggested that you give names to your formats 
that are an indicator of the type of graph used in this 
format so that you will not later forget what types of 
graphs are specified in what formats. 

Removing a Format 
After adding a number of formats to the menu, you may 
decide you no longer need some of them. You can use the 
Remove Format command to erase the format from the 
disk and delete the name from ‘the menu. | 
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After you select Remove Format, all formats currently 

available on the disk will be listed in a scrolling window. 

This window is very much like the one encountered when 

opening files from the disk. You can scroll through the 

selection of formats available, change disks or even eject a 

disk to swap the disk in the drive (all the standard features 

available when opening files). Click the format you wish 

to delete and then click the Remove button. 

The name of the format is removed from the Formats 

menu, and the disk file that contains that format will be 

erased from the disk. 

& 
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Swapping Formats with Others 
Formats are stored on the disk as files with this icon... 

Example Format 

You can swap these formats with others. You can treat 
them like any other files and delete, move or rename 
them. When Cricket Graph is first started up, it 
determines what formats are currently on the disk and — 
installs the names in the Formats menu. 

Storing individual formats in separate disk files (with theit 
own icon) has several advantages. You can treat these 
files as any other files (e.g., move, delete or rename 
them). You might even create standard formats to be used 
for certain types of graphs and pass them around to your 
friends and coworkers. Transferring formats to other disks 
is done in the normal Macintosh fashion by dragging the 
icons over to the other disk (refer to the guide that came 
with your Macintosh). 

An example of creating a format and then using it to 
recreate a graph type is given in the examples section of 
the first chapter. 
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Chapter 13 
Getting It on Paper 

ae 

Graphics can be utilized to add impact and convey a lot of 

information in a very short time. But what good is a 

eraph that you have created if you cannot effectively get it 

on paper? Control of the printed or plotted output is one 

of Cricket Graph's strongest features. 

Remember that in Cricket Graph you can have multiple 

windows on the desktop with different graphs in each 

window. The number of windows is limited only by 

available memory. 

After you select Print or Plot from the File menu, the 

page layout window is displayed. 
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Introducing the Page Layout Window 
The page layout window contains a miniature image of a 
page. The size of this image is a scaled version of 
whatever page size you currently have selected in Page 
Setup (or Plot Setup if you selected Plot). If you had 
set the page to the rotated orientation in Page Setup, the 
image of the page would show the page rotated with the 
widest part of the page horizontal rather than vertical. 

Contents of Other Windows 

bee un “Patiaa Pet? 
@ 

Contents of Active Window | 

: ——— Page Border 

Grid Control 

| | 
Grid: O sa Off 
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The first time you select the Print command after having 
started Cricket Graph, the contents of the frontmost 
window containing a graph will be automatically placed 
on the page. Other graphs that are in open windows will 
be positioned on the righthand side of the page layout 
window, off the page. Although you may have as many 
graphs as memory will allow, only the contents of the 
front 10 graph windows will appear in the page layout 
window. 

With the page layout window, you can resize a graph, 
position it on the page, and overlay one graph on another. 

The location and size of each graph on the page is 
"remembered". If you modify the graphs and select Print, 
the layout window will display the page as you had 
previously left it. However, creating new graphs or 
closing windows that contain graphs will cause the layout 

- window to "forget" the prior layout. 
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Selecting a Graph for Moving or Resizing 
Clicking the scaled image of a graph will select it. This is 
indicated by a gray outline that will appear around the 
edge of the graph. 

Selection Rectangle 

re here to resize 

Drag inside rectangle 
to reposition graph 

Grid: OOn @off 

_ By clicking the grid buttons, you can turn a grid on or off 
on the page. This grid is to assist you in positioning and 
aligning graphs on the page. The grid is not visible on the 
page when sent to a printer. | 
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Moving a Graph 
You can place the graph anywhere on or off the printed or 
plotted page by dragging it around after clicking it. The 

_ graph may also be on the page only partially. 

A gray rectangle around the edges of the image of the 
page denotes the border of the printable area (this is due to 
mechanical limitations of the various printers). Only the 
portion of a graph which is within this border will be 
printed. 

Move by dragging inside selection rectangle 

& 
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Resizing a Graph 
You can resize a selected graph by dragging the little gray 
box in the lower right corner of the gray rectangle. The 
graph can be made any size. A portion of it may even be 
off the page. What you see is very close to what you will 
get after printing. You can make a graph occupy the 
entire paper by moving it to the upper left corner of the 
paper and resizing it. 
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Arranging the Graph(s) 
By resizing and moving the scaled images of the graphs in 

this window, you can arrange the way the printed output 

of a page will appear. You can place graphs side by side 

for comparisons, or you may even overlay one graph on 

another for special effects. Each of the graphs is 

transparent, and overlaying them will still allow the graph 

in the background to show through. 

Arrange page by repositioning 

and resizing one or more 

graphs on the page. 

Page layout is extremely versatile because it allows you 

full control of what the printed (or plotted) output will 

look like. 

@ 
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Working with Color Plotters : 
Page layout is the same, whether you are sending the 
output to a printer or to a color plotter. Prior page layouts — 
are not "remembered" when you switch from Print to 
Plot. Appendix F describes how to use a color plotter 
with Cricket Graph. 
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cceaitis A 
Do's & Don'ts of Creating Effective 
Graphs 

Cricket Graph allows great versatility in creating 
presentation graphics -- so much versatility, in fact, that 
you may be tempted to over-use many of the features in 
your graphs. It must always be remembered that the 
primary goal of the graph is to convey a message. Here 
are a few good rules of thumb that can assist you in 
reaching this goal. 

The following suggestions are not original and in fact are 
guidelines used by many artists when creating graphs for 
clients. You should always keep in mind the thought, 
"What meaning am I trying to convey to my audience 1 in 
this graph?" 

& 
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Rule #1: Simplify 
With software developers stumbling over each other to 
give the consumer literally hundreds of options while 
creating graphs, this is probably the most important rule to 
remember. 

Try to limit the number of elements used in a graph. 
Adding too much to a graph can confuse the audience and 
tends to lessen the impact of the intended message. 

The number of slices in pie graphs, for instance, should be 
five or fewer. You can include more, but after eight slices 
the message begins to get muddled. 

Bar graphs, column graphs, and their stacked counterparts 
should also contain as few sets of data as possible 
(hopefully never more than 5 sets of data per graph). If 
you need to, you might wish to group data (the Recode 
command in Cricket Graph is for this purpose). Quite 
possibly, graphing the differences between multiple sets of 
data might be more effective. 

Overlaying set after set of data on scatter and line plots 
can create a confusing picture. Three or four intersecting 
lines should be considered a practical limit for this type of 
graph. 

Cricket Graph allows up to 16 categories, but graphs 
should never include anywhere near that many. 

You can also overdo things when adding text labels, lines 
and arrows. Use the minimum number necessary to 
emphasize your message. 
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If you find yourself overcrowding a graph, try designing a 

sequence of simpler graphs. If the number of categories is 

greater than eight, perhaps grouping several categories 

into one would produce a better result. 

Rule #2: Emphasize 
If you want one element to stand out to the audience, then 

emphasize it! Explode the most important section of a pie 

graph. Add an arrow pointing to the most significant 

value in the graph. Perhaps in bar and column graphs you 

could shade the most important bar in black with all other 

bars shaded in white. 

Rule #3: Use Balance | 

Use balance when placing things in the graph. Usually 

this means centering titles and axis labels. If you wish to 

add text off to the side, you may want to try to balance it 

by adding something to the other side or, better yet, 

shifting the plot slightly over to the opposing side. 

Rule #4: Space Carefully 

The elements of a graph should expand to fill the 

dimensions of the graph. Try not to crowd objects on the 

graph. Space can often be used very effectively ina 

sraph. 

& 

A-3 Appendix A: Do's & Don'ts of Creating Effective Graphs 



® 

~ Rule #35: Maintain Scale | 
Trends and patterns can be distorted if you are not careful 
to maintain scale. The vertical height of a graph to its 
horizontal width should be approximately a 3 to 4 ratio 
(this is the most pleasing visually). Try to keep the same 
increments on both x and y axes. Very often, you should 
force the vertical axis minimum to be zero (at the expense 
of losing resolution) so that the audience can gain a greater 
insight into the magnitude of the numbers. 

Rule #6: Watch Pattern & Color 3 
Patterns and their shades should get lighter from left to 
right. Don't use similar shades or patterns next to one 
another if the two are difficult to distinguish. Some 
patterns look awful in graphs. Try to select the best 
patterns that do not look garish next to one another. 

Rule #7: Choose Data & Tick-Mark Location 
With the vertical axis, you are given the choice of left or 
right placement. Typically you should use the left edge of 
the plot for the vertical axis. One exception: when depth 
(3-D) is added to column graphs, the vertical axis looks 
better on the right because of the angle of the depth. 
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Rule #8: Place Numbers & Labels Carefully 
Numbers and labels should be easily seen from a distance. 
Crowding too many numbers on an axis makes the 
numbers difficult to see at all. 

Rule #9: Use Consistent Font Size & Style 
The important point to remember in selecting fonts, sizes 

and styles is to be consistent. With the variety of fonts 

available on the Macintosh, it is easy for anyone to get 

carried away. All axis labels should be a consistent font 

and size. The title may be one exception to the rule. A 

graph title should be in slightly larger and bolder type than 

other labels in the graph. Do not use a dozen different 

fonts strung out in the graph without rhyme or reason. 

Rule #10: If it doesn't feel right, redo it! 
Redoing a graph with Cricket Graph is easy. If for some 

reason you feel uncomfortable with the results, try 

graphing the data in another fashion. Remember, you can 

create a new graph with the same data in another window 

and compare. 

The better the graphics package, the more tempted you 
will be to overindulge in all its features. Rule #1 is the 

one to watch most. Remember, KEEP IT SIMPLE! 
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Appendix B 
Technical Details 

This appendix describes some of the technical details 
behind Cricket Graph's operation. It includes specifics 
about the numeric computation environment, quality 
control computations, handling of pictures, memory 
management, and sorting order. 

Contents of Saved Formats 
The formats saved by Cricket Graph include all the items 
necessary to recreate that graph less any data dependent 
items. When you select a format that had been saved, the 
data dependent items are computed and then the graph is 
drawn. An example of data dependent items is the axis 
parameters (e.g., min, max, etc.). | 

The format record that is saved includes... 

(1) The plot frame location and size 

(2) The number of overlaid data sets 
(3) A list of all the information for each of the overlays (e.g., plot 

symbol, pattern, plot type, color, etc.) 
(4) The settings for the legend (less the labels, since these are data 

dependent) 
(5) Whether or not to draw the plot frame 
(6) Whether or not to add depth 
(7) If aquality control graph, what type it is 
(8) If appropriate, whether value labels are on the graph 
(9) Color of the value labels 
(10) Color of the plot frame, axes and grid lines 

(11) The format of each axis (e.g., linear, log, ticks and grids) 

(12) A list of all the extras on the graph (this includes text with 

size andfont information, rectangles, lines and arrows as 

well as the color settings of each item) 

& 
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What does Record Preferences Set? 
® 

The Record Preferences command from the Goodies 
menu allows you to reset the default values used by 
Cricket Graph for drawing the various graph types. The 
default values are reset to the settings currently used in the 
active graph window. 

The default values which are affected by this command 
adi... 

The plot frame location and size 
The location of the legend and whether it is visible or not 
Whether or not the plot frame is drawn 
Whether or not depth is added 
If appropriate, whether value labels are sciadiicltie 
added to the graph 
The tick and grid line formatting for each axis 
A list of all the font information for the first three text items in 
the graph (these are reserved for the x-axis label, the y-axis 
label and the graph title) 
Default color settings for the standard items in the graph | 
(color settings for extras such as rectangles, lines and arrows are 
not kept) 
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‘Numeric Computation Standards in Cricket Graph 

All computations performed in Cricket Graph utilize the — 

Standard Apple Numeric Environment (SANE). The core 

features of SANE are taken from Draft 10.0 of Standard 

754 for Binary Floating-Point Arithmetic. For further 

details refer to: 

Floating-Point Working Group 754 of the Microprocessor 

Standards Committee, IEEE Computer Society. "A 

Standard for Binary Floating-Point Arithmetic." Proposed 

to IEEE, 345 East 47th Street, New York, NY 10017. 

Cricket Graph uses extended precision variables in all 

computations to avoid round-off errors. The extended 

precision variable type has the following characteristics: 

precision: 80 bits (19-20 digits) 

minimum representable value: = - 1.1 E+ 4932 

maximum representable value: 1.1 E+4932 

The extended type is also able to handle infinities and 

classes designated as Not-a-Number (NANs). You may 

encounter infinities and NANs when trying to perform 

transformations on data. The following table will assist 

you in interpreting these occurrences: 

NAN'1' Invalid square root, such as sqrt(-1) 

-NAN'2' Invalid addition, such as adding infinity to -infinity 

NAN'4' Invalid division, such as 0/0 

NAN'8' Invalid multiplication, such as 0 * Infinity 

NAN'33' Invalid argument to a trigonometric function 

NAN'34' Invalid argument to an inverse trigonometric function 

NAN'36' Invalid argument to a logarithmic function 

NAN'37' Invalid argument to x” 
++++ Positive infinity 
~--- Negative infinity 
tid Not enough room to display answer 

& 
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Computations in Quality Control | ae 
The equations used in computing the central line and the 
control limits for the eight types of control charts are as 
follows... 

X+A,xR 

— ets X is the mean of combined sample means 
X+A.*5 | =. | 3 eee 

3 X is the mean of combined sample medians 

R is the mean of all sample ranges 

Xx = A,*R S is the mean of sample standard deviations 

Az and Az are obtained from Duncan 

(see reference) 

np+3J npx(1-p) nis the sample size 
his the average sample size 

a = ee Pp is the average 
pt+3S/D x(1-p)/n nonconformities 

¢ is the average of the 

C -|- 3 / C number of nonconformities 

per constant unit size 

= a U is the average of the 

U + 5 U number of nonconformities 

per varying unit size 

For R and § graphs the control limits are... 

LCL = D5*R LCL = B,*s 
UCL = D,*R UCL = B,*5 
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Handling Pictures 
When you use the Copy command in the Edit menu and 

the active window contains a graph, Cricket Graph places 

a picture of the graph on the Clipboard. Although a scaled 

version of the picture is displayed in the Clipboard 

window, the actual dimensions of the picture are the 

dimensions of the window from which it came. You 

determine the picture's size and shape by changing the 

window before using the copy command. 

The Clipboard can handle pictures of any size. Some 

applications, however, cannot. MacPaint, for example, 

rejects any picture larger than about 5 inches wide and 3.5 

inches tall. The Scrapbook desk accessory centers each 

picture. If your picture is larger than the Scrapbook's 

display area, it may look like part is missing even if it 1s 

not. 

Memory Management 
Cricket Graph uses dynamic memory management. This 

allows the program to make the most effective use of the 

available computer memory without placing arbitrary 

limits on you. The program itself is heavily segmented, 

and data areas are allocated only when you need them. 

The result of dynamic memory management is that 

whenever you open a window, Cricket Graph allocates 

storage space for a copy of the data displayed in that 

window. In addition to the space for the data, Cricket 

Graph also requires space to store the segment of program 

code that draws the window. The total memory used for 

these purposes can be substantial if you have a lot of 

windows open. You may need to take special care to 

close unneeded windows to free up memory space when - 

you use large data sets in a small machine (or a small 

Switcher partition). 
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If your requirements do exceed available memory, you 
should be aware that Cricket Graph cannot control the 
amount of space the Macintosh operating system takes for 
disk directories and other operations. You will have the 
maximum amount of memory available when you turn the 
Macintosh on and start Cricket Graph immediately without 
intervening operations. 

Sorting Order 
In case you need to know the exact precedence that 
standard ASCII characters can take in sorting, the list is 
presented here. The characters increase in sorting value 
going across a row from left to right and then down to the 
next row (same as reading). 

/ Se 9 : Soi asc sis sk 

BC Do peo Gi si 

M oN O. FP OIQ OR? US¥ spe yrioy Sow 

MeN 2 Te ale anima ty 

6.0 Se eae ee ee a ebay «| 

nh O p 8) -h- > Sk ch Wis) Vic W Ak 

y OMe? Wetec ee 
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Recoding Order 
The exact precedence of standard characters for recoding 

is presented here. Notice that the order is very similar to 

the order for sorting, except that capital and small | 

characters from A - Z are treated as the same character. 

" # $ % & ( ) 

* : : / 0 1 2 

3 4 5 6 yi 8 9 5 

< = > ? @ A(a) Bib) Cc) D@) 

Ee) FO G@ HH 1 J) KH LO M@ 

Nit) O00) Pe Q@@) RH Ss) TH UM VO) 

WK ee 
er ee ee 
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Appendix C: 
Importing & Exporting with Other 
Applications 

It is not necessary to retype your data from the keyboard if 

the data is already in some computerized form. You can 

transfer data from another application (such as a 

spreadsheet or word processor) into Cricket Graph by 

using the Macintosh's versatile ability to cut and paste. 

Cricket Graph can also read TEXT or SYLK files created 

by many other programs. You can also use a , 

communications application (such as MacTerminal™) to 

receive data from a mainframe computer. Transferring 

data in this way can save considerable time and expense. 

A few examples of how data or graphs may be transferred 

between applications are presented in this section. 

Remember, these are only a few examples of the wide 

range of data transfer possibilities. 

& 
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Methods for Importing and Exporting : 
Most Macintosh applications allow you to cut or copy data 
from within the program and place it on the Clipboard 
(Refer to each application's manual for instructions). 
Once on the Clipboard, data can be imported from another 
application into Cricket Graph. This works well with. 
small sets of data, but it is more desirable to read data files 
created by other applications for large data sets. 

Files SYLK Files 

Possible Methods of Importing Data 

Many of the Macintosh databases have the capability of 
saving data sets (usually referred to as reports) in either 
TEXT or SYLK file format. Some even allow both. 
SYLK is a file format devised and used by Microsoft in its 
products. 

= SYLK 

Omnis3 
i 

i SYEK Cricket Graph 

TEXT 

OverVUE 
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Like the data bases, spreadsheets typically allow you to 
save your data sheets in SYLK format. 

qi) 
Excel 

a 
Cricket Graph 

SYLK 
> 

Multiplan 

The text files created by Macintosh word processors can 
also be read into Cricket Graph. You must, however, 
make sure that the file is saved as text only. MacWrite™, 
for instance, saves data files in its own internal file format 
or in_text only formats but you have to specify which 
format to use when you save the file. 

SN 

Microsoft Word rst 

Text fc, BE 

Cricket Graph 

Mac Write 

& 
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Most other applications save data either in TEXT format 
or in SYLK format as an option. Remember though, if 
the program from which you wish to bring data does not 
support one of these formats, you can transfer data 
through the Clipboard (Note: data files from StatWorks™ 
can be read directly). 

Coy) 

ecard ==> 
MacTerminal 

SYLK = 

Microsoft Chart . : Cricket Graph 

2 x* Read , 

dls Directly 
StatWorks™ 
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To read either a TEXT file or SYLK file created by 

another application, you must "force" that file to be 

opened by Cricket Graph. Forcing is the term used to 

refer to a technique used on the Macintosh to read files 

created by other programs. To force a file to open, drag 

over the file icon and the Cricket Graph icon and then 

select Open from the File menu while in the Finder. 

Alternatively, you can click the file icon, shift-click the 

Cricket Graph Icon and then select Open from the File 

menu. | 

[ AGI Edit View Specia l 
Hs z 7 New Fol der SN ee ee 

re 33 

3 
: 

fee 
: 

Print 

Close 

Get Info 

Duplicate 

| TEXT Example Cricket Graph 

When you force a text data file open in this way, you must 

be sure that the information in the text file conforms to the 

proper format. 

& 
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Text File Format used by Cricket Graph 
Cricket Graphs's text file format consists of a standard text 
file that contains Tab characters and Return characters. 
Tab characters separate data items within arow. Return 
characters separate rows. 

If the first character stored in the disk file is an asterisk 
(*), the first row of data contains column names. When 
the file is read by Cricket Graph, these names are placed 
in the column headings. This is a matter of convenience, 
though, and it is not necessary that files contain the 
asterisk and store column names with the data (in fact, 
most applications do not). 

The following data ... 

Business Data 

would be stored on disk as... 

* [CR] Year [T]US [fT] Canada [ER]1 968 [1]15.9 [1]16.2 [ER]1 9737) 23.1 [1] 17.4 ERI 

Where represents a Carriage Return & represents a TAB character. 
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By using a simple text file format, you can write small 

applications in a programming language to create 

custom data sets (for example, you may wish to write 

a simulation program for an experiment and then use 

Cricket Graph to graph the results). At the end of this 

Appendix you will find two Macintosh Pascal 

programs that can be used as guides for writing your 

own programs. Similar programs may be written in 
BASIC or other languages available for the 

- Macintosh. 

Example: Reading a SYLK file 
In this example, a SYLK file created in Multiplan™ 
will be read into Cricket Graph. 

& File Edit Select Format Options 

Untitled = 
TE eee eee ee 
S| rece RS SES AS AS SSDS SSSSS SSS SS STS 
ies a ee oe — a aeanenaa ones seuss pence ans ee eaienate mecerat cree peroecians een eat are ene Sonamaeen = ASOT, ress: en aD 

ater sessions lsssarp snes sna Sass 

ete 

% e 

Selecting Data in Multiplan 

& 
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(1) 

(2) 

(3) 

(4) 

(3) 

While in Multiplan, select Save from the File menu. When the 
dialog appears asking you to name the file, click the SYLK 
option to save this data in the SYLK format. 

Quit the Multiplan program. 

Select the Cricket Graph icon and the icon of the file that you 
just saved. You can select multiple icons by holding the Shift 
key while you click the objects. | 

Select Open from the File menu. 

The Cricket Graph program will start up and the SYLK file 
that you selected will automatically be loaded into a Cricket 
Graph data window. 

Example: Reading a Text File 
The following example illustrates how standard text 
files can be imported into Cricket Graph. The 
example uses MacWrite to create the text file. It could 
just as easily be a report generated by a database. 

C-8 

TAB stops 

Untitled == l 
i 2 3 4 vipers fodentind Spodeli Shndntiedantenetinbtaedbnatiedndidn 

| [A] C1 6 lines/inch =) E) 

I96E.- 13:9: 16.2° 13:3 

La7 oS: fo. fla 

1976 246 229 15.4 

96S 22:0 25.5 9.4 

Press the RETURN key after each row 

Entering Data in MacWrite 
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(2) 

(3) 

(4) 

(5) 

(6) 

(7) 

(8) 
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Set the Tab stops in MacWrite. 

Enter the data, pressing the Tab key after each value until you 
have entered the entire line. Then press the Return key. 

Select Save As from the File menu. 

Enter a name for the file in the dialog box that is presented. 
Make sure that the text only option is selected (this saves the 

data, tabs and carriage returns without the extra information , 

such as font or size, used by MacWrite) 

Quit the MacWrite program. 

Select the icon of the file you just saved and the Cricket Graph 

icon. You can select multiple icons by holding the Shift key 

while clicking the icons. 

Select Open from the File menu. 

The Cricket Graph program will open and the data from the file 

(or files) selected will be placed in a Cricket Graph data 

window. 

If you are having trouble getting data transfer between 

applications by reading files, try transferring the data 

through the Clipboard. In most cases this will solve 

any problems. 

a 
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Data from Mainframe Computers ; 

If you wish to transfer data from a mainframe computer 

to Cricket Graph, you will need a terminal emulation 

program for the Macintosh. 

Edit Commands 

indo 

@ File 

‘OC 

24 Copy Table ,. 

{ fear 

} Select All | 
0000000000000000008006000000000 000000000000 000C000RNL0NR 

Show Clipboard 

Obtaining Data with MacTerminal 

For instance, you may transfer data from another 

computer to the Macintosh by using MacTerminal™. 

By dragging the mouse over tabular data received in 
MacTerminal and then using Copy Table from the 

Edit menu, you can transfer the data to the Clipboard. 

Once on the Clipboard, the data can then be pasted 

into Cricket Graph. 

If the data coming from the mainframe is not in 

columnar format, you can transfer the data first to 

MacWrite. In MacWrite you can add the Tab 

characters to create the needed columns from the data. 

You can then transfer the data into Cricket Graph as 

explained previously. 
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Exporting Graphs to Other Programs 
Graphs created in Cricket Graph can be exported to 
several other Macintosh programs. For instance, by 
using the Copy command on Cricket Graph's File 
menu, you can transfer the graph in the active window 

to the Clipboard and then paste into MacPaint™. By 

using MacPaint, you can add to or customize a graph 
with MacPaint's versatile drawing capabilities. 

Clipboard 

Scrapbook : 
vase MacPaint 

3 
Cricket Graph PICT files oA 

) > =< 
Clipboard 
Scrapbook MacDraw 

You might even wish to import graphs created in 

Cricket Graph into FileVision™ or another data base 
that accepts pictures. | 

& 
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There are basically two methods for exporting graphs 
to other programs. Applications like MacPaint that 
use bit maps to store pictures must have the picture 
transferred via the Clipboard. Word processors, such 
as Microsoft Word or MacWrite, would also fall into 
this category. 

@ File Edit Style Font Layout Arrange Fill 
re PPP EPPA PP PLP P LP Pet PPP PUPP PAPAL PPP IAN PPI PPP PIE Cet PPP PI PP PAP OP PAPI P PIPPI APPA PILE POL Oe LPL EP REEL ER LLP LOLLOP LEP LOLE LEC OPE EE SH 

Untitled 

MZ Canada® 

MacDraw™ and MacDraft™, on the other hand, can 
read PICT files. The PICT file is just a format for 
storing pictorial information. Cricket Graph allows 
you to save graphs in PICT format and therefore you 
can read these type files directly from programs that 
use PICT files (Appendix D illustrates using MacDraw 
with a graph from Cricket Graph). 
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Picture of item in Scrapbook 

You may not be able to see the 

entire item, but it is there! 

Scrapbook 

Data from “Business Data™ 

30 

Total number of items in Scrapbook Data will be stored as “TEXT” 

Number of this item in Scrapbook Graphs as “PICT” 

Use Scroll Bar to view selections in Scrapbook 

Transferring Multiple Pictures 
Remember that pictures may also be stored in the 
Scrapbook. The Scrapbook is similar to the Clipboard 
in that data or pictures can be stored in it. The 
difference is that multiple items can be stored in the 
Scrapbook at one time, whereas the Clipboard can 
hold only one item at a time. If you have several data 
sets to transfer into Cricket Graph, store the data sets 
in the Scrapbook. Then transfer each data set from 
the Scrapbook via the Clipboard into a separate 
Cricket Graph data window. 

8 
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A word of caution: If you move to a new application, 
you must make sure it can gain access to the 
Scrapbook you just created. If there's already a 
scrapbook icon on the new application's disk, either 
rename it and move your Cricket Graph Scrapbook to 
the new application's disk, or just replace it with your 
Cricket Graph Scrapbook by copying the Scrapbook 
icon from the Cricket Graph disk to the new 
application's disk and responding Yes to the dialo 
box. | 
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Sample Macintosh Pascal Program to Read Files 

program Readfile; 
var 
ch, cOld, row, col : integer; 
f : text; 

colname : array[1..10] of string[15]; 
values : array[1..10] of real; 
line, str: str255; 

procedure Scanline (ItsAName : Boolean); 
begin 
col:=1;. 
cOld := 1; 
chv=; 
while ch < length(line) do 

begin 
if line[ch] = chr(9) then 

begin 
str := copy(line, cOld, ch - cOld); 
if ItsAName then 

colname[col] := str; 
else 

ReadString(str, values[col,row]); 
cOld := ch + 1; 
col := col + 1; 
end; 

ch :=ch+ 1; 
end; 

str = copy(line, cOld, ch + 1 - cOld); 
if ItsAName then 

colname[col] := str; 
else | 

ReadString(str, values[col, row]); 
end; | 

& 
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begin 
reset(f,'Sample File’); 
readline(f, line); 
if line = '*' then 

begin; {there will be column names} 
readin(f, line); 
Scanline(TRUE); 
end; {of reading column names} 

else 
reset(f); {reread from start if no column names} 

row := 1; 

while eof(f) = false do 
begin 
writeln(‘Reading line’,row); 
readin(f,line); 
ScanLine(FALSE); 
row :=row + 1; 

end; 

close(f); 
end. 
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Sample Macintosh Pascal Program to Write Files 

program WriteFile; 
const 

nCols = 10; 

nRows = 8; 

var 
row, col : integer; 
f : text; 
colname : array[1..nCols] of string[11]; 
values : array[1..nCols, 1..nRows] of real; 

begin 
rewrite(f, ‘Sample File’); 
writeln(f, '*'); {there will be column names} 

for col :=1 to nCols - 1 do 
write(f, colname[col], chr(9)); 

writeln(f, colname[nCols]); 
for row := 1 to nRows do 

begin 
for col := 1 to nCols - 1 do 

write(f, values[col, row] :1 : 1, chr(9)); 
writeln(f, values[nCols, row] : 1: 1); 

end; 

close(f); 
end. 

Note: The two Pascal programs are only to be used as guides for writing 

your own programs. 

& 
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Appendix D 
Working with MacDraw 

Apple's MacDraw program is a very versatile package. 

By creating graphs in Cricket Graph and then transferring 

to MacDraw, you have a wealth of tools for customizing» 

graphs. A few brief suggestions are provided in this 

chapter on using MacDraw but it is highly recommended 

that you refer to MacDraw's manual for more details. 

Icon for Graph saved in PICT format. 

MacDraw can read this format. 
Example Graph 

Getting Graphs into MacDraw 

A graph created by Cricket Graph can be transferred to 

MacDraw through the Clipboard or as a PICT file. 
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Using the command Copy Picture on the Edit menu in 
Cricket Graph places a picture of that graph on the 
Clipboard. You can then start up MacDraw and paste this 
picture directly into MacDraw. Remember, multiple 
pictures can be stored in the Scrapbook before you transfer 
over to MacDraw. Better yet, save the graphs in PICT . 
format with the Save Graph command in Cricket Graph's 
File menu. Start MacDraw and select Open from 
MacDraw's File menu. This type of file is listed along 
with other MacDraw files and you will be able to read the 
file directly. 

Untitled 

sun <Comparison of Saless 
—— 

After the picture from Cricket Graph is loaded into 
MacDraw, it will appear something like above. All those 
little black squares are called handles and each object has 
its own set of handles. When Cricket Graph draws a 
graph each line segment, string of characters and filled 
polygon is considered a separate object. That's why so 
many handles appear when the picture file is first loaded 
into MacDraw. 
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Grouping Objects 
A convenient feature of MacDraw is that you can group 

multiple objects together so that they can be treated as one 

object. To do this, select the Group command from 

MacDraw's Arrange menu. 

Arrange 

Bring to Front 

Send to Back 

Paste in Front 

Paste in Back 

Rotate Left 

Rotate Right 

Flip Horizontal 

Flip Vertical 
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All the individual objects originally in the graph are now 
grouped together and can be treated as one object. 
Observe that only 8 handles around the object are now 
visible. These handles can then be used as controls for 
moving and resizing this one object (the graph as whole). 

Untitled 

Ce 
ots ee 

1968 1973 1978 1983 
Year 

Multiple objects that have been grouped can also be 
ungrouped as well so that they can be treated or modified 
individually. 
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Grouping is a very important feature of MacDraw (and 
also very convenient) so a simple example will help clear 
up any confusion. : 

Suppose that our picture contained only three objects: text, 
a rectangle and a rounded rectangle. Clicking any one of 
these objects selects it and handles appears around that 
object. If you hold down the Shift key and click more 
objects, they too become selected. This is known as 
shift-clicking and is a method for selecting multiple 
objects at a time. 

Untitled 

After you then use the Group command from the 
Arrange menu, the objects are grouped together and 
treated as one object. Only one set of control handles 
appears about the grouped objects (note how the handles 
form a rectangle about the object). 

& 
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Resizing and Moving Objects 
Dragging any one of the handles resizes the object (it 
effectively stretches or shrinks that object) with the 
exception of text. | 

Untitled 

F Comparison of Sales 

1968 1973 1978 1983 
Year 
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Dragging at a location somewhere within the rectangle 
formed by the handles allows you to move the object 
about the drawing area. 

Untitled 

1968 1973 1978 1983 
Year 
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Rotating Objects pe TOOL & 
After selecting an object in MacDraw, you can also rotate 
it. This can be very handy if you would like to rotate the 
entire graph on the page or perhaps rotate text so that it is 
printed vertically up or down the page. 

Untitled 
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‘After clicking the object, select the Rotate Left (or 
Rotate Right) command from MacDraw's Arrange 

flrrange 

Bring to Front 

Send to Back 

Paste in Front 

Paste in Back 

Rotate Left, 

Rotate Right 

Flip Horizontal 

Flip Vertical 

The object will be rotated in the direction that you chose. 

Untitled 

Appendix D: Working with MacDraw 



Selecting Patterns | } 
MacDraw is very versatile in allowing you to choose the 
pattern used to fill objects and the patterns used for 
drawing lines, rectangles, etc. 

LLL 
LL, 

— WZ Patterns available for = fakeebC.. 
filling & drawing. 

wWaVaW ar eceroreerere 
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Selecting Line and Arrow Types 
A variety of line types are available when you draw an 
object. Arrow types are also available. 

Lines and arrows 

that are available 

You do not have to preselect these patterns or line types. 
By selecting an object and then picking a fill pattern or 
line type, the object is redrawn using the newly selected 
fill or pen width. Therefore, any of the objects in a 
picture brought in from Cricket Graph can be changed at 
any time by selecting it and then choosing the proper 
menu command. 

& 
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Setting the Drawing Size 
A unique feature of MacDraw is the ability to choose your 
drawing area and then work with the object over that 
entire area. The drawing area can be as large as 96 by 48 a 
inches. Each 8 by 10 inch section will be printed out co 
separately. You can then trim the edges and tape the 
sections together. | 

Drawing Size: 

16.00 % 20.00 
oS 

After choosing Drawing Size from MacDraw's Layout 3 
menu, the above dialog box will appear. In this window call 
is a block of little squares. Each square represents an 8 by 
10 inch area. To select the drawing size you would like to 
work with, drag over the appropriate squares. Each | — 
Square that is highlighted in black is now part of the a 
drawing surface. or 

= 
or 
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After selecting the drawing size, you can now see how the 

object (in this case, the graph) appears in that drawing 

area. Choose Reduce to Fit from the Layout menu. A 

window will appear showing you the entire drawing area 

with a scaled down version of your object on the drawing 

surface. You can then select objects, drag them around, © 

and even resize them using the handles. 

The combination of Cricket Graph with MacDraw 

provides versatility beyond compare. In fact, the two 

work so well together that it is recommended that you 

consider bundling the pair using Switcher (a 512K 

Macintosh is required for this to work). Switcher is 

included on your Cricket Graph System disk and you are 

encouraged to use it. Appendix E discusses the use of the 

Switcher program. | 

& 
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Appendix E 
Using Cricket Graph with Switcher 

By combining Apple's Switcher program with Cricket 

Graph and your most often used Macintosh applications 

(MacDraw or Excel, for instance), you can create a 

custom integrated package. Switcher is included on the 

Cricket Graph System & Utilities disk and you are 

encouraged to use it (requires 512K or more of memory). 

Also included on the Cricket Graph System & Utilities 

disk is a preconfigured Switcher document that has Cricket 

Graph already installed and configured. If you 

double-click the icon of this document, Switcher is 

automatically started with Cricket Graph installed. 

This chapter describes the very basics that you will need to 

know in order to bundle Cricket Graph with other 

applications and use those applications in the Switcher 

environment. Full documentation on Switcher available 

and if you don't already have it, you may want to ask your 

local Apple dealer how to get it. You will need this 

documentation if you really want to use the more 

advanced features of Switcher. 

Double-click the Switcher icon from the Finder to start the 

program. 
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Installing Applications 

1? {? 
) | 

rr PHM OPP PF 

Application Switcher 

The above screen will be the first item you see after the 
Switcher program has begun. To use one or more 
applications in Switcher, you must first install these 
applications. To do so, you can simply double click 
where indicated to install an application (they refer to it as 
"launching"). A dialog box will appear that will let you 
select the program you wish to install. 
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Cricket Graph will set the needed memory configuration 
automatically when installed (the amount of memory set 

_aside for Cricket Graph may not match the illustration 
below). ashes 

Application Switcher 

eS Double-click here to launch an application... 

You can follow the same procedures for installing other 
applications. You might seriously consider bundling 
Cricket Graph with MacDraw from Apple Computer (the 
advantages are explained Appendix D). 

Application Switcher 

& 
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Switching Between Prégrams 
Once you have installed the applications that you wish to 
bundle together, you can easily switch from one 
application to another instantly. Switching is 
accomplished by using the arrow control that appears in 
the upper righthand corner of your screen. This control is 
available at all times. 

Switch to Other Applications 

Return to Switcher 

Using the Switching Control 

Clicking either the right or left side of the control switches 
you to the next application. At any time you can return to 
the Switcher desktop by clicking the center portion of the 
control. 
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The Switcher menu contains an Options command. It 

will be very helpful for you to check and make sure that 

the Always Convert Clipboard option is turned on 

(indicated by an "x" in the box) if you wish to transfer 

information from program to program through the 

Clipboard. For example, this option will allow you to 

copy a graph from Cricket Graph onto the Clipboard, 

switch to MacDraw or MacPaint and paste the picture into 

that application. 

tion Switcher Options 2p Reece 

[_] Switcher in Rotation 

XX] Always Convert Clipboard 

KX] Switching Animation 

Xx] Back After Launch 

[] Same One Twice 

[_] Reverse Switch Direction 

[] Room For LaserWriter 

Cancel 
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Saving a Bundled Set 
After you have installed one or more programs with 
Switcher, you may want to bundleé these applications as 
one (this is how the preconfigured Switcher document on 
the Cricket Graph System & Utilites disk was created). 
This allows you to create your own custom integrated 
package, a package which includes your favorite and most 
often used functions (e.g., word processing, drawing, 
Etc. ). 

File 

Load Set... 921 
Save Set... . 3S 

80 000000000000000000600000000000000000000000008000000000000000000 02002 P20BR00ECENL0RR 

Choose the Save Set command located in Switcher's File 
menu. You will be asked to enter a name for this set of 
applications (like saving files). 
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<— Graph Disk 

My Business Data <>! (6) Graph Disk : 
& Cricket braph 
fy fmagemriter 
y Science Data 

Name to save set as: 

Graph & Draw 

After entering the name of the bundled set and clicking the 
Save button, the set 1s saved to disk under an icon of its 
own. 

Bundled Set of Applications 

Graph & Draw 

You can now open this set by double-clicking the icon 
from the Finder desktop (just as you can any other 
program). The applications bundled within this set will 
automatically be opened and ready to run. 

In essence, by using Switcher you have created a custom 
integrated environment tailored to suit your needs. 

Quitting Switcher 
To quit Switcher, you must first switch to each application 
and quit that application. Switcher will not let you quit if 
an application is still open. 

& 
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Appendix F 
Using Color Plotters 

Cricket Graph can plot graphs on a number of color 
plotters that can be connected to the serial ports on the 
back of the Macintosh. Either serial port can be used. 

Installing the Plotter Resources 
You will need to install the necessary resources to 

_ configure Cricket Graph for the type of plotter that you 
wish to use. Several small icons representing different 
plotters are on the Cricket Graph System & Utilities disk. 
If your plotter is not represented by an icon, you may want 
to contact Cricket Software to see if an installer has 
become available. 

Icon for HP 7475A installation program 

HP 7475A 

This program will install the resources 

needed for Cricket Graph to use this plotter. 

F-1 Appendix F: Using Color Plotters 



Choose the icon which represents the plotter that you will 
be using. Copy this file to the Cricket Graph disk (the 
disk that the program is located on) by dragging the icon 

_ from one disk to the other. The installation program 
MUST be on the same disk as the Cricket Graph program. 

After you have copied the installation program for your 
plotter onto the Cricket Graph disk, double-click the 
installation program's icon. The resources for the plotter 
you selected will be installed into the Cricket Graph 
program. That's all there is to it. | 

After the installation is finished, you will have the option 
of starting Cricket Graph immediately or returning to the 

- Finder. 

Only one plotter can be installed in Cricket Graph at a 
time. However, at any time, you can replace the 
resources for the current plotter by installing the resources 
for another plotter. 

Plot Setup 
The first thing you need to do after installing the plotter is 
select the Plot Setup command from Cricket Graph's File 
menu. Each dialog is specific for the plotter you have 
chosen. In this example, the installation was done for an 
HP 7475. Therefore, the exact details for setting the 
parameters for the plotter you are using may vary slightly 
from the example. 3 
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Paper: @®8 1/2 # 11 Tall ©O8 1/2 Kh 11 Wide 

© 11 1? Tall © 118 1? Wide 

Speed: @® Fast OMedium  O Slow 

Pen Size: @® Narrow (.3mm) © Wide (.? mm) 

Scale Fonts: © Yes @ No 

Connector: @® Modem © Printer 

Minimize Pen Changes: © Yes © No 

Color Assignments to Plotter Pens: 

Black Green Magenta 
White Blue Yellow 

Red Cyan 

The most obvious thing to select first is the paper size you 

wish to use. Notice that you can choose whether the 

image appears in the tall or wide direction on the paper. 

When you put paper into the plotter, insert it as specified 

in your plotter manual. If a rotated image is selected, 

Cricket Graph will rotate the image before plotting. You 

do not need to turn the paper. 

Select the desired pen speed. Fast is fine for new pens. 

As your pen wears down, you can reduce the pen speed 

for a better image. The pen speed should be set to Slow 

if you are going to make transparencies. 

Cricket Graph also needs to know what the width of the 

pen tip is. Set the appropriate size. 
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You may wish to turn on the Scale Font feature. If 
Scale Font is on, the fonts will be scaled to the same 
proportion as the scaling necessary to draw the graph in 
the size you select in the plotter page layout. In most 
cases, you may wish to leave this feature off. 

The plotter can be connected to either serial port on the 
back of the Macintosh, but you must set the appropriate 
button in this dialog to tell the software which port you are 
using. 

You can also set the feature for minimizing pen changes. 
If you have this feature on, the plotter will finish drawing 
all objects in a certain pen color before changing pens. 
This will save a great deal of time since pen changestake a 
considerable amount of time on some plotters. 

Setting Pen Colors | 
The number of pens available is specific to the type of 
plotter you are using. Cricket Graph supports the use of 
eight colors (including black and white). After setting 
colors in the graph itself, you must then set the pen colors 
in this dialog. Usually, plotter pens are referred to by 
number and are not a fixed color. You can set the color 
when you put the pens in the plotter's penholder. 

Next to the name of each color supported by Cricket 
Graph is a number representing a plotter pen. You can 
reduce the pen number by clicking the left arrow of the 
control. Likewise, clicking the right arrow will increase 
the pen number. The pen number can be increased up to 
the largest pen number that your plotter allows. 
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Plotters do not have a pen number zero. You can turn a 
color off by setting the pen number to zero. Go ahead and © 
select the desired pen numbers that will represent each of 
the eight colors. Notice that you can specify that two or 
more colors be drawn by the same pen. Also, note that 
most plotters do not have a pen for white so you probably 
will want to turn this color off by setting to zero. 

Install the color pens in the plotter as you set these 
controls. This will help you avoid confusion later on. 

When all options have been set, click the OK button. 

Page Layout with the Plotter 
After creating graphs in Cricket Graph, you can send 
output to the plotter by choosing Plot from the File menu. 
A page layout window will appear. You can drag, resize 
and place multiple graphs on the page just as you can with 
the Print command. 

After you have arranged your page, click the OK button 
and if all goes well, the plotter will begin to draw your 
graphs. : 

Graphs that have depth added to them may or may not 
look fine on the plotter. The reason is that lines drawn in 
the background are not hidden and may show through a 
foreground color. 
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Technical Details on the Serial Interface 
The plotter is connected to the Macintosh through one of 
the two serial ports on the back. The standard 
ImageWriter cable can be used to make the connection for 
many plotters. : 

The communication protocol used for most plotters is... 

9600 Baud 
8 Data bits 
1 Stop bit 
No Parity 

If your plotter requires settings different from these, a 
message will appear just under the plotter's name in the 
Plot Setup window. 

You do not have to set any of these parameters in Cricket 
Graph. The necessary parameters were set when you 
install the plotter resources. You may find the protocol 
information useful if you find you must reset the switches 
that are typically found in each plotter. If you are having 
problems getting the plotter to work, check your plotter's 
manual and make sure that the switches are set for the 
correct protocol. 
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Appendix G 
A Quick Tour of the Menus... 

About Graph... 

Scrapbook 

Note Pad 

Calculator 

Alarm Clock 

Key Caps 

Control Panel 

Chooser 

_ About Graph... 
Displays information about program and publisher. 

Desk Accessories 
All the traditional desk accessories are available and fully functional. The 
Scrapbook is very handy for storing one or more graphs created in this 
program. The graphs can then be pasted into other Macintosh applications. 

8 
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New 36N 

Open... 360 

Close 36K 

Save Graph 3S 

Save Graph As... 

Page Setup... 

Print 3P 

Plot Setup... 

New 
New opens a new, untitled data window. 

Open... 
Opens and retrieves an existing data set or a graph that has been previously 
saved. 

Close 

Closes the active window. 

Save Graph / Save Data 
The Save command will reflect what is currently in the active window (a 
graph or a data set). Save Graph will save the graph in the active window on 
disk for later recall. Save Data will save the data set on disk. The data set can 
then be recalled later. 

Save Graph As... / Save Data As... 
Save As allows you to save the contents of the active window on disk under a 
new name. 

Page Setup... 
Page Setup lets you specify the paper size and other printer characteristics. 

Print 
The Print command prints a copy of the active window using the settings 
specified by Page Setup. If the active window contains a graph, a page layout 
window will appear allowing you to position and size one or more graphs on 
the page. 
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Plot Setup... 
The Plot Setup command 1s similar to Page Setup. The specified settings 
affect devices connected to the serial port of your Macintosh. 

Plot : 
The Plot command sends commands to a serial output device for drawing on 
that device. This command can only be used to draw graphs. Before the 
actual drawing is done, you will be presented with a page layout window that 
will allow you to place and size one or more graphs on the page. 

Quit 
Quit leaves Cricket Graph and returns to the Finder. 

Copy Data’ 

Paste 

Clear 

Select All 

Show ciipnened 

Undo 
The Undo command can be used to remove data sets from a graph that 
contains more than one set of data. The last set of data to be drawn on the 
graph is removed using this command. 

Cut 
The Cut command removes selected text in the data window and places the 
selection on the Clipboard. 

Copy Graph / Copy Data 
The Copy command reflects the contents of the currently active window. 
Either a graph or a selection of data can be placed on the Clipboard using this 
command. | 

Paste 

The Paste command replaces the current selection in a data window with the 
current contents of the Clipboard (if the Clipboard contains text). 

a 

G-3 Appendix G: A Quick Tour of the Menus 



Clear 
The Clear command removes selected text from a data window or objects 
selected in a graph. 

Select All 

Select All can be used to select the entire contents of a data window. 

Show Clipboard / Hide Clipboard 
The Show clipboard command opens or closes a window that displays the 
current contents of the Clipboard. 

Sort... 

Recode... 

Transform... 

Simple Math... 

Count Frequency... 

Smooth... 

Sort... 
The Sort command sorts the rows of data in order according to the column 
you specify. 

Recode... 
You may use Recode to group a range of data into a single code (numerical 
or categorical). 

Transform... 
The Transform command performs mathematical transformations on a 
column of data. | 

Simple Math... 
The Simple Math command allows you to add, subtract, multiply. or divide a 
column of data by another column or a constant. 

Count Frequency... 
Using the Count Frequency command, you can take raw categorical data 
(i.e., a list of unordered or grouped categories) and create two columns. 
One column contains the unique category names encountered and the other 
column contains the frequency of occurrence for each category. 
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Smooth... 
The smooth command allows you to perform a sliding average smooth on a 
specified column of data. You are allowed to choose the smooth width. 

Scatter : 

Scatter graphs allow you to specify one variable for the horizontal axis and 

one or more variables for the vertical axis. 

Line : 
Line graphs are similar to Scatter graphs except that a line is used to connect 

each of the data points. Also, either a categorical or numerical variable may 

be used for the horizontal axis. | 

Area 
An Area graph is used to graph multiple sets of values along the vertical axis. 

Each set is added to the values of the previous set before graphing. Either 

categorical or numerical data can be used along the horizontal axis. 

Bar | 
A Bar graph can be used to compare one or more sets of numbers among a 

specified set of categories. The bars are graphed in a horizontal fashion. 

The horizontal axis is numerical and the vertical axis lists the categories. 

G-5 Appendix G: A Quick Tour of the Menus 



e 

Column 
A Column graph is very similar to a Bar graph, except that the bars are 
drawn in a vertical fashion. Therefore, the horizontal axis lists the 
categories and the vertical axis is numerical. 

Pie : 

A Pie graph is used to show the proportion contributed by each category to 
the sum of all the categories. Only one categorical and one numerical 
variable are used in this type of graph. 

Stack Bar 
A Stacked Bar is very similar to a Bar graph. Instead of placing the various 
values for each category side by side, they are stacked end to end. 

Stack Column 
A Stacked Column graph is like a column graph except that the various 
values for each category are stacked one on top of another instead of side by 
side. 

Polar 
A Polar graph uses a polar coordinate system where each data point is 
specified by a radius from the center and an angle from a reference point. 
Multiple sets of radii and angles may be overlaid with one another. 

QC 
By using the QC command, you have the choice of creating a number of 
different types of graphs used quite frequently for tracking Quality Control. 

DoubleY : | 
With the DoubleY graph, you can plot two sets of data on the same graph 
even if different vertical axis scales are used for each set of data. The 
horizontal axis can represent either numerical or categorical data. 

Text 
A Text graph can be created using words. This may be a very good way to 
emphasize a message very simply. A number of tools are available so that 
you can add lines, boxes and arrows. 
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Curve Fit 

Simple 

Polynomial 

Logarithmic 

Exponential 

Remove 

Simple 3 
Simple regression will draw the "best fit" straight line through the data on a 
scatter or line graph. If multiple sets of data are on the graph, you can select 
which data values are to be used in the computation. 

Polynomial 
The Polynomial command will fit up to a fifth order polynomial through the 
selected set of data. The graph must be a scatter or line graph. 

Logarithmic 
The Logarithmic command will perform a logarithmic regression on the 
selected data and draw the computed curve. 

Exponential 
The Exponential command will perform an exponential regression on the 
selected data and draw the computed curve. 

Interpolate 
With the Interpolate command, you can draw a curve for the selected data 
that will pass through each and every point (unlike the regression fits). This 
is very similar to using an electronic "French Curve". 

Remove : 
You can use the Remove command to delete a fitted curve from the selected 

data set on a graph. 

& 
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Goodies 

Show Tools 

Show Colors 

# Error Bars 

Y Error Bars 

Hide Legend 

Add Depth 

Remove Plot Frame 

Switch Axes 

Add Value Labels 

Record Preferences 

Show Tools / Hide Tools 
The Tools command will make the toolbox visible or invisible. The tools can 

‘be used to add such things as text, lines and arrows to a graph. 

Show Colors / Hide Colors 
The Colors command will make the color palette visible or invisible. With 
this palette you can change the color of any selected item in a graph. 

X Error Bars 
The X Error Bars command allows you to add error bars to each data value 
in a scatte,line or bar graph. You have the option of specify one of three 
ways to obtain the error to be used. The bars are drawn in a horizontal 
fashion corresponding to the x axis. 

Y Error Bars 
The Y Error Bars command is very similar to the X Error Bars command. 
The bars, in this case, are drawn in a vertical fashion corresponding to the 
vertical axis. Y error bars can be placed on scatter, line or column graphs. 

Hide Legend / Show Legend 
The Legend command can be used to make the legend in a graph visible or 
invisible. 

Add Depth / Remove Depth 
Using the Depth command removes or adds a three dimensional appearance 
to a graph. Depth really adds character to bar and column graphs. 
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Remove Plot Frame / Add Plot Frame 
The Plot Frame command will cause the graph to be redrawn with or 
without the plot frame. 

Switch Axes 
On many graphs, the Switch Axes command can be used to swap the 
horizontal and vertical axes. On the Double Y graphs, the two vertical axes 

are swapped. 

Add Value Labels / Remove Value Labels 
Labels in column and bar graphs can be added or removed for each bar using 
the Value Labels command. Likewise, the wedges of a pie graph can also be 
labeled. 

Record Preferences 
Record Preferences looks at the graph in the currently active window and 
uses all the parameters set in the graph as the default values for all further 
graphing. With this command, you can reset all the default values either 
temporarily or permanently. 

Formats 

Save Format.. 

Remove Format.. 

Save Format... 
The Save Format command can be used to save all the data-independent 
information of the graph in the currently active window. You will be given 
the chance to name this format. The format is then added to this menu under 
the name that you assigned it. Selection of that format will cause the graph to 
be recreated except that you will be given the opportunity to specify a new 
data set and a new selection of variables. The graph used to specify this 
format will be created using the new data. This command gives you the 
capability to create "Graphic Macros". 

Remove Format... 
The Remove Format command allows you to remove a previously saved 

format from the disk and from the menu. This command is only active if 

there are formats currently saved and listed on this menu. 

All Formats currently saved will be listed. 

8 
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Index 

Active window, 2-13 
Add Depth, 1-11, 10-10 
Add Plot Frame, 10-12 
Add Value Labels, 10-14 
Alphabetic data, 2-3 
Angles 

for transformations, 6-9 
in polar graphs, 7-16 

Apple menu, 3-1 
AppleTalk, 3-2 
Area graph, 7-7 
Arrows | 

on graphs, 10-5 
in MacDraw, D-11 

Averaging data, 6-14 
Axes 

categorical, 8-5 
changing, 1-12, 1-32, 8-2 

colors, 11-3 
linear or log scale, 8-3 
switching, 10-13 
vertical label, 8-13 

Bar graph, 7-9 
Baud rate, F-6 
Business example, 1-5 

Categorical axis, 8-5 
Changing graphs, 8-1 
Chooser, 3-2 
Clear, 5-3 

Clipboard, 2-16 
data transfer, C-2 
pictures in, B-5 
Show/Hide, 5-4 
with Switcher, E-5 

Close, 4-3 : 
Color, 10-5 

selecting, 11-1 
plotters, F-1 
slides, 1-1 

Column graph, 1-8, 7-10 
with lines, 7-25 

Column numbers, 2-3 
Columns, 2-1 
Control limits, 7-19 
Copy, 2-8 
Copy Data, 5-2 
Copy Picture, 5-3 
Cosine transformation, 6-9 

Count Frequency, 6-15 
Curve Fit menu, 9-1 

Cut, 2-8, 5-1 



Data Edit menu, 5-1 
alphabetic, 2-3 Editing Data, 2-1 ° 
averaging, 6-14 See also Data. 
columns, 1-7, 2-1 EJECT button, 2-15, 4-1, 4-6 
deleting columns, 2-11 ENTER key, 2-6 
deleting rows, 2-12 Equation, removing, 1-29 
entering by columns, 2-4 Error Bars, 1-30, 7-5, 10-6 
entering by rows, 2-5 Excel, data from, C-2 
entering missing values, 2-7 Exploded pie graph, 8-17 
from other computers, C-10 Exponentials, 6-8 
selecting columns, 2-10 
selecting rows, 2-12 File menu, 4-1 

Data menu, 6-1 3 Film recorders, 1-1 
Data sets Formats, 1-15 

overlaying, 7-2 creating, 12-1 
removing, 8-18 recalling, 12-3 
selecting, 1-27, 9-2 saving, 1-16, 12-2 

Data windows, 2-1 what is saved, B-1 
capacity, 2-2 Formats menu, 12-1 
multiple, 2-13 Frontmost data window, 2-13 
structure, 2-2 

Degrees to radians, 6-9 Goodies menu, 10-1 
Delete. See Remove. Graph Disk, 1-2 
Derivatives, 6-10 Graph file format, 1-34, 4-6, C-6 
Desk Accessories, 3-1 Graph menu, 7-1 
Do's and Don'ts, A-1 Graphic macro. See Format. 
Double Y graph, 7-22 Graphs 
Double-clicking, 1-9, 8-1 changing, 8-1 
Dragging, 1-6, 8-1 in Scrapbook, 3-4 
DRIVE button, 2-15, 4-1, 4-6 to other applications, C-11 

Grid 
colors, 11-3 
in page layout, 13-4 
lines, 8-4 

Grouping in MacDraw, D-3 
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Hide Clipboard, 5-4 NAN, B-3 
Hide Colors, 10-5 New, 4-1 | 
Hide Legend, 10-10 Numeric computations, B-3 
Hide Tools, 10-2 Numerical axis, 8-3 
Home region, 2-3 
Horizontal axis, 2-1 OMNIS 3, data from, C-2 

Open, 4-1 
Icons, 1-2, 4-4, 4-5, 12-6, D-1 OPEN button, 2-15, 4-1 
ImageWriter, 3-2 Open files, 1-35 | 
Insertion bar, 2-4 Order of precedence, B-6— 
Interpolation, 9-1, 9-4 Out of Memory, B-5 
Inverse transformation, 6-11 Overlaid data 

deleting, 5-1, 8-18 
Keycaps, 3-5 } Overlay Plot, 7-3 

: OverVue, data from, C-2 
LaserWriter, 3-2 
Layout, for output, 13-1 
Legend 

changing, 8-11 
color, 11-7 
Show/Hide, 10-10 

Line graph, 7-6 
two Y axes, 7-22 
on Column graph, 7-25 

Lines 
on graphs, 10-5 

- in MacDraw, D-11 
Logarithmic transformations, 6-8 

MacDraw, 1-34, 4-6, C-11, D-1 
MacPaint, B-5, C-11 

Macro. See Format. 
MacTerminal, C-1, C-4, C-10 
MacWrite, 2-1, C-2, C-8 

- Memory management, B-5 
_ Missing values, entering, 2-7 
Moving an item, 1-13, 8-1 
Moving in page layout, 13-5 
Multiplan, data from, C-2 



Page layout, 1-22, 4-8, 13-2 
with plotters, F-5 

Page orientation, 13-2 
Page Setup, 1-20, 1-24, 4-7 
Paste, 2-8, 5-3 
Patterns, | 

changing, 1-15, 8-8 
colors, 11-6 
in MacDraw, D-10 

PICT files, 1-34, 2-16, 4-6, 

C-12, D-1 
Pictures and other 

applications, B-5 
Pie graph, 1-18, 7-11 

exploding, 8-17 
value labels, 10-14 

Plot frame, 8-15, 10-12 

Plot Setup, 4-9, F-2 
Plot symbols 

changing, 1-26, 8-8 
colors, 11-6 

Plot, 4-10 
Plot, resizing, 8-15 
Plotters 

color, F-1 

pen assignment, F-4 
Polar axis, changing, 8-2 
Polar graph, 7-15 

coordinates, 7-16 
Polynomial, degree of, 1-28 
Preferences 

setting, 10-14 
what is saved, B-2 

Print, 1-22, 3-2, 4-8 
in color, 11-10 

Quality Control 
graphs, 7-18 
formulas, B-4 

Quick tour, G-1 
Quit, 4-10 
Quitting from Switcher, E-7 

Radians, 6-9 
Radius, 7-16 
Range, changing, 8-3 
Recode, 6-4 

order of precedence, B-7 
Record Preferences, 10-14, B-2 
Rectangles | 

adding to graphs, 10-4 
moving and resizing, 10-4 

Regression lines, 9-1 
Regression models, 9-3 
Remove curve fit, 9-5 
Remove data set, 8-18 
Remove Depth, 10-10 
Remove Format, 12-4 
Remove overlaid data, 8-18 - 
Remove Plot Frame, 10-12 
Remove Value Labels, 10-14 
Resizing graph, 1-24 
Resizing in MacDraw, D-6 
Resizing in page layout, 13-6 
Resizing plot frame, 8-15 

_ Resizing windows, 2-3 
RETURN key, 2-4 
Roots, transformations, 6-11 
Rotating image on plotters, F-3 
Rotating in MacDraw, D-8 
Rotating text, 8-13 
Row numbers, 2-3 
Running sum, 6-9 
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SANE, B-3 
Save Data, 2-14, 4-3 
Save Format, 1-16, 12-2 
Save Graph, 1-33, 4-3 
Scale Fonts, F-4 
Scatter graph, 1-25, 7-4 
Science example, 1-24 
Scrapbook, 3-3, C-13 

moving to correct 
disk, C-14 

pictures in, B-5 
Select All, 5-4 
Selecting graph parts, 8-1 
Serial interface, F-6 
Show Clipboard, 5-4 
Show Colors, 10-5 
Show Legend, 10-10 
Show Tools, 10-2 
Simple Math, 6-12 
Sine transformation, 6-9 
Smooth, 6-16 
Smooth Width, 6-17 
Sort, 6-1 

nested, 6-3 
order of precedence, B-6 
preserving tied values, 6-2 

Square root, 6-11 
Stacked Bar graph, 7-12 | 
Stacked Column graph, 7-14 
StatWorks, data from, C-4 
Stineman interpolation, 9-4 
Switch Axes, 7-23, 10-13 
Switcher, 1-2, E-1 

partition size, B-5 
SYLK files, 2-16, C-2, C-7 
System & Utilities Disk, 1-2 

TAB key, 2-5 
Tall Adjusted, 1-21, 4-7 
Text 

adding to graphs, 10-2 
changing, 8-13 

TEXT files, 2-16, C-2, C-6, 
C-15 

Text graph, 7-24 
3-D effect, 10-10 
Tick labels, 8-6 

colors, 11-4 
Tick marks, 8-4 
Tools window, 10-2 
Transform, 6-7 

Undo, 5-1 

Value labels, 10-14 
Variable names, 2-2 

editing, 2-9 
in file format, C-6 

Variables, 1-7, 2-1 
selecting, 1-7, 7-2 

Vertical axis, 2-1 
Vertical axis label, 8-13 
Vertical text, 8-13 

Wide paper orientation, 4-7 
Windows, resizing, 2-3 

X axis, 2-1 
X Error Bars, 10-6 

Y axis, 2-1... 
Y Error Bars, 10-9 
YY graph, 7-22 

Z-scores, 6-10 
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Addendum: 
Version 1.1 and 1.2 Updates 

The New Data Window 

‘The data window has been improved to give it more of the feeling of a 

spreadsheet program—though be aware that it is not a spreadsheet. You may 

notice when you start up the program that all the columns are now pre- 

assigned default names. There is a predefined grid of 2700 rows by 100 

columns. You may enter data anywhere in the sheet . (Of course, memory 
restrictions limit the portion of the total spreadsheet you can use at any one 

time.) : 

Untitled Data #1 

is 

Cell Size 
The number of characters that may be entered in a cell is now 31. However, 
the maximum number of digits supported in a decimal number is 19 or 20, 

depending on the value of the number. If you enter a number with more than 

19 or 20 digits, the trailing digits are stored as zeroes. 

a 
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Adjusting Column Width 

You may now adjust the width of individual columns. To do so, move the 

cursor to the righthand part of the cell where the column number is located. 

The cursor changes from an arrow into a double-headed arrow. Click and 

drag, and you can make the column wider (up to 31 characters) or narrower 

(down to 2 characters). A dotted line indicates the changing column border as 

you drag. Changing the width of one column does not affect any other 

column. 

% 
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Inserting and Deleting Data 

Under the Edit menu are two new entries, Insert and Delete. You may 

insert or delete columns and rows, or you may insert and delete within any 

rectangular range on the screen. 

feat Unde 
000000000 0600 0000800008000 0089 8000000000 000008 60009000009 

Copy Data 

Paste BS § 

Place 

Clear 36B 

Select All 

Insert. 
Delete 

Show Clipboard 
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Inserting Columns or Rows 
To insert a new column or row of data, click the number of the column or 

row at which you want to insert data. All the cells in that column (or row) are 

now selected. Then select Insert from the Edit menu. If it is a column, all 

the data in the current column moves to the right, as do all columns to its 

right. If you insert a row, all the data in the current row shifts down, as do 

all rows below it. The program warns you if you are about to push data off 

the edge of the sheet. You are asked to confirm or cancel the operation. 

SS ht ESSE 
: Sea Sra ive Sa Bees Se) 

Column headers behave rationally in an insert operation. A user-entered 

column name (“Quarter”) shifts with the data to which it is connected. A 

default column name (“Column 4”) remains with the column whose number it 

represents. 

Deleting Columns or Rows 

Deleting columns and rows works in much the same way. You click the 

column and row number to select that range. Then select the Delete 

command from the Edit menu. The column or row disappears, and the other 

columns and rows shift automatically, up or to the left. 

Copy Data 

Paste SEES | 
Piace : 

Clear 36B 

Select All 

Delete 

Show Clipboard 

a 
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Be aware that Delete is different from Cut or Clear. With Cut or Clear, 

the data in the column or row disappears, but the column or row remains in 

the same place and no shift takes place. Unlike Cut or Clear, however, you 
cannot Undo a Delete. 

You may also select several columns or rows and delete them at the same time. 

Inserting and Deleting Areas 
You may also insert or delete within any rectangular area in the spreadsheet, 
ranging from one cell to a large number of cells. Click and drag from a comer 
cell in your designated area, until all the cells you want are selected. 

If you want to insert, you are asked if you want the contents of the current 
cells shifted down or to the right. If you want to delete, you are asked if you 
want the contents of the adjacent cells shifted up or to the left. 

Insert: Delete: 

© Shift Cells Right © Shift Cells Left 

© Shift Cells Down —@ Shift Cells Up 

Column headers are not affected by inserting or deleting in this way. 
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The Data Menu 

The Go To Function 

Under the Data menu, the new Go To... function allows you to select a 

specific cell to which to move in the window. You give the coordinates of the 

cell by row and column number. The cell you have designated is displayed on 

the screen and it is selected. The initial row and column values in the dialog 

box are for the current cell. To go to the current cell (in cases where you have 

scrolled it off the screen), you need only enter the Go To... command and 

press Return. 7 

Column Form st 

Recode... 

Transform... 

Simple Math... 

Count Frequency... 

Smooth... 

Transpose 

Go To... 

The Column Format Function 

Under the Data menu, the new Column Format function allows you to 

select specific data types and formats for each column. This allows you not 

only to set the data type of the data you enter, but also to adjust the appearance 

of the column as you wish. Probably the most important feature of this _ 

command is to prevent the entry of non-numerical data into numeric fields. 

a 
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The formats are defined as follows: 

E ) Definiti 

Alphabetic Any character 

Decimal Numbers, leading & trailing spaces, period (decimal 

point), comma, +, -, e, E 

Scientific As Decimal 

Dollars As Decimal but with $ 

Percentage As Decimal but with % 

By default, all columns are set as Decimal. If you want to change a column 
to another format, you must change it through the Column Format dialog 
box. 

Column Format: Column 1 

Format: Justification: 

© Alphabetic © Left aligned 

@® Decimal © Centered 

© Scientific @ Right aligned 

© Dollars : 

© Percent Digits: 

Here are some samples of data presented in each of the formats, left-aligned, 
with digits set at 3: 

' Entered _as Alphabetic Decimal Scientific Dollars Percent 

ABC ABC wonnena nae wannnnnnnnnn mene neem 

1.00 1.00 1.000 1.00e+0 $1.000 100.000% 

003 003 0.003 3.00e-3 $0.003 0.300% 

2000 2000 2000.000 2.00e+3 $2000.000  2000.000% 

1.53e-1 1.53e-1 0.153 1.53e-1 $0.153 15.300% 

If you want to use simple integers, specify Decimal format type with 0 digits. 

Add-6 Addendum: Version 1.1 and 1.2 Updates 



ee A SSS A AS 
ma 

The column format is for external (visible) representation only; any number 
you enter will be preserved in its entirety for calculation. You can verify this 
by entering more digits of precision than are specified in the column format. 
After you press Return or click off the cell, the digits shown will be the 
number specified in the column format. If you click on the cell again, the total 
number of digits you entered will be shown while that cell is selected. 

If you change the format of an alphabetic column containing numeric data to 
any of the other formats, you are shown the dialog box below. This message 
indicates that the conversion may cause some loss of precision in your data. 
You may choose to continue, by clicking OK, or cancel the operation. 

Data is being converted from alphabetic 

to a numeric format. Some data could be 

lost. 

If you try to enter alphabetic (non-numeric) data in a numeric column, or use 
otherwise inappropriate characters, the cell into which you entered data is 
blanked. You then get the following message. 

The data is the wrong format for the 

column. 

Cricket Graph now accepts (and ignores) commas and leading or trailing 

spaces in numeric data. 

a 
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The Sort Function 
The Sort command under the Data menu has changed. The dialog box for 
the sort has two new fields: a listbox containing all the column names 
(“Associated Columns”) and a button labeled "All Columns" combining all the 
columns together. 

Go To... 3G 

Column Format 3€F 

Recode... 

Transform... 

Simple Math... 

Count Frequency... 

Smooth... 

Transpose 

Sort the Data @ Ascending Order 

© Descending Order 

Sort Column Associated Columns 

All Colurmns 

Cancel 

If you choose to sort a column and no associated columns are selected, the 
other columns are not “carried along” with the sort—they remain as they 
were. This default is different from the default sorting method in version 1.0. 
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If you want to carry all other columns along, click the All Columns button 

before clicking the Sort button. If you want only selected columns to be 
changed by the sort, you may do it in one of two ways: 

¢ You can pre-select a column or a number of columns by Option- 
clicking column numbers before issuing the Sort command. In 
this case, the columns are sorted based on the contents of the 

leftmost selected column, and they are displayed as selected in the 
list of Associated Columns. 

¢ You can choose them by clicking items in the list of Associated 

Columns before clicking the Sort button. 

The Transpose Function 
The Transpose command has been added to the Data menu. Selecting this 
command causes the rows and columns to be switched. This is useful if the 
data were brought in from a spreadsheet and was row-oriented instead of 
column-oriented as Cricket Graph expects. If the data being transposed is not 
compatible with the format of the column in which it will be placed, the 
column format is changed to "alphabetic" to accommodate the data. 

8 
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The File Menu 

Saving Data Files 
Since the data window now has complex formatting characteristics associated 
with it, including column width, data type, significant digits, and so on, the 
Cricket Graph file format in which a data window is saved now contains this 
information. The data is no longer saved in a simple String-Delimiter-String 
arrangement. : 

As a result, other programs that in the past have been able to read Cricket 
Graph files may no longer be able to interpret them. Cricket Graph, of 
course, can still read its old file formats, along with tab-delimited text files 
from other programs. 

q) Graph data 

Ey polar plat tsint2s33 (O\c Internal 2... 
2 Polunemial itt — 
| Hespoase tata a 
S Scatter Caler se 
ie 
2 | Py Science Bete 

fs sin, £46 by EOD pot... 

Saving Graph Files 
When you select the Save Graph option in the File menu, you are offered 
the choice of saving your graph in Cricket Graph format or in PICT (picture) 
format. You should be aware that PICT format is for exporting only, in the 
sense that Cricket Graph reads PICT files in only as objects as explained in 
the section on the Place command in the Edit menu. A PICT object is not 
treated as a graph. 
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Opening Data Files 
When opening data files by selecting Open from the File menu, Cricket 
Graph data files are listed. A new addition to this dialog is a check box, 
Show all TEXT files. By clicking this box and turning it on, all text files 
are listed as well. Thus, if a file is in a format that Cricket Graph is capable of 
importing, it can be selected and read into Cricket Graph. 

©) Graph Data 

D Business Data 
OD example graph 

<— Drive20 

D Science Data 

EX Show all TEHT files 

Text, SYLK, WKS and JWKS Files 
Cricket Graph can read data files in standard tab-delimited format, as well as 
the MicroSoft SYLK format. You can also import data from Lotus’ Jazz™ 
using the JWKS format. 

You can also import Lotus WKS files that were created on an IBM PC or 
compatible system. WKS files are generated by LOTUS 1—2-—3™ and other 
programs. The WKS files from an IBM PC or compatible system can be 
accessed through a networking package such as TOPS™ from Centram, or 
through non-network file converters, such as MacLink Plus™ from DataViz. 

WKS files generated by Macintosh programs are not necessarily compatible 
with Lotus WKS files. 
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Plotting Columns of Data 

Row Numbers 
Row Numbers are now treated as a variable (a column of data). Therefore, 
each time a dialog box appears allowing you to select a column of data for 
plotting or other data transformation, the variable name "Row Numbers" | 
appears at the top of the list when appropriate. 

Dollars and Percent Formats 
Data in dollars and percent formats is different in nature from other numerical 
data and from each other. You may not mix data in dollars and percent 
column formats with other data formats when graphing. For example, if you 
have three columns of data in the data window and the column formats are 
decimal, dollar, and percent, you might plot the decimal column on the X-axis 
versus the dollar column on the Y-axis. If you then try to overlay the percent 
data set onto the plot just created, you get an error message and you are 
prevented from doing so. | 

On the other hand, if you have a fourth, dollars-formatted data column, you 
can overlay it on the plot just created. Other legal combinations include, for 
instance, a dollar X-axis and a percent Y-axis, or a double-Y graph with one 
Y-axis as a dollar format and another Y-axis as a percent format. 

Furthermore, you may not set a dollar or percent formatted axis to log type 
gradations. 

Number of Categories in a Graph 
The number of categories that can be placed along an axis has been increased 
from the 16 mentioned in the manual to 64. This will allow, for instance, 
sales for each month in a five year period to be graphed. However, try not to 
stuff too much information into one graph. Placing 60 months worth of sales 
data in one graph could very easily distract from the purpose of the graph. 
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Pre-selecting Columns 

Columns of data may be selected for graphing before you request a new graph 

to be created. This is done by holding down the Option key and clicking in 

the column number field of the columns you wish to select. The column 

number field is highlighted in the selected columns. 

When a graph is then requested, the pre-selected column names are already 

highlighted in the listboxes for that graph type, and the user need only click 
the OK button or press the Return key to proceed with the plot. The 

leftmost column selected is the one highlighted in the left listbox, and any 

others are highlighted in the right listbox, up to the limit allowed for that graph 

type. 

New Plot Symbols and Line Types 

32 new plot symbols have been added, for a total of 48. These symbols can 

be used for line, scatter, double-Y, polar, and Quality Control graphs. In 

addition, a set of alternate line styles and widths has been added. These can 

be used for line-type graphs (line, double-Y, and Quality Control) and for 

tools like lines and arrows. 

& 
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If you double-click a legend symbol in a line graph, you see the following 
dialog box, enabling you to make your choices: 

Plot Symbol Line Width- 

v 

Double-clicking a legend in a scatter graph causes a dialog box containing 
only the symbol types to appear. Double-clicking a straight line (created 
using the line tool) brings up a dialog box with only the line widths and 
styles. 

The new line styles (other than solid) are recognized by some, but not all, 
other applications which can read Cricket Graph PICT files or Clipboard 
images. A few programs were sampled and the results are listed below. 

MacDraw™ and SuperPaint™ (Draw layer) can read Cricket Graph PICT 
files. Both programs reproduce the Cricket Graph lines without the styles. 

Of the programs that can read Clipboard images, MacDraw and Cricket 
Draw™ cannot reproduce the line styles. MacPaint™, MacWrite™, 
WriteNow™, PageMaker™ 2.0 (using Apple's LaserPrep™), SuperPaint™ 
(Bitmap layer), and Microsoft Word™ 3.01 can reproduce the line styles. 
SuperPaint and MacPaint reproduce the styles at screen resolution only, so 
that some distortion may occur. 

If you use line styles other than solid, and print on a plotter, the resolution is 
similar to that obtained by the ImageWriter—some distortion may result. 
Horizontals, verticals, and lines at a 45 degree angle work best; lines at other 
angles are less smooth. All line widths are drawn as 1 unit wide on plotters. 
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PictureBase™ Files 

You can now import images into your graphs from PictureBase™ by 
Symmetry, Version 1.2. Access to PictureBase-formatted files is possible 
through a desk accessory supplied with PictureBase, called PBRetriever. 
Select the Place command from that desk accessory to place a PictureBase 
image in your graph. The point where you click on the graph window 
specifies the center point of the imported image. 

PB Retriever 
PictureBase 

For further information about PictureBase and PictureBase files, consult the 

PictureBase documentation. 

Importing PICTS from the Clipboard 

A new Place command in the Edit menu allows you place a PICT file image 
from the Clipboard into a graph. The image is centered on the point in the 
graph where you click. This option is enabled only if a picture is currently in 
the Clipboard. You can use this to paste pictures, such as a corporate logo 
created in MacPaint or a chemical symbol created in MacDraw, into a graph. 

fant unde 

Copy Graph 
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Show Clipboard | 
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Once you place the picture into the graph, you can click on the picture to drag 
it around in the graph, or drag on the gray size box in the lower right-hand 
comer of the selection rectangle to resize it. 

Moving Objects in a Graph 

Cursor Keys 
The cursor keys on a Macintosh Plus (or later model) can be used to move a 

selected object in the graph four pixels in the direction of the arrows on the 
cursor keys, each time the key is pressed. This can be used to position items 
in a graph precisely. 

ppkeot! suxcsonoeds 
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The Shift Key 
The SHIFT key can now be used to constrain a number of items or changes. 
The list of actions and effects of holding the SHIFT key are listed below. 

* creating rectangles creates squares 

* creating ovals creates circles 

° creating lines constrains to horizontal, vertical, or 45° angles 

* creating arrows constrains to horizontal, vertical, or 45° angles 

¢ resizing an object maintains the same aspect ratio (also works in Page Layout) 

¢ moving objects constrains movement to horizontal, vertical, or 45° 

Tick Marks and Labels 

Log Axis Tick Labels 
The tick labels on a logarithmic axis can now be set to decimal notation or 
scientific notation. On a linear axis, the number 1000 might be represented in 
decimal as "1000.00"; in scientific notation as "1.00e+3". On a logarithmic 
axis, the number 1000 in decimal would be the same as on a linear axis, and 

in scientific notation would be "103" 
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Ticks on All Sides 

Tick marks may now be placed on all or any of the four sides of a 
(rectangular) graph. Tick labels may be placed on top or bottom, as well as 
right or left. New entries in the Horizontal and Vertical Axis Format dialog 
boxes allow you to specify the location of tick marks on left, right, top, 
bottom, or any combination, and labels on bottom or top, left or right. 

Minor Ticks 
You can now specify the number of minor tick marks (from 1 through 9). 
This allows you greater control, not only in tick marks, but in grid lines as 
well, since minor grid lines are placed along minor tick marks. _ 

Horizontal (HK) Axis Format Vertical (Y) Axis Format Ticks 

Axis Mark Grid Anis Mark Grid 

Major: : : RO XO 
een So dee a Minrs = OO 
Maximum: [26.000 | : CO Maximum: Inside: CO 

Increment: Increment:| 10.000 Both sides: [] 

# of Minor Ticks: [G]1]> # of Minor Ticks: [O/1|]| Labels: @Left © Right 
© Linear O Lag = © Linear © Log 

The "Inside" option in the Ticks selection box means that tick marks will be 
placed along the inside of the graph rectangle, as opposed to the outside of the 
rectangle (default). The "Both sides" option means that tick marks will be 
placed along both the left and right sides, or on both the top and bottom of the 
graph, depending on whether you are setting ticks for the X or Y axis. 

User beware: the flexibility of changing the axis parameters can give 
unfavorable results if the numbers chosen are not reasonable. For instance, if 
you increase the Maximum for an axis by orders of magnitude, and you 
neglect to increase the Increment by a similar scale, the program will attempt 
to draw an axis with many, many tick marks and may eventually fail, 
depending on memory limitations. 

8 eeecgcdgdgesuedsgiadgsdaeaasd sd a 
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The example below shows a graph with tick marks on all four sides. This 
format is required for certain scientific publications. = _* 

Data from "Science Data" 

i$ 
a Io) Signal #1 
o @ Signal #2 
D ) 
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Quality Control Plots 

Control Limit Values 
Quality Control graphs now have an additional feature. The UCL (upper 
Control Limit), LCL (Lower Control Limit), and mean values have been 

shown on the appropriate types of QC graphs as bold lines through the graph. 
Now, the numeric values are also displayed as text strings. Like other text on 
the graph, you can double-click these strings and edit them. While you can 
change the font setting for these strings, be aware that certain special 
characters may not appear in some fonts. Most notably, the x-double-bar 
symbol: 

5 

appears only in the Chicago font. 

XR Data 

UCL 0.93841 

© 

e = , 
ce 
2 0.93805 

® 
= 

LCL 0.93769 

) 1 2 3 4 peor Aka Babah 

Sample 

The decimal precision of the control limit numbers shown on the graph is one 
digit greater than the precision of the Y axis tick labels. If you want the 
control limit precision to be greater, increase the number of decimal places i in 
the Y axis value in the data window, then recreate the graph. 
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The Goodies Menu 

Error Bars 

There is an additional method of specifying an error bar when you select either 
Y Error Bar or X Error Bar from the Goodies menu. The standard 
deviation of all values in the series can now be specified as the error. 

Ungrouping Legends 
The legend area is now treated as a group of related items. A | 

Group/Ungroup Legend command is now available under the Goodies 
menu. | 

Goodies 

Show Tools 

Show Colors 

i frrar fare 

Y Error Bars 

Grd-ip Legend 
Hide Legend 36 L 

Remove Depth 365 

Remove Plot Frame SF 

Swwszickh Rees 

Add Value Labels | 

Record Preferences 

Goodies 

Show Tools 

Show Colors 

Ri par Pars 

Y Error Bars 

Ungroup Legend 

Hide Legend 

Remove Depth 363 

Remove Plot Frame. 3F 

SxpBsich RstOs 

Add Value Labels 

Record Preferences 

You can ungroup the legend, and edit the text of each legend item 
individually, setting content, size, style, and font. The text for each legend 
item may now contain up to 255 characters. You can also move the items of 
the legend individually, then regroup them. The regrouped items are then 
treated as one item. 

mi Gemany 

Ro vcccscaccnccevccanccocossoncesead 
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Legend item Text: 

Style: 

>] Plain 

[ |] Bold 

[_] Italic 

[ ] Underline 

[_] Outline 

[ ] Shadow 

[_] Condense 

[] Futend 

It is now possible, for example, to place a legend across the bottom of a 
graph. 

Sales 

Helvetica 

Courier 

Symbol 

Mobile 

Cancel 

UUVVIUUUAUVOATOOAUONTUUEUAVAUAT AT 

198 198 

Year 

& ous Of Europe & 

The legend area in previous versions of the program was transparent by 

Canada [Hj Other 

Unit Sales in 

Thousands 

default. Now it is opaque when grouped, transparent when ungrouped. In 
other words, objects behind a grouped legend are not visible. Objects behind 
an ungrouped legend can be seen. The legend area is defined by an imaginary 
rectangle that encloses all the legend elements. Therefore, if you ungroup, 
rearrange, and regroup a legend, you could create a large opaque area behind 
the new legend. 

8 
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Background Color | 

A command for setting background color for graphs is now found in the 
Goodies menu. The background defaults to white, but may be set to any of 
the eight standard colors. On a color monitor, the graph windows are 
displayed with the background color selected. On a black-and-white monitor, 
the background is displayed in white if the color is white, black if the 
background is black, and gray if the background is any other color. Dark 
background colors are usually used when sending output to film-type devices. 

Goodies 

Show Tools 

Show Colors 

£333 Bar's 

Y Error Bars 

Ungroup Legend 7 

Hide Legend 36L 

Add Depth 363 

Remove Plot Frame 

Switch Axes 

Add Value Labels 

Set Background Color 

Record Preferences 

Background color applies to the program as a whole, not to individual graphs. 
Background color is not saved with a graph file nor is it recorded when you 
“Record Preferences." It must be set each time the program is run. If you 
create a graph with a dark background and with white lines, text, and patterns, 
then the graph may appear empty the next time its file is opened, due to a 
different current background in Cricket Graph. You must change the 
background to something other than white to see the contents of the graph. 
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The Tools Window 

Multiple Line Text 
Text editing, either by using the text tool or by double-clicking, now supports 

multiple lines. Only 255 characters in total are allowed in any text box, but 

_ they can be spread over several lines as required. 

A new text box allows you to view three lines at a time. You can use this box 

to position text in one line relative to another line. Adding a new line is 

accomplished by pressing the Return key. To scroll up and down in text that 

has more than three lines, click and drag in the direction you wish to go. 

National Eggplant Marketing 

Sales Figures— 1985, 1986, 198?, 1988 

Greater Walla Walla Area 

[] Plain 

x] Bold 

[_] Italic 

[ ] Underline 

| (J Outline 
[] Shadow 

[ ] Condense 

[] Extend 

N Helvetica Ne 
Palatino 

Orientation: 

© Horizontal © Vertical 

Time and Date 
When adding text to a graph, you can enter "@D" in the text and the current 

date is inserted when you print the graph. If you enter "@T", the current time 

is inserted. Therefore, you can insert either the current time, date, or both into 

text that you place on the graph. Remember, though, this will change the 

length of the text on the graph and you will need to keep this in mind when 

positioning the text. 

& 
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Additional Drawing Tools 

The Tools window contains a number of new tools that can be added to a 

graph. 

Ovals, rhomboids, and diamonds can now be created. The rhomboids and 

diamonds are useful for making flow diagrams in a presentation. Creating an 
oval, diamond, or rhomboid is done in exactly the same manner as defining a 

rectangle (explained in the manual). 

The Curve Fit Menu 

Correlation Coefficients 
The calculation of fitted curves in Cricket Graph produces an equation along 
with a correlation coefficient. This correlation coefficient was formerly 
designated by R=X .X X , where X.XX is a number between 0 and 1. We 
now use the more significant R42 (R squared). In brief, the closer this 
number is to 1.00, the more reliable (for purposes of extrapolation or 
interpolation) is the curve fit equation generated. A more detailed explanation 
of the correlation coefficient is available in the Cricket Software Technical 
Notes, published several times a year. 

Polynomial Curve Fits 
When selecting a curve to be plotted for a set of data, it is important to realize 
that a curve cannot always be calculated for a given set of data. For instance, 
there must be at least 3 data points in order to calculate a second-order 
polynomial; at least 4 data points for a third-order polynomial, and so on. 

If the equation for a curve cannot be calculated, a message is presented saying 
that "The data is singular. A curve fit cannot be completed." The term 
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“singular” applies to the method by which the terms of the equation are 
derived. A matrix of cross products is calculated to come up with the terms of 
a polynomial curve fit. If certain matrix operations fail, the matrix is said to 
be singular. 

Removing Curve Fits from a Graph 

When you remove a curve fit from a graph, the text of the equation is not 
removed. This is because the equation, once placed on the screen as a text 
object, is changeable by the user and is not associated with the curve in any 
way. The user may wish to try different curves to see which is the best fit, 
and for that reason would want to leave the equation string intact. To remove 
the equation, click on it to select it, then press the Backspace key. 

The Formats Menu 

Adding a Format 
The Formats menu has a new option, Add Format. By selecting this 
menu command, you can add a format to the formats already listed in this 
menu. You are given the opportunity to select the format name from the 
proper HFS folder. Previously, you had to keep your formats on the disk 
where Cricket Graph was located. Now the formats can be in any folder or 
volume. 

Formats 

Add Format... ,.. 

Save Format... 

Remove Format... 

Joe's Line 

Larry's QC 

Formats are now listed in alphabetical order in the Formats menu. 

Saved formats now include the graph's size and location on the screen when 
the format was created. 

Formats Containing Error Bars 

The rules for imposing a format containing error bars on a graph have been 
made more precise. The situation arises when you have an existing graph and 
want to apply a format to redefine it. The new implementation is as follows: 

8 
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If the error bar type in the format differs from the error bar type in the graph to 
which the format is being applied, then a dialog box is presented asking what 
type of error bars the user wants. The dialog box is presented for each data 
set where the error bar types differ between the graph and the format, and 
each data set is identified at the top of the dialog box. 

Additionally, if the error bar type in the format is a fixed value or a percentage 
value or values from a column, the dialog box is also presented, even if the 
user already has error bars of the same type in the graph. This approach is 
taken because the fixed, percentage, and column values are not saved in the 
format. 

If the user selects the Cancel option when the dialog is presented, the current 
error bar setting for the indicated data set in the existing graph is not changed. 

Quality Control Formats 
When you save a Quality Control graph as a format, the control limit strings 
are saved with the format, as with all other strings and objects. In general, 

when you apply any format to a graph, the strings and objects from the format 
replace the strings and objects in the graph, except for the current graph axis 
labels and title, which are retained. 

When you apply a QC format, the control limit values, having been saved in 
the format as strings, are written on the graph, along with other text and 
objects. However, the graph will have new control limit values calculated for 
it to match the data in the graph. Therefore, you will see new control limit 
values placed in the graph at their appropriate locations, as well as old control 
limit values from the format. It is the user's responsibility to delete the old 
control limit strings. 
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The Windows Menu 

Access to Hidden Windows 

Anew Windows menu lists all open windows, both Graph and Data. You 
can bring any listed window to the front by clicking the name in this list. The 
Tools window and Colors palette are also listed here, making these often- 
hidden windows easy to bring to the front and access. 

Windows 

Untitled braph <3 

Tools 

Untitled Data #1 

Colors 

Stacked and Tiled Windows 
The menu also has two options: Stack and Tile. These functions affect all 
open windows. As before, windows are simply piled one on top of the other 
under normal circumstances. When you select Stack or Tile, the windows 

are rearranged on the screen for better visibility. 

The Stack option takes the windows and places them along a diagonal path, 
starting at the top left corner. It offsets each window a pre-set distance from 
the previous one. In this way, you can see all the open windows and easily 
pick one to move to the front. 

ae! 
Ces] 

i 4 i 
i 

{ } 
1 
| 

E : 

Untitled Data #1 

Business Data 

Untitled Graph #1 

Pizza Graph 

NT ETE se ea a ee ps OP ee ee Se Ee 

300 
270 

Sin(2x) for x = 0° to 360° 
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the open windows into these parts. Although you can see a number of 
windows at a time, you can edit in only one active window. You can make a 
window active by clicking on it. As with other Macintosh programs, holding 
down the Command key allows you to move a window without making it 
active. 7 

The Tile option splits the screen into equal or near-equal portions and places — 

@ File Edit Bate Graph true fit Goodies Formats Windows 

== 3 d column world sales 

World Sale 

ea... Ea France 

ig _.| 2d UK 
i |* US 

quarterly pie : Business Data = 

bio ae mart prerrmang 

Ei First 

P| 
Eq Third 
HE Fourth 

Other Changes 

Terminating the Program 
You can now press the Command-Q key combination to quit the 
application, even if you are currently in a dialog box. 

Preferences 
The command Record Preferences in the Goodies menu now also sets the 
default graph size and location on the screen. 
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Preserving Changes 
Any time you create an untitled graph or make a modification to a titled graph, 
you will be asked if you wish to save the graph before the graph can be 
closed. This was done for your protection in response to a number of users 
who had problems with losing graphs. 

Undo 
Many users found the use of the Undo command in the Edit menu to be 
unclear. This command now reads Can't Undo when "undo" is not 
implemented for the action taking place. Where appropriate, Undo is enabled 

for the specific action just performed, as in Undo Cut. 

Regression Curves 
The plotting of regression curves has been improved, resulting in 
considerably smoother curves on the LaserWriter. 

Zero-range Data 

Cricket Graph now handles a set of data with no variation (for example, if all 
cells in a column have the value 1.0). 

Zero-height Bars and Columns 
Zero height bars and columns are no longer drawn. 

Disk Space vs. ImageWriter 
If your output device is an ImageWriter, a lot of disk space is saiged by the 
Macintosh to create an image for printing on this device. Consequently, if — 
you attempt to put several graphs together on a page of output, and you do not 
have a hard disk, you may run out of space on your floppy disk. 

“Dumb” Plotter Support 
On plotters that are not capable of filling objects (such as the Apple plotter), 
bar, column, pie wedge, and legend frames are now plotted in the color 
selected for the data set rather than in the color selected for the frame. 
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Plotters 

Plotter Command Files 
You can now save a text file containing the graphic commands for a plotter to 
disk by clicking the Text File button in the Plotter Setup dialog. This 
feature is convenient if you wish to modify the plotter commands before 
sending to the plotter. 

Paper: @© 8 1/2 4 11 Tall ©8 1/2 4 11 Wide 

HP 7470A Plotter 

Speed: © Fast OMedium  O Slow 

Scale Fonts: O Yes @ No 

Connector: @ Modem © Printer 

Output to: © Plotter @ Text File 

Color Assignments to Plotter Pens: 

Black [G]1|O] Green Magenta 
White Blue Vellow [Golo 

Red = [@]2|>] Cyan 

Plotter files saved in this manner can later be transmitted to the plotter by a 
small application entitled "GraphSender™", which is now included on your 

disk. 

Using GraphSender™ 
The GraphSender™ program is provided so that plotter files that have been 
saved to disk can quickly and easily be sent to a plotter without having to use 

Cricket Graph. 

After you double-click the icon of the GraphSender™, the program starts. 
Only three menus are available. 

The Apple menu contains the usual About box which lists the author and 
publisher of this program. All the desk accessories you have installed in your 
System file will also appear on this menu. 
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The File menu contains three commands with which you will primarily be 
concerned. The Send command is used to send files to the plotter. The 
Setup command is used to select the port to which you wish to send these 
files. You may select either the Modem or Printer port. The Quit 
command exits the program and returns to the Finder. 

HK 

If you select the Setup command, the following dialog will appear. Click 
the TEXT file button if it is not already chosen, and select the port 
connected to the plotter. 

etup for: 

@ TEHT file © Matrix Device © Dunn Film Recorder 

Connector: © Modem © Printer 

If you select the Send command from the File menu, you will be presented 
with a dialog allowing you to choose which file you wish to transmit to the 
plotter. This dialog is the same as the dialogs with which you are already 
familiar for selecting and opening files. 

—D Image #1 
0 Image #2 
D Image #3 

| Cancel 

a 
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All the items in the Edit menu, except for Show Clipboard, are disabled. 
They are not used by GraphSender, and will become active only if you open a 
desk accessory. | 

Cant Unde 

{ 4k 3K 

Copy 36 

Paste BK 

{fear 36B 

Select All 468 

Show Clipboard 

The Show Clipboard command allows you to look at the current contents 
of the Clipboard. 

If you have several files to send to the plotter, you can select them all at once 
in the Finder before you double-click to start GraphSender™. In that case, 
GraphSender™ will send all the files automatically, pausing between files to 
allow you to change the paper. 

Using the HP 7550A Plotter with Cricket Graph 
The HP 7550A plotter is now supported by Cricket Graph. An installer 
utility is provided on your disk for this plotter. Follow the directions in the 
Cricket Graph User's Guide to install the driver for this plotter. 

Cable Connection 
Like other plotters, the HP 7550A requires the same Macintosh cable 
connection as the ImageWriter I printer. There is one major difference, 
however. The connector on the HP 7550A is a male DB-25 connector instead 
of the female DB-25 connector that is used on the ImageWriter I and other 
plotters. This means that you need to obtain a DB-25 male/female adapter 
connection in order to plug the cable into the HP 7550A. A suitable adapter is 
available from Radio Shack stores. 

Setting up the HP 7550A 
Most plotters let you establish the parameters governing communication 
between the computer and plotter by setting DIP switches on the back of the 
plotter. Instead of DIP switches, the HP 7550A has a small message screen 
and keys on its front panel that let you execute a setup sequence. This provides 
more flexibility than DIP switches, at the cost of slightly more complexity. 
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If you are already using your HP 7550A with other microcomputer software, 
you will probably not need to change your front-panel settings. Cricket 
Graph uses fairly standard settings, which are the same settings used by other 
software such as ChartMaster and Plot-It. Here is a brief summary of the 
proper settings: 

e "Computer" 

¢ "Remote" data flow 

e "Hardware" handshake 

¢ "Bypass" is OFF 

e Full Duplex 

¢ 9600 Baud 

¢ 8 data bits, no parity 

Trademarks 

PictureBase is a trademark of Symmetry, Inc. 
Microsoft Word is a trademark of MicroSoft Corporation. 
SuperPaint is a trademark of Silicon Beach Software. 
Macintosh, LaserWriter, ImageWriter, MacPaint, MacDraw, and MacWrite 

are trademarks of Apple Computer, Inc. 
PageMaker is a trademark of Aldus Corporation. 
WriteNow is a Trademark of NEXT, Incorporated. 

Jazz and Lotus 1-2-3 are trademarks of Lotus Development Corporation. 
TOPS is a trademark of Centram Systems, Inc. 
MacLink Plus is a trademark of DataViz. 
Cricket Draw is a trademark of Cricket Software. 
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The original Cricket Graph authors are James Rafferty and Richard Norling. 
Contributors to this update include Joseph Zglinicki, Lawrence Greenley, 
Barbara Sieg, Martin Fisher, and Dennis McFerren. 
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